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Who is this book for?

Anyone who wants to get up to speed quickly with LibreOffice Base will find this book valuable. You
may wish to first read Chapter 8, Getting Started with Base, in the Getting Started guide.

What's in this book?

This book introduces Base, the database component of LibreOffice. Base uses the HSQLDB
database engine to create database documents. It can access databases created by many
database programs, including Microsoft Access, MySQL, Oracle, and PostgreSQL. Base includes
additional functionality that allows you to create full data-driven applications.

This book introduces the features and functions of Base, using two example databases.
* Creating a database
* Accessing external databases

* Creating and using tables in relational databases
* Creating and using forms for data entry

* Using queries to bring together data from different tables, calculate results where
necessary, and quickly filter a specific record from a mass of data

¢ Creating reports using the Report Builder

* Linking databases to other documents and external forms, including use in mail merge
* Filtering and searching data

* Using macros to prevent input errors, simplify tasks, and improve usability of forms

* Maintaining databases

Where to get more help

This book, the other LibreOffice user guides, the built-in Help system, and user support systems
assume that you are familiar with your computer and basic functions such as starting a program,
opening and saving files.

Help system

LibreOffice comes with an extensive Help system. This is your first line of support for using
LibreOffice. To display the full Help system, press F1 or select LibreOffice Help from the Help
menu. In addition, you can choose whether to activate Tips, Extended Tips, and the Help Agent
(using Tools > Options > LibreOffice > General).

If Tips are enabled, place the mouse pointer over any of the icons to see a small box (“tooltip”) with
a brief explanation of the icon’s function. For a more detailed explanation, select Help > What's
This? and hold the pointer over the icon.

Free online support

The LibreOffice community not only develops software, but provides free, volunteer-based support.
See Table 1 and this web page: http://www.libreoffice.org/get-help/

You can get comprehensive online support from the community through mailing lists and the Ask
LibreOffice website. Other websites run by users also offer free tips and tutorials. This forum
provides community support for LibreOffice: http://en.libreofficeforum.org/

8 Base Handbook


http://en.libreofficeforum.org/
http://www.libreoffice.org/get-help/

This site provides support for LibreOffice, among other programs:
http://forum.openoffice.org/en/forum/

Table 1: Free support for LibreOffice users

Free LibreOffice support

Questions and answers from the LibreOffice community

Ask LibreOffice http://ask.libreoffice.org/en/questions/

User guides, how-tos, and other documentation.
Documentation http://lwww.libreoffice.org/get-help/documentation/
https://wiki.documentfoundation.org/Documentation/Publications

Answers to frequently asked questions

FAQs http://wiki.documentfoundation.org/Faq

Free community support is provided by a network of experienced users

Mailing lists http://www.libreoffice.org/get-help/mailing-lists/

The LibreOffice website in your language.
http://www.libreoffice.org/international-sites/

International mailing lists
http://wiki.documentfoundation.org/Local_Mailing_Lists

International support

Information about available accessibility options.

Accessibility options http://www.libreoffice.org/get-help/accessibility/

Paid support and training

Alternatively, you can pay for support services. Service contracts can be purchased from a vendor
or consulting firm specializing in LibreOffice.

What you see may be different

lllustrations

LibreOffice runs on Windows, Linux, and Mac OS X operating systems, each of which has several
versions and can be customized by users (fonts, colors, themes, window managers). The
illustrations in this guide were taken from a variety of computers and operating systems. Therefore,
some illustrations will not look exactly like what you see on your computer display.

Also, some of the dialogs may be differ because of the settings selected in LibreOffice. You can
either use dialogs from your computer system (default) or dialogs provided by LibreOffice. To
change to using LibreOffice dialogs:

1) On Linux and Windows operating systems, go to Tools > Options >LibreOffice > General
on the main menu bar to open the dialog for general options.

2) On a Mac operating system, go to LibreOffice > Preferences > General on the main
menu bar to open the dialog for general options.

3) Select Use LibreOffice dialogs in Open/Save dialogs and, in Linux and Mac OS X operating
systems only, Print dialogs to display the LibreOffice dialogs on your computer display.

4) Click OK to save your settings and close the dialog.

Preface 9


http://www.libreoffice.org/get-help/accessibility/
http://wiki.documentfoundation.org/Local_Mailing_Lists
http://www.libreoffice.org/international-sites/
http://www.libreoffice.org/get-help/mailing-lists/
http://wiki.documentfoundation.org/Faq
https://wiki.documentfoundation.org/Documentation/Publications
http://www.libreoffice.org/get-help/documentation/
http://ask.libreoffice.org/en/questions/
http://forum.openoffice.org/en/forum/

Icons

The icons used to illustrate some of the many tools available in LibreOffice may differ from the
ones used in this guide. The icons in this guide have been taken from a LibreOffice installation that
has been set to display the Galaxy set of icons.

If you wish, you can change your LibreOffice software package to display Galaxy icons as follows:

1) On Linux and Windows operating systems, go to Tools > Options >LibreOffice > View on
the main menu bar to open the dialog for view options.

2) On a Mac operating system, go to LibreOffice > Preferences > View on the main menu
bar to open the dialog for view options.

3) In User interface > Icon size and style select Galaxy from the options available in the drop-
down list.

4) Click OK to save your settings and close the dialog.

Some Linux operating systems, for example Ubuntu, include LibreOffice as part of
the installation and may not include the Galaxy set of icons. You should be able to
download the Galaxy icon set from the software repository for your Linux operating
system.

Note

Using LibreOffice on a Mac

Some keystrokes and menu items are different on a Mac from those used in Windows and Linux.
The table below gives some common substitutions for the instructions in this chapter. For a more
detailed list, see the application Help.

Windows or Linux Mac equivalent Effect
Tools > Options LibreOffice > Preferences Access setup options
menu selection
Right-click Control+click and/or right-click Open a context menu
depending on computer setup
Ctrl (Control) 3 (Command) Used with other keys
F5 Shift+3#+F5 Open the Navigator
F11 ¥+T Open the Styles and Formatting window

What are all these things called?

The terms used in LibreOffice for most parts of the user interface (the parts of the program you see
and use, in contrast to the behind-the-scenes code that actually makes it work) are the same as for
most other programs.

A dialog is a special type of window. Its purpose is to inform you of something, or request input
from you, or both. It provides controls for you to use to specify how to carry out an action. The
technical names for common controls are shown in Figure 1. In most cases we do not use the
technical terms in this book, but it is useful to know them because the Help and other sources of
information often use them.
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Page Style: Default
| Organizer | Page | Borders | Background  Header | Footer|Sheet| 14

Page order

@® Top to bottom, then right
2 © Left toright, then down 4 5

First page number C%

Print
[J Column and row headers Charts
OJ Grid Drawing objects
O Comments [J Formulas
Objects/graphics Zero values

Scale
Scaling mode 6
[Reducefenlarge printout ¢ |  Scaling factor @

7 [ OK ] [ Cancel ] Help ] [ Reset ]

Figure 1: Dialog showing common controls

1) Tabbed page (not strictly speaking a control).
2) Radio buttons (only one can be selected at a time).
3) Checkbox (more than one can be selected at a time).

4) Spin box (click the up and down arrows to change the number shown in the text box next to
it, or type in the text box).

5) Thumbnail or preview.
6) Drop-down list from which to select an item.
7) Push buttons.
In most cases, you can interact only with the dialog (not the document itself) as long as the dialog

remains open. When you close the dialog after use (usually, clicking OK or another button saves
your changes and closes the dialog), then you can again work with your document.

Some dialogs can be left open as you work, so you can switch back and forth between the dialog
and your document. An example of this type is the Find & Replace dialog.

Who wrote this book?

This book was written by volunteers from the LibreOffice community. Profits from sales of the
printed edition will be used to benefit the community.
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Frequently asked questions

How is LibreOffice licensed?
LibreOffice is distributed under the Open Source Initiative (OSI) approved Lesser General
Public License (LGPL). The LGPL license is available from the LibreOffice website:
http://www.libreoffice.org/download/license/

May I distribute LibreOffice to anyone?
Yes.

How many computers may | install it on?
As many as you like.

May I sell it?
Yes.

May | use LibreOffice in my business?
Yes.

Is LibreOffice available in my language?
LibreOffice has been translated (localized) into over 40 languages, so your language probably
is supported. Additionally, there are over 70 spelling, hyphenation, and thesaurus dictionaries
available for languages, and dialects that do not have a localized program interface. The
dictionaries are available from the LibreOffice website at: www.libreoffice.org.

How can you make it for free?
LibreOffice is developed and maintained by volunteers and has the backing of several
organizations.

I am writing a software application. May | use programming code from LibreOffice in my
program?
You may, within the parameters set in the LGPL. Read the license:
http://www.libreoffice.org/download/license/

Why do | need Java to run LibreOffice? Is it written in Java?
LibreOffice is not written in Java; it is written in the C++ language. Java is one of several
languages that can be used to extend the software. The Java JDK/JRE is only required for
some features; the most notable one is the HSQLDB relational database engine.

How can | contribute to LibreOffice?
You can help with the development and user support of LibreOffice in many ways, and you do
not need to be a programmer. To start, check out this webpage:
http://www.documentfoundation.org/contribution/

May I distribute the PDF of this book, or print and sell copies?
Yes, as long as you meet the requirements of one of the licenses in the copyright statement at
the beginning of this book. You do not have to request special permission. In addition, we
request that you share with the project some of the profits you make from sales of books, in
consideration of all the work we have put into producing them.
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Introduction

In everyday office operation, spreadsheets are regularly used to aggregate sets of data and to
perform some kind of analyses on them. As the data in a spreadsheet is laid out in a table view,
plainly visible and able to be edited or added to, many users ask why they should use a database
instead of a spreadsheet. This handbook explains the differences between the two, beginning with
a short section on what can be done with a database.

This chapter introduces two database examples and the entire Handbook is built around these.
One database is named Media_without_macros.odb and the other, extended with the
inclusion of macros, is named Media_with_macros.odb.

Base - a container for database content

A Base file is a compressed folder that contains information for the different work areas of Base. In
daily use, Base initially opens with the following view.

W Media_without_Macros.odb - LibreOffice Base o &
Eile Edit Wiew Insert Tools Window Help »
B-EB0 e ML B0 B2

[ Create Form in Design View... Description
i% Use Wizard to Create Form...

& i

E Loan Mone -

QFueries
[=] Loan_Barcode
" [=] Loan_Example
;= | =] Loan_Example_0
Forms [=] Loan_Example_1

[=] Loan_Example_2

i [F=] Maintenance
=] Media
BEepors [=] Reader_Admission
=] Recall

Embedded database | HSGL database engine | |

The Base environment contains four work areas: Tables, Queries, Forms, and Reports. Depending
on the work area selected, various tasks—creating new content or calling up existing elements—
may be carried out.

Base starts with the Form view, because forms are the elements most commonly used when
working with databases.
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Data input using forms

Simple forms show just one table as in the upper part of the Loan form.

B

Media_without_Macros.odb : Loan - LibreOffice Base: Database Form >~ o %
Eile Edit View Insert Format Table Tools Window Help
Loan
First Name | Last Name [ o] Fitter (Last Name)
| Annelise Elau 5 A oK
G Cabo |6 |}
Lisa Gerd 2 =
" |Hein Keindurchblick 4
T |Bert Lederstrurnpf o ™
— lhdanika hufirinla 3| ™
Record |2 [of 101} EIE
Record of 10 K4 b oBplP & 24 &8 2

Loan for Reader Garbo, Greta

Loan Date: 04.04.13 J Refesh

curmrent Loan

Ivkediurm | Loan Date |
[ |4 - Die neue deutsche Rechtschreibung - by Hermann, Ursula 04.04.13
Record Ji [of [
Return
hledium Loan Date | Retum Date | Extension | Loan Days| Balance Time
[ (3 - Traditionelle und kritische Thearie - by Horkheimer, hiax 01.04.13 3 Days 4 Days
Record Ji [of [
Page1/1 Default STD S8 ® |75%

[

The Loan form has been extended to show additional information:

The range of persons shown can be filtered on last name to limit the detail shown. If a user
inputs the letter “G” in the Filter (Last Name) field at the right of the Loan table, only
persons whose last name begins with “G” will be shown.

New borrower information can be input directly into the table fields of the form.

Details of items to be borrowed are input and shown in the area in the middle of the form. If
a previously borrowed item is overdue and must be returned this area is blocked (no input
possible) and the title will indicate “Loan temporary locked!”.

Items on loan are shown in the lower area of the form. The date for returning each
borrowed item is compared with the current date and the remaining loan duration shown.
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* The borrowing date is set as the current date. In the pull-down field at the right of the Loan
Date are the media items which can be borrowed. Items which are already on loan to the
selected borrower are not available for selection.

* Media items selected for loan are added to the current loan details by clicking the Refresh
button.

* In the lower section of the form (Return) it is not possible to delete a data row. Only the
fields Return Date and Extension can be edited. If a borrower was previously locked and
has subsequently returned the overdue item(s), the lending area can be unlocked by
clicking the Refresh button.

All these functions can be carried out without using macros, when the form is set up and filled in
the manner described.

Data input directly into a table

¥ . Loan - Media_without_Macros - LibreOffice Base: Table Dat... > » x
Eile Edit Wiew [nset Tools Window Help

=t #F- 7 N8 R v
ID | Media_lD | Reader D | Loan_Date | Return_Date | Extension
1 2 2 15.10.11 250212 2
2 0 3 g2.11.11 g4.0412 1
3 3 0 04.11.11 28.11.11 2
g ) 0 28.11.11 030212
10 4 0 28.11.11 g4.0412
B |11 4 0 09.11.11 050412
12 3 0 09.12.11 171112
13 ¥ 0 09.12.11 g4.0412
15 0 0 240212 250212
16 ¥ 0 250212 171112
17 i} 2 250212 250212
18 1 2 250212 g4.0412
149 2 2 250212 g4.0412
21 0 g 04.0313
22 2 1 04.0313 1
23 1 0 o4.0412 171112
24 8 1 12.03.13
25 i} 2 grat11z2 04.0413
26 ) 1 29.0313
27 1 2 171112 04.0413
28 3 i} 01.0413
249 4 i} 04.0413
=AutoF
Record |6 | of 22 "I

[ a4

The table structure for such a form is relatively basic and easy to set up. In the table shown above,
the same data can be directly input in the rows and columns of the table as when using the form.

* The first field shows a primary key (“ID”) which is automatically generated. More on this
topic can be found in the chapter on Tables.

* The second field, Media_ID, stores the primary key of the Media table, a number which
refers to the Media. In the form the media id, title and author are shown in the drop-down
menu.
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The third field, Reader_ID, stores the primary key of the Reader table. This key is a number
which refers to the reader. In the form the Last name and First name of the reader are
shown.

The fourth field stores the loan date. If this date is present and is later than the current
date, the corresponding data set for the reader is shown in the bottom table of the form
under Return.

The field marked Extension contains information about extensions of the loan for an item.
The meaning of the values 1, 2 and so on is explained later. The database contains a
special table called Settings for this type of information.

The input of this data permits the management of a simple library.

Queries - getting information on data in tables

03 Media_Loan_Balance_Time - Media_without_Macros - LibreOffice ... =~ =~ %
Eile Edit “iew Insert Tools Window Help
|=f #wF- 7 v R v
Media_lD|  Medium  |Reader_ID|Loan_Date|Extension|prolonged_for| LoanDays | BalanceTime
B |0 0-Derklgine Ho 9 04.0313 0 Kh| -7

a 3 -1mAugenblick 1 120313 0 23 -16

2 2-Eine kurze Ge 1 040313 N ¥ Kh| -10

5 - 1hearyou kno 1 290313 0 f 1

3 3- Traditionelle L & 01.0413 0 3 4

4 4-Die neue dewl & 04.0413 0 1] 14
Record 1 [ of B b oM

The query shown above lists all media which are currently out on loan. It calculates for each item
how long it has been on loan and the balance of the loan period.

All media for which the Return_Date field is empty is listed. As an additional overview, the
medium name is included in the query together with the Media_ID.

The reference to the Reader is established with the primary key of the Reader table.

The value of the LoanDays field is calculated as the difference between the Loan_Date and
the current date.

The number of LoanDays is subtracted from the Loan Time to give the remaining number
of days in the loan period. The Loan Time can vary with different media types.

In the Settings table a value of '1' for Extension corresponds to an extension of the loan
period of 7 days. In the data set above, the line with Media_ID '2' shows an extension of 7
days.

Reports - presentation of data

Before an actual report in the form of a recall notice can be printed, the recall information must be
entered into the Recall form. The table in the form shows all persons who have borrowed items
with a negative remaining loan time.

For each media item to be recalled, the recall date and recall notice number is entered. The recall
date defaults to the current date. The recall number is an integer incremented by 1 with each
successive recall notice for a particular lender/media.
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This form, in the current database example without macros, requires user input to create recall
notices. In the macro version, the date is automatically entered and the recall notice printed.

=] .~ Media_without_Macros.odb : Recall - LibreOffice Base: Databa... =~ = *
File Edit View |Insert Format Table Tools Window Help

First Mame Reader | Last Mame Reader |
Greta Garbo
|
Terence Nobady
Record |2 [of i "I
Ap I A
Record of 3 K9 4 B Bl 1% ad 3

Recall for Reader Miiller, Heinrich

edium | Loan Date | Extension [Loan Days|Balance Time|
8 - Im Augenblick - by van ‘ween, Heman 12.03.13 23 Days -16 Days

W 2 - Bne kurze Geschichte der Zeit - by Hawking, Steven W. EYERE -m_.

Record 2 [of 201} W o

Medium: 2 - Eine kurze Geschichte der Zeit - by Hawking, Steven W.

Recall Date |  Recall No. |
I S RARAE 1
Record [i [of [ v
FPage1/1 | Default STD = = (] ?5'%1_

The recall notice is generated by means of a query from the previously input data. The user of the
database needs only to choose the Recall report and a recall letter can be printed out and sent to
all persons who have a recall entry made in the form on the previous page.

In such a report there may be multiple entries (overdue items) for a particular person. If the table
containing the items for this person exceeds the space on a page, it is extended to cover a
succeeding page.

Such a report is more encompassing than a mail merge letter produced with Writer. It automatically
gathers together the data sets for printing and arranges the necessary accompanying text
accordingly.
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= Recall.odt (read-only) - LibreOffice Writer & & &
Eile Edit %iew Insert Format Tahle Tools Window Help

SE R EgE=EEgE »
i Fa
Libre Office Library 1
Wr.
Heinrich Miller
Mowhereroad 14 b
GB 3PGT0 Downtown
040413
Recall
Dear Mr. Miller,
the following mediaweren't returned at the right time: u
Recalldate |RecallMo |Medium Loandate [Owerrun Charge
040413 |1 2 - Eine kurze Geschichte der Zeit - by |04.03.13 10Days|$0.25
Hawking, Steven W.
FNENER & - Im Augenblick - by van Veen, Herman |L2.03.13 16Days|F0.50
Recall Charge: 30.75
Sincere regards,
Fat
W
4
[Adrministration of Librany) &
¥
<[ I ] 1< >
Page1/1 | Default STD Group_HeaderAl |O OGO (@ 81—
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General notes on the creation of a database

The basics of creating a database in LibreOffice are described in Chapter 8 of the Getting Started
guide, Getting Started with Base.

The database component of LibreOffice, called Base, provides a graphical interface for working
with databases. In addition, LibreOffice contains a version of the HSQL database engine. This
HSQLDB database can only be used by a single user. The entire data set is stored in an ODB file
which has no file locking mechanism when opened by a user.

New database using the internal HSQL engine

If a database with multiple users is not planned, or the user wishes to gain some initial experience
with a database, the internal database engine will suffice. It is possible at some later stage to
transfer the database to an external HSQLDB environment, where multiple users can have
concurrent access to the database on the HSQLDB server. This is described in the Appendix to
this Handbook.

The creation of a new internal database is described in detail in Getting Started with Base.

A database which is registered in LibreOffice can be accessed by other program components as a
data source (for example, mail merge). This registration process can be carried out at a later stage
if desired.

Accessing external databases

An external database must exist before it can be accessed. Assuming that access to a database is
desired, the database must be set up to allow network connections with a specific user name and
password before external programs can connect to it.

When such a database is properly set up, a user may, depending on the available connection
software (the database driver), create tables, input data, and query data.

Click on File > New > Database to open the Database Wizard and allow a connection to an
existing database to be made. The list of available database types varies according to operating
system and user interface, but the following should always be available:

* dBase
e JDBC

e MySQL
e ODBC

* Oracle JDBC

* PostgreSQL

e Spreadsheet

e Text

e as well as various types of address books.

The connection options will vary according to the type of database selected. These can in any case
be corrected later, after the *.odb file is created.

Some database types (for example spreadsheets) do not allow new data to be entered. These are
used only to search for or report on existing data.
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MySQL databases

There was an extension for MySQL, the MySQL Native Connector, which should allow Base to
connect directly to a MySQL database. The extension was in the LibreOffice Extensions center
under the Base Category but is not being developed at present.

General access to MySQL for versions of LibreOffice from 3.5 onwads is via JDBC or ODBC. To be
able to use JDBC, it is necessary to install mysqgl-connector-java.jar. This Java Archive file is best
copied into the same folder where the current java version used in LibreOffice is located. This is
likely to be a subfolder like .. .javapath.../1lib/ext for a Linux installation.

Alternatively the appropriate folder containing the Java archive can be set through Tools >
Options > Java > ClassPath.

The method of access to an existing MySQL database is shown in the following steps.

0 Database Wizard ¥ X
Steps Welcome to the LibreOffice Database Wizard
1. 5elect databhase Ise the Database Wizard fo create a new database, open an existing database
. file, ar connectto a database stored on a server.
2. 5etup JOBC connection
3. 5et up user authentication
4 Save and proceed

What do you wantto do?

Create a new database
Qpen an existing database file
Recently used

Media_without_Macros

Open...

iConnectto an existing database!

JOEC

Help =< Back et == Einish zancel

Creation of a new database is only possible in the internal HSQLDB format. Connection to an
external database is only possible when the database already exists.

Select the Connect to an existing database option. A list of database formats is contained on the
pull-down menu. Select MySQL.
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® | Connectto an existing database

FIDBC v
JOBC
Oracle JOBC

__ KDE Address Book
'LDAF Address Book

___ SeaMonkey Address Book i

— — Thunderbird/lcedove Address Book —_—

Spreadsheet
dBASE
Text

ODBC H

PostgreSaL

Connection to MySQL can be via ODBC or JDBC unless a native MySQL connector has been
installed. In this case a direct connection to MySQL is possible.

In this example, select the Java connector JDBC.

03 Database Wizard v X
Steps Set up a connection to a MySQOL database

1. 5elect database You can connectto a MySQL database using either QDBEC or JOBC.

2. Set up MySQL connection Eéi?ﬁgscuntact your system administratar if you are unsure about the following

3. Setup JOBC connection
4. Setup user authentication

5. 5ave and proceed

How do you want to connect to your MySQL database?

Connectusing ODBC (Qpen Database Connectivity)
_ Connect using JOBC (Java Database Connectivity):
Connect directly

Help == Back et == Einish Zancel

S

The database name must be known and input.

If the MySQL server is on the same computer as LibreOffice, then the Server name can be set as
localhost. Otherwise the IP address of the server or its hostname on the network or internet must

be input. It is also possible to access a database with Base where the database is located on the
website of an Internet Service Provider.

The default port number will usually be correct.
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Type in the JDBC driver class and click the Test class button. A dialog should pop up confirming
that the connector is loaded and accessible using Java. The mysqgl-connector-java.jar file must
either be in the same path as the version of Java in use in LibreOffice or directly linked in to

LibreOffice.

D

Steps

1. 5elect database
2.5etup MySQL connection
4. Set up user authentication

5. Save and proceed

Database Wizard

Set up connection to a MySQL database using JOBC

Flease enterthe required information to connectto a MySQL database using
JOBC. Mote that a JDBC driver class must be installed an your system and
registered with LibreOffice.

Flease contact your system administrator if you are unsure about the following

settings.

Datahase name |otest

Server localhost

Bort number 3306 Default: 3306

MySQL JDBC driver class:

com.mysql.jdbe. Driver Testclass
Help == Back Mext == Einish Zancel
5 & LibreOffice Base 2

6 The JOBEC driver was loaded successfully.

I
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Database Wizard

Steps Set up the user authentication

1. Select database
2. 5etup MySQL connection
3. Setup JOBC connection

4. Set up user authentication [EEEELEUELLE haseuser

5. 5ave and proceed

Some databases require you to enter a user name.

| Passwaord required:

Test Connection

Help == Back et == Einish Zancel

[

The database on the network should be protected with a user name and password. Again a
connection test may be carried out.

If a direct connection was selected, this test will generate error messages. Without

testing, Base will, at the end of the Assistant, open the database window and
connection to MySQL.

Note

0 Authentication Required Y@

Message from senver:
A password is needed to connect to the data source .

Enter user name and password for:

ser name
haseuser

Password

Aedrdririedr

Help Dk Zancel
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The connection test starts the authentication process using the user name previously input. After

the correct password is input, a dialog announces the result of the test. If MySQL is not running at
this time, an error message is shown.

e LibreOffice Base 2 &

6 Connection Test

The connection was established successfully.

Fl

The final step is registering the database. The database can, if necessary, be registered at a later
time to allow its use with Writer or Calc.

03 Database Wizard v &

Steps Decide how to proceed after saving the database

1. Select database
2. 85etup MySQL connection
3. 5etup JOBC connection

Do you want the wizard to register the database in LibreOffice?

¥es, registerthe database for me

s Mo, do not register the database!
4. Setup user authentication -

After the database file has been saved, what do you wantto do?
5. 5ave and proceed

v Openthe database for editing
N Create tables using the table wizard
Click 'Finish'to save the database.

Help =< Back Iext == Einish Cancel

]
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ihomelrobbyDokumente/Libre Office 08 109 €%

Title = Type Size Date modified

(] Andere_HBs Falder 3122012 09:51:37 e

(3 Anmerkungen_MNiedermair Folder 03.03.2013 20:4412

(7 Base_Erste_Schritte Folder 27122012, 213531

[(7 Base_Handbuch Folder 04042013 0918:33

[(7 Base_Handbuch_komplett Folder 13.03.2013, 2212:49

[(7 Base_HE_Englisch Folder 04042013 1218:37

(7 Base_HEB_LO_36 Folder 16.03.2013, 08:34:27 Y

1 Base HE LO 41 Folder 31.03.2013, 10:36:23 w

File name: Mew MySQL_JDBC Database vi| Save J

File type: 'ODF Datahase v | . Cancel |
| Help |

b Automatic file name extension

[

The Assistant ends the connection process with the storage of the ODB database. The ODB
database contains all the connection information needed to allow tables in the database to be

accessed whenever the database is opened.

At this stage choose a name for the ODB database file and save it. The next picture is a view of

the Base interface.

) New_MySQL_JDBC_Database.odb - LibreOffice Base ) &
Eile Edit Wiew Inset Tools Window Help
B-E2d as- M E-0: B3
[5: Create Table in Design View... gESthiPﬁ?r:Jl " A
- reate a table by specifying the fie
E [E Use W|z§rd to Create Table. . names and properies, as well as the d..
Tables [ Create View...

Queries 9
T Name
2 Town
Forms
BRepons
MySQL (JDBEC) lotest haseuser localhost

Maone -

28
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The tables in the database are contained in the tree under the name of the database.

T
pB

The view of the table tree can be closed by clicking on the database name. For a single database
connection this does not make much sense, but it does give a visible indication of the direct
connection.

e MySQL_direkt_33.odb - LibreOffice Base ORI
File Edit View [nsert Tools Window Help b 4 |
BN 4  BENENERE==]
T
[] Create Table in Design View... | Description

| Use Wizard to Create Table. .

Tables [# Create View...
F—:I ;
R
Queries
- None -
(] Marme
Town
Fﬂrmﬁ I my5q|
F performance_schema
Eﬁ B test
Reports
MyS QL (Native) | test ' rabby | localhost

[

Instead of only the database input in Step 3 of the Wizard (see lower status bar), LibreOffice opens
all databases that are available in MySQL to the user “robby”.

Queries must include in the MySQL syntax not only the table hame but also the database which
contains, for example, the following code:

. FROM "myphplib"."ASB" AS "ASB", "myphplib"."Kategorien" AS "Kategorien"
It is also possible in every such case to specify an alias, made up from the database and table
names. More details are given in the chapter on Queries.

Tables can be created and deleted in a database. Fields with auto values may be created when
setting up the structure of tables. In MySQL the starting value of such fields defaults to 1.
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dBase databases

dBase databases have a format where all data is contained in separate, previously initialized
tables. Links between the tables must be made in program code. Relations are not supported.

2. 5et up dBASE connection

3. 5ave and procee

N Database Wizard i &
Steps Set up a connection to dBASE files
1.5elect database Select the folder where the dBASE files are stored.

Eath to the dBASE files

' { Browse |

The connection is made to a specific folder. All DBF files in this folder will be included and shown in
the ODB database and can be linked together using queries.

Tables in dBase have no primary key. They can in principle be described as corresponding to the
worksheets in Calc.

. ket dBase.odb - LibreOffice Base &

G
C
¥ (%

File Edit View Insert Tools Window Help

3= RN N=NEN=RIE - Rl BN =l

Database

ET Create Tahle in Design View...
%] Use Wizard to Create Table...

r I

Description

ﬁ

_|
[[<%]
=T
o
I

'@ASB Mone -
= Ausleine
‘= Einband
‘= Erwerb
E Gesperrt
= Leihzaht
‘= Leihzahl
‘T Leihzeit
T Leser

‘5 Mahnung
FE Rueck_Nr
‘B Sprache
T Status
= Tage180
H Werkart

B

[io

ue

=
18]
[45]

ﬁ

ﬂ
=

=
wr

B m :
—
n

[

g

dBASE | ihomelrabbywDokumente/Programmierunglbibi_new/Biblio_DBE
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Tables can be created and will then be copied as new files in the folder previously selected.

The number of different field types for a new dBase table is clearly less than when the internal

HSQLDB format is used. In the following figure there are still some field types with the same type
name.

Field Name | Field Type |
ID Integer [INTEGER ]
Firsthlame Text [WARCHAR ]

[ |LastMame Text [VARCHAR] %

Yes/Mo [ BOOLEAN |
Memo [ LONGYARCHAR |
Decimal [ DECIMAL |
Decimal [ NUMERIC |
Integer [INTEGER ]
Double [DOUBLE ]
Double [ DOUBLE]

Text [ VARCHAR |

Date [ DATE | l

Date/Time [ TIMESTAMP ]

The dBase format is especially suitable for the exchange and extensive editing of data. In addition,
spreadsheet calculations can directly access dBase tables. It may be better to manipulate the data
in Base because Calc requires the input of the type of character encoding, whereas Base simply
takes the appropriate encoding provided by the operating system. Old dBase files may exhibit
small decoding errors where special characters have been used.

Spreadsheets

Calc or Excel spreadsheets can also be used as the table source for databases. If, however, a
Calc spreadsheet is used, no editing of the table data will be possible. If the Calc document is still
open, it will be write protected.

0 - Database Wizard v) (X
Steps Set up a connection to spreadsheets
1. 5elect database Click 'Browse...'to select a LibreOffice spreadsheet or Microsoft Excel workbook.

2. Setup Spreadsheet LibreOffice will open this file in read-only mode.
connection

- Location and file name
3. Save and proceed

Browse

BPasswaord required

The only questions to be answered are the location of the spreadsheet file and whether or not it is
password protected. Base then opens the spreadsheet and includes all worksheets in the

document. The first row is used for the field names and the worksheet names become the table
names.

Relationships between spreadsheets cannot be set up in Base, as Calc is not suitable for use as a
relational database.

Chapter 2 Creating a Database 31



Thunderbird address book
The Assistant will automatically seek a connection to an address book, for example as used in
Thunderbird. The assistant will prompt for the location of the ODB file that will be produced.

oW
X

, &/ Thunderbird_Adressen.odb - LibreOffice Base
Eile Edit “iew Insert Tools Window Help

BEBE e M E-0 B H

Create Table in Design View... | Description

1@ %, Mse Wizard to Create Table..
Tables

F

B
Queries

= Collected Addresses Mone -
Forms Jahrgang
Mathe_Jahrgang
‘F= Personal Address book
Eeports
Thunderbird/icedove Address Book | Thunderbird/icedove Address Book | | .

[

All tables are shown. As in Calc, the tables are not editable. Base uses the table data only for
gueries and mail merge applications.
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General information on tables

Databases store data in tables. The main difference from the tables in a simple spreadsheet is that
the fields into which the data is written must be clearly defined beforehand. For example, a
database does not allow a text field to contain numbers for use in calculations. Such numbers are
displayed, but only as strings, whose actual numerical value is zero. Similarly, images cannot be
included in all types of fields.

Details of which data types are available can be obtained from the Table Design window in Base.
They are shown in the Appendix to this handbook.

Simple databases are based on only one table. All data elements are entered independently, which
can lead to multiple entry of the same data. A simple address book for private use can be created
in this way. However, the address book of a school or a sports association could contain so much
repetition of postcodes and locations that these fields are better placed in one or even two
separate tables.

Storing data in separate tables helps:
* Reduce repeated input of the same content
* Prevent spelling errors due to repeated input

* Improve filtering of data in the displayed tables
When creating a table, you should always consider whether multiple repetitions, especially of text
or images (which consume a lot of storage) may occur in the table. If so, you need to export them

into another table. How to do this in principle is described in Chapter 8, Getting Started with Base,
in the Getting Started with LibreOffice book.

Relationships between tables

This chapter explains many of these steps in detail, using an example database for a library:
media_without_macros. Constructing the tables for this database is an extensive job, as it
covers not only the addition of items into a media library but also the subsequent loan of them.

Relationships for tables in databases

The more relationships there are between tables, the more complex is the design task. Figure 2
shows the overall table structure of this example database as an overview, scaled to fit the page
size of this document. To read the content, zoom the page to 200%.
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E- Subtitle 7 Media 24 Loan
2D e ——— 1 1D
pedia_D Tt Madia_ID
o Edition Reader_ID
= Author Subtile Pub Year g
@D i Length N Comment Return_Date
FirstMame 0 Categony_ID Extension
Lasthame 0 Mediastyle_ID Media_ID_BC
SH (el Medi B pubisher D EiClass
[t rel_Media_Author Price =1 EH rel_Reader_Schot 'E= Schoolclass 21D
n, 8 Media_iD Picture ‘il Reader 21D 71D Class
EH Author_Add , 2 i“mmJSD . ISBN 21D Schoolclass_|D Class_ID
uthor_Sar
_ g e Grade_ID
71D F—~It author_add_ID Firsthiame rade._|
Author_Add = LastMame =5 -
- = Gender Lotk F Grade
91D b Gender_|ID F 1D
‘= Category Gender Grade
%D 1 Title
Category Salutation . -
Description ) Address
1D
Street_ID
Mo
T Mediastyle
= Mediaste 1 E= Posteode n Country
%D h _ ————t Postode D
Mediastyle %D
Loantime Postcode
Town_ID
E Town

%D
Town

= Publisher

71D
Publisher

Figure 2: Relationship diagram for the example database media_without_macros

One-to-many relationships

The media_without_macros database lists the titles of the media in one table. Because titles can
have multiple subtitles or sometimes none at all, the subtitles are stored in a separate table.

This relationship is known as one-to-many (1:n). Many subtitles may be assigned to one medium,
for example the many track titles for a music CD. The primary key for the Media table is stored as a
foreign key in the Subtitle table. The majority of relationships between tables in a database are
one-to-many relationships.

" Subtitle = Media
1D 1 3
o n i
Mo Edition
EE Authaor Subfitle Fub Year
? 1D l Length Comment
Firstiame Category_ID
LastMame Mediastyle_ID
Town_ID
B rel_Media_Author Publisher_|D
- n Frice
- # Media_ID Picture
BE Author_Add F Author_ID ISEN
1 Author_Sort
% 1D i—-. 1. .
Author_Add Authar_Add_ID

Figure 3: Example 1:n relationship; n:m relationship
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Many-to-many relationships

A database for a library might contain a table for authors’ names and a table for the media. The
connection between an author and, for example, books that author has written, is obvious. The
library might contain more than one book by one author. It might also contain books with multiple
authors. This relationship is known as many-to-many (n:m). Such relationships require a table that
acts as an intermediary between the two tables concerned. This is represented in Figure 3 by the
rel_Media_Author table.

Thus, in practice, the n:m relationship is solved by treating it as two 1:n relationships. In the
intermediate table, the Media_ID can occur more than once, as can the Author_ID. But when using
them as a pair, there is no duplication: no two pairs are identical. So this pair meets the
requirements for the primary key for the intermediate table.

For a given value for Media_ID, there is only one title of the media and one ISBN.
For a given value for Author_ID, there is only one Author's first and last name. So,
for a given pair of these values, there is only one ISBN and only one Author. This

makes the pair unique.

Note

One-to-one relationships

B rel_Reader_Schoc Bf Schoolclass
HH Reader 1 1 @ 1D n 1 21D
% 1D Schoolelass_ID Class_ID
FirstMame Grade_ID
LastMame
Lock
Gender_ID
Hf Address P —
' oD . __ Street
Street_ID — 12 e p
Mo © Street
Country
Postcode_ID |

Figure 4: Example 1:1 relationship

The library database described above requires a table for readers. In this table only the fields that
are directly necessary were planned in advance. But for a school database, the school class is also
required. From the school class records, you can find borrowers’ addresses where necessary.
Therefore it is not necessary to include these addresses in the database. The school class
relationship of pupils is separated from the reader table, because mapping to classes is not
appropriate in all areas. From this arises a 1:1 relationship between the reader and the individual
school class assignment.

In a database for a public library, the addresses of readers are required. For each reader there is a
single address. If there are multiple readers at the same address, this structure would require the
address to be entered again, since the primary key of the Reader table is entered directly as the
primary key in the Address table. Primary key and foreign key are one and the same in the
Address table. This is therefore a 1:1 relationship.

A 1:1 relationship does not signify that for every record in a table, there will be a corresponding
record in another table. But at most there will be only one corresponding record. A 1:1 relationship
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therefore leads to fields being exported which will be filled with content for only some of the
records.

Tables and relationships for the example database

The example database (media_without_macros) must satisfy three requirements: media additions
and removals, loans, and user administration.

Media addition table

First, media must be added into the database so that a library can work with them. However, for a

simple summary of a media collection at home, you could create easier databases with the wizard;
that might be sufficient for home use.

The central table for Media addition is the Media table (see Figure 5).

T Subtitle FE Media
% ID L
Media_ID f T
=5 No Edition
B Author smm: Pub_Year
71D ! Length Comment
Firsthlame Category_ID
LastMame Mediastyle_ID
Town_ID
B rel_Media_Authar Eu_bIISh-':I'_ID
rice
8 p, © Media_ID Picture
T Author_Add 7 :umm'_ISD t 1SBN
1 Luthor_Sar
1D P author_Add_ID
Authar_Add - =
EH Category
% 1D
Category
Description
= Mediastyle
% ID
Mediastyle
Loantime
A Town
% 1D
Town
= Publisher
% ID
FPublisher

Figure 5: Media addition
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In this table all fields that are directly entered are assumed not to be also in use for other media
with the same content. Duplication should therefore be avoided.

For this reason, planned fields in the table include the title, the ISBN, an image of the cover, and
the year of publication. The list of fields can be extended if required. So, for instance, librarians
might want to include fields for the size (humber of pages), the series title, and so on.

The Subtitle table contains the detailed content of CDs. As a CD can contain several pieces of
music, a record of the individual pieces in the main table would require a lot of additional fields
(Subtitle 1, Subtitle 2, etc.) or the same item would have to be entered many times. The Subtitle
table therefore stands in a n:1 relationship to the Media table.

The fields of the Subtitle table are (in addition to the subtitle itself) the sequence number of the
subtitle and the duration of the track. The Length field must first be defined as a time field. In this
way, the total duration of the CD can be calculated and displayed in a summary if necessary.

The authors have a n:m relationship to the media. One item can have several authors, and one
author might have created several items. This relationship is controlled by the rel_Media_Author
table. The primary key of this linking table is the foreign key, formed from the Author and Media
tables. The rel_Media_Author table includes an additional sorting (Author_Sort) of authors, for
example by the sequence in which they are named in the book. In addition, a supplementary label
such as Producer, Photographer and so on is added to the author where necessary.

Category, Mediastyle, Town and Publisher have a 1:n relationship.

For the Category, a small library can use something like Art or Biology. For larger libraries,
general systems for libraries are available. These systems provide both abbreviations and
complete descriptions. Hence both fields appear under Category.

The Mediastyle is linked to the loan period Loantime. For example, video DVDs might on principle
have a loan period of 7 days, but books might be loaned for 21 days. If the loan period is linked to
any other criteria, there will be corresponding changes in your methodology.

The Town table serves not only to store location data from the media but also to store the locations
used in the addresses of users.

Since Publishers also recur frequently, a separate table is provided for them.

The Media table has in total four foreign keys and one primary key, which is used as a foreign key
in two tables, as shown in Figure 5.

Loan table

The central table is Loan (see Figure 6). It is the link between the Media and Reader tables. In
case you need to find out retrospectively who has taken out a book (for example, if someone
notices during the loan process that the book is damaged, or if you wish to make a list of the most
popular media), the Loan_Date in the loan record is not simply deleted during the return process.
Instead a Return_Date is recorded.

Similarly, Reminders are integrated into the loan procedure. Each reminder is separately entered
into the Recall table so that the total number of reminders can be determined.

As well as an extension period in weeks, there is an extra field in the loan record that enables
media to be loaned using a barcode scanner (Media_ID_BC). Barcodes contain, in addition to the
individual Media_ID, a check digit which the scanner can use to determine if the value scanned in
is correct. This barcode field is included here only for test purposes. It would be better if the
primary key of the Media table could be directly entered in barcode form, or if a macro were used
to remove the check digit from the entered barcode number before storage.

Finally we need to connect the Reader to the loan. In the actual reader table, only the name, an
optional lock, and a foreign key linking to the Gender table are included in the plan.
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Figure 6: Loan

User administration table

For this table design, two scenarios are envisaged. The chain of tables shown in Figure 6 is
designed for school libraries. Here there is no need for addresses, as the pupils can be contacted
through the school. Reminders do not need to be sent out by post but can be distributed internally.

The Address chain is necessary in the case of public libraries. Here you need to enter data that will
be needed for the creation of reminder letters. See Figure 7.
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Figure 7: Readers - a School class chain and an Address chain

The Gender table ensures that the correct Salutation is used in reminders. The writing of
reminders can then be automated as far as possible. In addition, some given names can be
equally masculine or feminine. Therefore the separate listing of gender is required even when
reminders are written out by hand.
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The rel_Reader_Schoolclass table, like the Address table, has a 1:1 relationship with the
Reader table. This was chosen because either the school class or the address might be required.
Otherwise the Schoolclass_ID could be put directly into the pupil table; the same would be true of
the complete content of the address table in a public library system.

A School class usually consists of a year designation and a stream suffix. In a 4-stream school,
this suffix might run from a to d. The suffix is entered in the Class table. The year is in a separate
Grade table. That way, if readers move up a class at the end of each school year, you can simply
change the year entry for everyone.

The Address is also divided. Street is stored separately because street names within an area are
often repeated. Post code and town are separated because there are often several post codes for
a single area and therefore more post codes than towns. So compared with the Address table, the
Postcode table contains significantly fewer records and the Town table even fewer.

How this table structure is put to use is explained further in the Chapter 4, Forms, in this handbook.

Creating tables

Most LibreOffice users will generally use the graphical user interface (GUI) exclusively to create
tables. Direct entry of SQL commands becomes necessary when, for example, a field must
subsequently be inserted at a particular position, or a standard value must be set after the table
has been saved.

Table terminology: The picture below shows the standard division of tables into columns and rows.

TABLE

COLUMN COLUMN

Field Name | Field Type Field Name | Field Type
(FIELD) | (TYPE) NULL | DEFAULT (FIELD) (TYPE) NULL | DEFAULT

ROW | Reclord |

Data records are stored in a single row of the table. Individual columns are largely defined by the
field, the type, and the rules that determine if the field can be empty. According to the type, the size
of the field in characters can also be determined. In addition, a default value can be specified to be
used when nothing was entered into the field.

In the Base GUI, the terms for a column are described somewhat differently, as shown below.

Notations of the Base-GUI

COLUMN

Field properties

Field Name Field Type Entry required Default value
(FIELD) (TYPE) (NULL/NOT NULL) | (DEFAULT)

Field becomes Field Name, Type becomes Field Type. Field Name and Field Type are entered into
the upper area of the Table Design window. In the lower area you have the opportunity to set,
under the Field properties the other column properties, in so far as they can be set using the GUI.
Limitations include setting the default value of a date field to the actual date of entry. This is
possible only by using the appropriate SQL command (see “Direct entry of SQL commands” on
page 43).
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Default values: The term "Default value" in the GUI does not mean what the
database user generally understands as a default value. The GUI displays a certain
value visibly, which is saved with the data.

The default value in a database is stored in the table definition. It is then written into
the field whenever this is empty in a new data record. SQL default values do not
appear when editing table properties.

Note

Creation using the graphical user interface

Database creation using the graphical user interface is described in detail in Chapter 8, Getting
Started with Base, in the Getting Started with LibreOffice book. Therefore only the main sources of
error are described here.

When a table design is saved, you may be asked if a primary key should be created. This signifies
that a necessary field is missing from the table. Without a primary key, the database cannot
access the tables. Usually this field is given the abbreviation ID and the data type INTEGER and
allowed to run as an AutoValue. You can make it the primary key with a right-click on the
corresponding field.

If information from another table is to be pulled through into this one (for example, an address
database with separate post codes and locations), you must include in the table a field of the same
data type as the primary key of the other table. If the Postcode table has as its primary key the
field ID, of data type Tiny Integer, the Address table must have a field Postcode ID with the data
type Tiny Integer. In other words, the Address table will always contain only the number that
serves as the primary key in the Postcode table. This means that the Address table now has a
foreign key in addition to its own primary key.

Basic rules for naming fields in the table: no two fields may have the same name. Therefore you
cannot have a second field with the name ID as a foreign key in the Address table.

There are limits to the changes you can make in the field type. An upgrade (longer text field, larger
numeric range) is unproblematic as all the values already entered will fit the new type. A
downgrade creates problems and may cause loss of data.

Creating an index

Sometimes it is useful to index other fields or a combination of other fields in addition to the
primary key. An index speeds up searching and can also be used to prevent duplicate entries.

Each index has a defined sort order. If a table is displayed without sorting, the sort order will be
according to the content of the fields specified in the index.

Edit Eiew| Window Help

ES b5 Inde
—_— by .
Field Mam Macros »
DO Extension Manager...
Sirsthame Customize...
Qptions...
asthlame e

Figure 8: Access to Index Design

Open the table for editing by right-clicking and using the context menu. Then you can access index
creation with Tools > Index Design.
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Figure 9: Creating a new Index
On the Indexes dialog (Figure 9), click New Index to create an index in addition to the primary key.

The new index is automatically given the name index1. The Index field specifies which field or
fields are to be used for this index. At the same time you can choose the Sort order.
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SYS_IDX_48
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[Firsthlame = 1 Ascending
| Close Help

Figure 10: The Index is defined as Unique.

In principle, an index can also be created from table fields that do not contain unique values.
However in Figure 10, the Index detail Unique has been checked, so that the LastName field
together with the FirstName field can only have entries that do not already occur in that
combination. So, for example, Robert Muller and Robert Maier are possible, and likewise Robert
Miller and Eva Miller.

If an index is created for one field only, the uniqueness applies to that field. Such an index is
usually the primary key. In this field each value may occur only once. Additionally, in the case of
primary keys, the field cannot be NULL under any circumstances.

An exceptional circumstance for a unique index is when there is no entry into a field (the field is
NULL). Since NULL can have any arbitrary value, an index using two fields is always allowed to
have the same entry repeatedly in one of the fields as long as there is no entry in the other.
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NULL is used in databases to designate an empty cell, one that contains nothing.
Note No calculation is possible using a NULL field. This contrasts with spreadsheets, in
which empty fields automatically contain the value O (zero).

Example: In a media database, the media number and the loan date are entered when the item is
loaned out. When the item is returned, a return date is entered. In theory, an index using the fields
Media_ID and ReturnDate could easily prevent the same item from being loaned out repeatedly
without the return date being noted. Unfortunately this will not work because the return date initially
has no value. The index will prevent an item from being marked as returned twice with the same
date but it will do nothing else.

Limitations of graphical table design
The sequence of fields in a table cannot be changed after the database has been saved. To
display a different sequence requires a query.

Only the entry of direct SQL commands can insert a field into a specific position in the table.
However, fields already created cannot be moved by this method either.

The properties of the tables must be set at the beginning: for example which fields must not be
NULL and which must contain a standard value (Default). These properties cannot subsequently
be changed using the GUI.

The default values set here have nothing to do with the default values within the database itself.
For example, you cannot define the default for a date field as being the date of entry. That is only
possible with directly entered SQL commands.

Direct entry of SQL commands
To enter SQL commands directly, go to Tools > SQL.

Window Help

Relationships... |
User Administration...
Table Filter...

N |
L@ b
Macros !
Extension Manager...
AML Filter Settings...
Customize...

Qptions...

You can then enter commands into the upper area of the window (shown in Figure 11). The lower
area shows the result or, if appropriate, the reason why the command failed.

Queries cannot be created here. For these, the Query Design window offers an extra possibility of
editing the query in SQL Mode.
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Figure 11: Dialog for direct entry of SQL commands

A summary of the possible commands for the built-in HSQLDB engine can be found at
http://www.hsgldb.org/doc/1.8/guide/ch09.html. The contents are described in the following
sections. Some commands only make sense when dealing with an external HSQLDB database
(Specify User, etc.). Where necessary, these are dealt with in the section “Working with external
HSQLDB?” in the Appendix to this handbook.

LibreOffice is based on Version 1.8.0 of HSQLDB. The currently available server
version is 2.2. The functions of the new version are more extensive. A further
description is given in the installation packages for HSQLDB, which can be
downloaded from http://sourceforge.net/projects/hsqldb/files/hsqldb/.

Note

Table creation
A simple command to create a usable table is:

CREATE TABLE "Test" ("ID" INT PRIMARY KEY, "Text" VARCHAR(50));

CREATE TABLE "Test": Create a table with the name "Test".

(' ): with the specified field names, field types and options.

"ID" INT PRIMARY KEY, "Text" VARCHAR(50): Field name "ID" with the numeric type
integer as the primary key, field name "Text" with the text type variable text length and the text size
limited to 50 characters.

CREATE [MEMORY | CACHED | [GLOBAL] TEMPORARY | TEMP | TEXT] TABLE
"Table name" ( <Field definition> [, ...] [,
<Constraint Definition>...] ) [ON COMMIT {DELETE | PRESERVE} ROWS];
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[MEMORY | CACHED | [GLOBAL] TEMPORARY | TEMP | TEXT]:
The default setting is MEMORY: HSQLDB creates all tables in core memory. This setting also

applies to the tables that are written into the embedded database by LibreOffice Base. Another
possibility would be to write the tables to the hard drive and use memory only to buffer access

to the hard drive (CACHED). Tables in TEXT format (such as CSV) are not writable in internal
databases that are set up purely in MEMORY, while Base cannot access TEMPORARY or TEMP
tables. The SQL commands are carried out in this case but the tables are not displayed (and

therefore cannot be deleted) using the GUI, and data entered via SQL is likewise not visible to

the query module of the GUI, unless the automatic deletion of the contents after the final
commit is prevented. Any request in this case shows a table without any contents.

Tables built directly with SQL are not immediately displayed. You must either use View >
Refresh Tables or simply close the database and then reopen it.

<Field definition>:
"Field name" Data type [(Number of characters[,Decimal places])]
[{DEFAULT "Default value" | GENERATED BY DEFAULT AS IDENTITY (START
WITH <n>[, INCREMENT BY <m>])3}] | [[NOT] NULL] [IDENTITY] [PRIMARY
KEY]

Allows default values to be included in the field definition.

For text fields, you can enter text in single quotes or NULL. The only SQL function allowed is
CURRENT_USER. This only makes sense if HSQLDB is being used as an external Server
database with several users.

For date and time fields, a date, a time, or a combination of the two can be entered in single
quotes or else NULL. You must ensure that the date follows the American conventions (yyyy-
mm-dd), that time has the format hh:mm:ss, and that a combined date/time value has the
format yyyy-mm-dd hh:mm:ss.

Allowed SQL functions:

for the current date CURRENT_DATE, TODAY, CURDATE()
for the current time CURRENT_TIME, NOW, CURTIME()
for the current data time stamp CURRENT_TIMESTAMP, NOW.

For boolean Fields (yes/no) the expressions FALSE, TRUE, NULL can be entered. These
must be entered without single quotes.

For numeric fields, any valid number in the range, or NULL is possible. Here too, if you enter
NULL, do not use quotes. When entering decimals, make sure that the decimal point is a dot
(period) and not a comma.

For binary fields (images, etc.) any valid hexadecimal string in single quotes or NULL is

possible. A hexadecimal example string is: '0004ff', which represents 3 bytes, first 0, then 4 and
finally 255 (Oxff). As binary fields in practice need only be entered for images, you need to know

the binary code of the image that is to serve as a default.

NOT NULL: The field value cannot be NULL. This condition can only be given in the field
definition.

Hexadecimal system: Numbers are based on 16. A mixed system consisting of the
numbers 0 to 9 and the letters a to f provides 16 possible digits for each column.
With two columns, you can have 16*16=256 possible values. This corresponds to 1
Byte (28).

Note
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<Constraint definition>:
[CONSTRAINT "Name"]
UNIQUE ( "Field_name 1" [,"Field_name 2"...] ) |
PRIMARY KEY ( "Field_name 1" [,"Field_name 2"...] ) |
FOREIGN KEY ( "Field_name 1" [,"Field_name 2"...] )
REFERENCES "other_table_name" ( "Field_name_1" [,"Field_name 2"...])
[ON {DELETE | UPDATE}
{CASCADE | SET DEFAULT | SET NULL}] |
CHECK(<Search_condition>)

Constraints define conditions that must be fulfilled when data is entered. Constraints can be
given a name.

UNIQUE ("Field_name"): the field value must be unique within that field

PRIMARY KEY ("Field_name"): the field value must be unique and cannot be NULL
(primary key)

FOREIGN KEY ("Field_name") REFERENCES <"other_table_name">
("Field_name"): The specified fields of this table are linked to the fields of another table.
The field value must be tested for referential integrity as foreign keys; that is, there must be a
corresponding primary key in the other table, if a value is entered here.

[ON {DELETE | UPDATE} {CASCADE | SET DEFAULT | SET NULL}]: Inthe case of a
foreign key, this specifies what is to happen if, for example, the foreign record is deleted. It
makes no sense, in a loan table for a library, to have a user number for which the user no
longer exists. The corresponding record must be modified so that the relationship between the
tables remains valid. Usually the record is simply deleted. This happens if you select ON
DELETE CASCADE.

CHECK(<Search_condition>): Formulated as a WHERE condition, but only for the current
record.

You need constraints when the relationship between tables or the index for certain fields must
be defined.

[ON COMMIT {DELETE | PRESERVE} ROWS]:
The content of tables of the type TEMPORARY or TEMP is erased by default when you have
finished working with a particular record (ON COMMIT DELETE ROWS). This allows you to
create temporary records, which contain information for other actions to be carried out at the
same time.

If you want a table of this type to contain data available for a whole session (from opening a
database to closing it), choose ON COMMIT PRESERVE ROWS.

Table modification

Sometimes you might wish to insert an additional field into a particular position in the table.
Suppose you have a table called Addresses with fields ID, Name, Street, and so on. You realize
that perhaps it would be sensible to distinguish first names and last names.

ALTER TABLE "Addresses" ADD "First Name" VARCHAR(25) BEFORE "Name";

ALTER TABLE "Addresses": Alter the table with the name "Addresses".
ADD "First Name" VARCHAR(25): insert the field "FirstName" with a length of 25 characters.
BEFORE "Name": before the field "Name".

The possibility of specifying the position of additional fields after the creation of the table is not
available in the GUI.

ALTER TABLE "Table_name" ADD [COLUMN] <Field_definition> [BEFORE
"already_existing_field_name"];
The additional designation COLUMN is not necessary in cases where no alternative choices are
available.
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ALTER TABLE "Table_name" DROP [COLUMN] "Field_name";

The field "Field name" is erased from the table Table_name. However this does not take place if
the field is involved in a view or as a foreign key in another table.

ALTER TABLE "Table name" ALTER COLUMN "Field name" RENAME TO
"New_field name"

Changes the name of a field.

ALTER TABLE "Table_name" ALTER COLUMN "Field_name" SET DEFAULT
<Standard value>};

Sets a specific default value for the field. NULL removes an existing default value.

ALTER TABLE "Table_name" ALTER COLUMN "Field_name" SET [NOT] NULL
Sets or removes a NOT NULL condition for a field.

ALTER TABLE "Table_name" ALTER COLUMN <Field definition>;
The field definition corresponds to the one from the Table creation with the following restrictions:

* The field must already be a primary key field to accept the property IDENTITY.
IDENTITY means, that the field has the property AutoValue. This is possible only for
INTEGER or BIGINT fields. For these field type descriptions, see the Appendix to this
handbook.

* If the field already has the property IDENTITY but it is not repeated in the field definition,
the existing IDENTITY property is removed.

* The default value will become that specified in the new field definition. If the definition of the
default value is left blank, any default already defined is removed.

* The property NOT NULL continues into the new definition, if not otherwise defined. This is
in contrast to the default value.

* In some cases, depending on the type of modification, the table must be empty in order for
the change to occur. In all cases the change will have effect only if it is possible in principle
(for example a change from NOT NULL to NULL) and the existing values can all be
translated (for example a change from TINYINT to INTEGER).

ALTER TABLE "Table_ name" ALTER COLUMN "Field name" RESTART WITH
<New_field_value>

This command is used exclusively for an IDENTITY field. It determines the next value for a field
with the Autovalue function set. It can be used, for example, when a database is initially used with
test data, and subsequently provided with real data. This requires the contents of the tables to be
deleted and a new value such as "1" to be set for the field.

ALTER TABLE "Table_name"
ADD [CONSTRAINT "Condition_name"] CHECK (<Search_condition>);

This adds a search condition introduced by the word CHECK. Such a condition will not apply
retrospectively to existing records, but it will apply to all subsequent changes and newly entered
records. If a constraint name is not defined, one will be assigned automatically.

Example:
ALTER TABLE "Loan" ADD CHECK
(IFNULL("Return_Date", "Loan_Date")>="Loan_Date")

The Loan table needs to be protected from input errors. For example, you must prevent a return
date being given that is earlier than the loan date. Now if this error occurs during the return
process, you will get an error message Check constraint violation ..

ALTER TABLE "Table_name"
ADD [CONSTRAINT "Constraint_name"] UNIQUE ("Field_namel",
"Field_name2" ...);
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Here a condition is added that forces the named fields to have different values in each record. If
several fields are named, this condition applies to the combination rather than the individual fields.
NULL does not count here. Afield can therefore have the same value repeatedly without causing
any problems, if the other field in each of the records is NULL.

This command will not work if there is already a UNIQUE condition for the same field combination.

ALTER TABLE "Table_name"
ADD [CONSTRAINT "Constraint_name"] PRIMARY KEY ("Field_namel",
"Field_name2" ...);

Adds a primary key, optionally with a constraint, to a table. The syntax of the constraint is the same
as when a table is created.

ALTER TABLE "Table_name"
ADD [CONSTRAINT "Constraint_name"] FOREIGN KEY ("Field_namel",

"Field_name2" ...)
REFERENCES "Table_name_of_another_table" ("Field_namel_other_table",
"Field_name2_other_table" ...)

[ON {DELETE | UPDATE} {CASCADE | SET DEFAULT | SET NULL}];
This adds a foreign key (FOREIGN KEY) to the table. The syntax is the same as when a table is
created.

The operation will terminate with an error message, if any value in the table does not have a
corresponding value in the table containing that primary key.

Example: The Name and Address tables are to be linked. The Name table contains a field with
the name Address_ID. The value of this should be linked to the field ID in the Address table. If the
value "1" is found in Address_ID but not in the ID field of the Address table, the link will not work. It
will not work either if the two fields are of different types.

ALTER TABLE "Table_name" DROP CONSTRAINT "Constraint_name";
This command removes the named constraint (UNIQUE, CHECK, FOREIGN KEY) from a table.

ALTER TABLE "Table_name" RENAME TO '"new_table_name";
Finally this command changes only the name of a table.

Deleting tables
DROP TABLE "Table name" [IF EXISTS] [RESTRICT | CASCADE];
Deletes the table "Table name".

IF EXISTS prevents an error occurring if this table does not exist.

RESTRICT is the default arrangement and need not be explicitly chosen; it means that deletion
does not occur if the table is linked to another table by the use of a foreign key or there is an active
view of this table. Queries are not affected as they are not stored within HSQLDB.

If instead you choose CASCADE, all links to the table "Table_name" are deleted. In the linked
tables, all foreign keys are set to NULL. All views referring to the named table are also completely
deleted.

Linking tables

In principle you can have a database without links between tables. The user must then ensure
during data entry, that the relationships between the tables remain correct. This usually occurs
through the use of suitable input forms that manage this.
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Deleting records in linked tables is not a simple matter. Suppose you wish to delete a particular
street from the Street table in Figure 7, where this field is linked with the Address table as a foreign
key in that table. The references in the Address table would disappear. The database does not
allow this, once the relationship has been created. In order to delete the Street, the precondition
must be fulfilled, that it is no longer referenced in the Address table.

Basic links are made using Tools > Relationships. This creates a connection line from the primary
key in one table to the defined foreign key in the other.

You may receive the following error message when creating such a link:

‘Ef Street B Address
F 1D % 1D
Strest
[
0. LibreOffice Base v (2%

Column types do not match in statement [ALTER TAELE "Address"
ADD FOREIGHM KEY ("str_ID") REFEREMCES "Street” ("1D")]

This message shows some text in English and the internal SQL command that caused the error.

Column types do not match in statement—As the SQL command is displayed as well, the
reference is clearly to the columns Address.str_ID and Street.ID. For test purposes one of these
fields was defined as an Integer, the other as Tiny Integer. Therefore no link could be created since
the one field cannot have the same value as the other.

H Strest e Address
% 1D F 1D
Strest
[r
O - LibreOffice Base o G
Integrity constraint vialation - no parent 1, table: Address in
@ staternent [ALTER TABLE "Address" ADD FOREIGH KEY ("str_ID")
REFEREMCES "Street’ ("ID")]

In this case the column types match. The SQL statement is the same as in the first example. But
again there is an error:

Integrity constraint violation — no parent 1, table: Address ... —The integrity of the relationship
is not ensured. In the field of the Address table, Address.str _ID, there is a number 1, which is not
present in Street.ID. The parent table here is Street, since its primary key is the one that must
exist. This error is very common, when two tables are to be linked and some fields in the table with
the prospective foreign key already contain data. If the foreign key field contains an entry that is not
present in the parent table (the table containing the primary key), this is an invalid entry.
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If the linking is carried out successfully and subsequently there is an attempt to enter a similarly
invalid record into the table, you get the following error message:

ID | st_D | Nr |
i 13

4 am

Ny & LibreOffice Base v) (X

= O A e | —

@ Errar updating the current recard

Inteqrity constraint vialation - no parent SY5_FK_275 table: Address
in staternent [UPDATE "Address" SET "str_ID" = * WHERE "ID" = 7]

|- O | Mare

Again this is an integrity violation. Base refuses to accept the value 1 for the field str_ID after the
link has been made because the Street table contains no such value in the ID field.

Ef Street B Address
:E LI | ]
Street Delete

R

Figure 12: Links can be edited with a right-click

The properties of a link can be edited so that the deletion of a record from the Street table will
simultaneously set to NULL the corresponding entries in the Address table.

The properties shown in Figure 12 always relate to an action linked to the change in a record from
the table containing the corresponding primary key. In our case this is the Street table. If the
primary key of a record in this table is altered (Update), the following actions might take place.

No action

Changing the primary key Street.ID is not allowed in this case, as it would break the
relationship between the tables.

Update cascade

If the primary key Street.ID is changed, the foreign key is automatically changed to its new
value. This ensures that the linkage is not damaged. For example, if a value is changed from 3

to 4, all records from the Address table that contain the foreign key Address.Street _ID with the
value 3, have it changed to 4.
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Fields invaolved
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Update aptions Delete options

(0 Mo action () No action

@ Update cascade () Delete cascade

() Setnull

) Set default
| oK | Cancel Help

Figure 13: Editing the properties of a relationship

Set null
All records which contain this particular primary key will now have no entry in the foreign key
field Address.Street ID; the field will be NULL.

Set default
If the primary key Street_ID is changed, the value of Address.Street_ID originally linked to it is
set to the previously defined default value. For this purpose we need an unambiguous
definition of a default value. The LibreOffice Base GUI up to Version 3.5 does not seem to
provide this. If the default is set using the SQL statement:

ALTER TABLE "Address" ALTER COLUMN "Street_ID" SET DEFAULT 1,

the link definition ensures that the field will return to this value in the case of an Update. So if
the primary key in the Street table is changed, the corresponding foreign key in the Address
table will be set to 1. This is useful when a record is required to have a street field, in other
words this field cannot be NULL. But be careful! If 1 is not in use, you will have created a link to
a non-existent value. In this case HSQLDB seems to have been designed without due thought.
It is therefore possible to destroy the integrity of the relationship.

Attention  If the default value in a foreign key field is not linked to a primary key of the foreign
table, a link to a value would be created, that isn't possible. The referential integrity
of the database would be destroyed.

It would be better not to use the possibility to set the value to default.
If a record is deleted from the Street table, the following options are available.
No Action

No action takes place. If the requested deletion affects a record in the Address table, the
request will be refused.
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Cascading Delete
If a record is deleted from the Street table and this affects a record in the Address table, that
record will also be deleted.

That might seem strange in this context but there are other table structures in which it makes a
lot of sense. Suppose you have a table of CDs and a table which stores the titles on these
CDs. Now if a record in the CD table is deleted, many titles in the other table have no meaning
as they are no longer available to you. In such cases, a cascading deletion makes sense. It
means that the user does not need to delete all these titles before deleting the CD from the
database.

Set to Null
This is the same as for the update option.

Set to Default
This is the same as for the update option and requires the same precautions.

To avoid error messages from the database as far as possible, since these may not
Tip always be comprehensible to the user, the No Action option should definitely be
avoided.

Entering data into tables

Databases that consist of only a single table usually do not require an input form unless they
contain a field for images. However as soon as a table contains foreign keys from other tables,
users must either remember which key numbers to enter or they must be able to look at the other
tables simultaneously. In such cases, a form is useful.

Entry using the Base GUI

Tables in the table container are opened by double-clicking them. If the primary key is an
automatically incrementing field, one of the visible fields will contain the text AutoValue. No entry is
possible into the AutoValue field. Its assigned value can be altered if required, but only after the
record has been committed.

[ Titte | Editinn_ | Pub_“fear [ Fditinn | Puk waoar | Comment |
b Column Eormat...  §732 b Column Format...
72
Column Width... TE Column Width...
??U Hide Column
T 96 |
| hearyo |1 1472 q
Datenba 3., akiualisi 2009 3., aktualisi 2009 Al
2008
Figure 14: Entry into tables — Hiding columns 2009

Figure 15: Entry into tables — Unhiding columns

Individual columns in the Table Data View can be hidden. For example, if the primary key field
does not need to be visible, this can be specified in the table in data entry view by right-clicking on
the column header. This setting is stored with the GUI. The column continues to exist in the table
and can always be made visible again.

Entry into the table usually takes place from left to right using the keyboard with the Tab or Enter
keys. You can also use the mouse.
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When you reach the last field of a record, the cursor automatically jumps to the next record. The
previous entry is committed to storage. Additional storage using File > Save is not necessary and
indeed not possible. The data is already in the database.

For the HSQLDB, data is in working memory. It will only be transferred to the hard

Caution : . . . .
drive when Base is closed (unfortunately from the viewpoint of data security). If Base
A for some reason does not close down in an orderly fashion, this can lead to loss of
data.

If no data is entered into a field that has been previously defined during table design as mandatory
(NOT NULL), the appropriate error message is displayed:
Attempt to insert null into a non-nullable column ..

The corresponding column, the table and the SQL command (as translated by the GUI) are also
displayed.

Changing a record is easy: find the field, enter a different value, and leave the row again.

ID | Titte | Ediion | Pub_vear |

[
|4 Table Farmat... 1972
; 1983
— Row Height...
mOW Reld 1970
- Copy 1996
1972

hj.lalisi 2009
[as Fos 2008

[
8 Im Augel 20048

To delete a record, select the row by clicking its header (the grey area to the left), right-click and
choose Delete Rows.

The Sort, Search, and Filter functions are very useful for retrieving particular records.

Sorting tables

B K=® o @ uHR v ¥

ID | Title | Edition™] Pub_vear | Cor
P E Sort Descending
8 Im Augenblick 2008
g | hearyou knocking 1 1472
2 Eine kurze Geschichte der Zeit 1983
4 Die neues deutsche Rechtschreibung 1996
1] Der kleine Hobhbit 2. Auf. 1472
[ Datenbanken mit OpenOffice.arg 3 3., aktualisi 2008
1 Das sogennante Bise 1472
7 Das Fostfi-Buch 2008

Figure 16: Quick Sort

The quick sort option hides behind the A~ Z and Z - A buttons. One field is selected, one click on
the button, and the data is sorted by that column. The figure shows a descending sort by the Title
field.

Quick sort sorts only by one column. To sort by several columns simultaneously, a further sort
function is provided.
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The field name of the column and the current sort order are selected. If a previous quick sort has
been carried out, the first row will already contain the corresponding field name and sort order.

=] &€ & BB w Z - ‘i‘h‘i‘ﬁi& b SRV T

T | Title |"Edition | Pub_¥ear | Comment Category_ID
B |3 Traditionelle und kritische Theorie 1870

8 m - Sort Order S

5

2 Sort arder

: QK

4 Operator Field name Qrder

g . 2 | [descending o Cancel

1? and then <nane> = | |ascending A Help

=futoF and then =nones= ascending

Figure 17: Sorting by more than one column

Searching tables

ﬂr\jﬁ}ﬂ -
s | Edition
che (Find Record (Ctrl+F)

Functions for searching records are extensive and perhaps not the first choice for locating a
particular record for users accustomed to search engines.

Before you search, make sure the columns you will be searching are wide enough to
show correctly the records that you will find. The search window remains in the
foreground and you will not be able to correct the settings for column width in the
underlying table. To reach the table, you must break off the search.

Tip

The search takes over terms from the field from which it was invoked.

To make the search effective, the search area should be limited as far as possible. It would be
pointless to search for the above text from the Title field in the Author field. Instead, the field name
Title is already suggested as the single Field name.

Further settings for the search can make things easier through specific combinations. You can use
the normal SQL placeholders ("_" for a variable character, "%" for an arbitrary number of variable
characters, "\" as an escape character, to enable these special characters themselves to be
searched for).

Regular expressions are described in detail in LibreOffice Help. Apart from that, the Help available
for this module is rather sparse.
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| Title | Edition | Pub_vear | Comment | Category_ID | Mediastyle_|

[Traditionelle und kritische Theorie | 1970 1
m W Record Search )2
Search for | Search |
@ Text Traditionelle und kritische Theorie | “ |
- | Close |
() Field contentis MULL
) Field contentis not MULL | Help |
Where to search
() All Fields
@ Single figld Title ~
Settings
Position |anywhere in the fizld ol
[] Apply field format [] Search backwards [] Wildcard expression
[] Match case [ Framtop [] Begular expression
[] Similarity Search
State
Record ; 1

Figure 18: Entry mask for a Record search

m Similarity Search 2ol 2%

Settings

Exchange characters E |
Add characters 2 | Cancel |

Remove characters 2 | Help |

[] Eombine

[] Fram top Eegular expression
Similarity Search o=

B

Figure 19: Limiting the similarity search
The similarity search function is useful when you need to exclude spelling mistakes. The higher the
values that you set, the more records will be shown in the final list.

This search module is most suitable for people who know, from regular use, exactly how to achieve
a given result. Most users are more likely to succeed in finding records by using a filter.

Chapter 4 of this handbook describes the use of forms for searching, and how the use of SQL and
macros can accomplish a keyword search.
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Filtering tables
R v

I
Pub_vB&r | Comment
AutoFilter

1872

4007
You can filter a table quickly by using the AutoFilter. Place the cursor in a field, and one click on
the icon causes the filter to take over the content of this field. Only those records are shown for
which the chosen field has the same content. The figure below shows filtering according to an
entry in the Pub_Year column.

HER 357E 4 \?i

| Pub_vear | Commbeht [ cCategory_ID | Med
Remove FilteriSort 1]

1972 2 0

1972 1 1

The filter is active, as shown by the filter icon with a green check mark. The filter symbol is shown
pressed in. If the button is clicked again, the filter continues to exist, but all records are now shown.
So, if you want, you can always return to the filtered state.

Clicking on the Remove Filter/Sort icon at the extreme right causes all existing filters and sorts to
be removed. The filters become inactive and can no longer be recovered with their old values.

You can still enter records normally into a filtered table or one that has been
Tip restricted by a search. They remain visible in the table view until the table is updated
by pressing the Refresh button.

R ¥ v

1=
b_Year #™Smment | Ca
Standard Filter|
2

The Standard Filter icon opens a dialog inwhich you can filter using several simultaneous criteria,
similar to doing a sort. If AutoFilter is in use, the first line of the Standard Filter will already show
this existing filter criterion.

B s Standard Filter ) %
Criteria
: " | OK |
Qperatar Field name Candition Value Iy, [ )
[Pub_Year ~ ] [ & | [1972 | | cancel
AND - none - 3 Help
AMD - None -

Figure 20: Multiple Data Filtering using the Standard Filter
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The Standard Filter provides many of the functions of SQL data filtering. The following SQL
commands are available.

GUI Condition Description

= Exact equality; corresponds to like, but without any additional placeholders

<> Unequal

< Less than

<= Less than or equal

> Greater than

>= Greater than or equal

like For text, written in quotation marks (' '); "_" for a variable character, "%"
for an arbitrary number of variable characters

not like Opposite of 1ike, in SQL NOT LIKE

empty No entry, not even a space character. In SQL this is expressed by the term
NULL

Not empty Opposite of empty, in SQL NOT NULL

Before one filter criterion can be combined with another, the following row must have at least one
field name selected. In Figure 20, the word — none — is shown instead of a field name, so the
combination is not active. The combination operators available are AND and OR.

The field name can be a new field name or a previously selected one.

Even for large data collections, the number of retrieved records can be reduced to a manageable
set with skillful filtering using these three possible conditions.

In the case of filtering forms too, there are some further possibilities (described in the following
chapter) which are not provided by the GUI.

Direct entry using SQL

Direct data entry using SQL is useful for entering, changing or removing multiple records with one
command.

Entering new records

INSERT INTO "Table_name" [( "Field_name" [,...] )]
{ VALUES("Field value" [,...]) | <Select-Formula>};

If no "Field_name" is specified, all fields must be completed and in the right order (as laid down in
the table). That includes the automatically incremented primary key field, where present. The
values entered can also be the result of a query (<Select-Formula>). More exact information is
given below.

INSERT INTO "Table_name" ("Field_name") VALUES ('Test');
CALL IDENTITY();

In the table, in the column "Field_name", the value 'Test' is inserted. The automatically incremented
primary key field "ID" is not touched. The corresponding value for the "ID" needs to be created
separately by using CALL IDENTITY(). This is important when you are using macros, so that the
value of this key field can be used later on.

INSERT INTO "Table_name" ("Field_name") SELECT "Other_fieldname" FROM
"Name_of_other_table";
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In the first table, as many new records are inserted into "Field_name", as are present in the column
"Other_fieldname" in the second table. Naturally a Select-Formula can be used here to limit the
number of entries.

Editing existing records

UPDATE "Table_name" SET "Field_name" = <Expression> [, ...] [WHERE
<Expression>];

When you are modifying many records at once, it is very important to check carefully the SQL
command you are entering. Suppose that all students in a class are to be moved up one year:

UPDATE "Table_name" SET "Year" = "Year"+1

Nothing could be faster: All data records are altered with a single command. But of course you
must now determine which students shoul€d not have been affected by this change. It would have
been simpler to check a Yes/No field for the repetition of a year and then to move up only those
students for which this field was not checked:

UPDATE "Table_name" SET "Year" = "Year'"+1l WHERE "Repetition" = FALSE

These conditions only function when the field in question can only take the values FALSE and
TRUE; it may not be NULL. It would be safer if the condition were formulated as WHERE
"Repetition" <> TRUE.

Other calculation steps are also possible with Update. If, for example, wares costing more than
$150.00 are to be included in a special offer and the price reduced by 10%, this can be carried out
as follows:

UPDATE "Table_name" SET "Price" = "Price"*®,9 WHERE "Price" >= 150

Deleting existing records

DELETE FROM "Table_name" [WHERE <Expression>];
Without the conditional expression the command

DELETE FROM "Table_name"
deletes the entire content of the table.

For this reason it is preferable for the command to be more specific. For example, if the value of
the primary key is given, only this precise record will be deleted.

DELETE FROM "Table_name" WHERE "ID" = 5;

If, in the case of a loan, the media record is to be deleted when the item is returned, this can be
done using

DELETE FROM "Table_name" WHERE NOT "Return_date" IS NULL;
or alternatively with
DELETE FROM "Table_name" WHERE "Return_date" IS NOT NULL;
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Problems with these data entry methods

Entry using a table alone takes no account of links to other tables. This is clear from an example of
a media loan.

B 3 Loan - Media_without_Macros - LibreOffice Base: Table Data View ¥ & &
Eile Edit Wiew [nsert Tools Window Help

E2) B0 SRR R Y

ID |Media_ID|Reader_ID|[Loan_Date|Return_Date| Extension | Media_ID_BC |
0 0 110211 110411

1 2 2 10M511 (0202512 2

2 0 3 1102111 04/04112 1

33 0 1104111 112811 2

9 5 0 11/28/11 02003112

10 4 0 11728111 04104112

The Loan table consists of foreign keys for the item being lent (Media_ID) and the corresponding
reader (Reader_ID) as well as a loan date (Loan_Date). In the table, therefore, we need to enter at
the time of the loan two numeric values (Media number and Reader number) and a date. The
primary key is automatically entered in the ID field. Whether the reader actually corresponds to the
number is not apparent unless a second table for the readers is open at the same time. Whether
the item was loaned out with the correct number is also not apparent. Here the loan must rely on
the label on the item or on another open table.

All this is much easier to accomplish using forms. Here the users and the media can be looked up
using list box controls. In forms, the names of user and item are visible and their numeric identifiers
are hidden. In addition, a form can be so designed that a user can be selected first, then a loan
date, and each set of media are assigned this one date by number. Elsewhere these numbers can
be made visible with the exactly corresponding media descriptions.

Direct entry into tables is useful only for databases with simple tables. As soon as you have
relationships between tables, a specially designed form is better. In forms, these relationships can
be better handled by using sub-forms or list fields.
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Forms make data entry easier

Forms are used when direct entry into a table is inconvenient, to pick up errors in data entry
promptly, or when too many tables make direct management of data impossible.

A Form in Base is a structure invisible
to the user. It serves within Base to

allow contact with the database. Control field 1
Note What is visible to the user is the set of Control field 2
Controls, which serve for the entry or

display of text, numbers, and so on. Control field 3
These controls are divided by the GUI
into various types.

Control field ...

Creating forms

The simplest way to create a form is to use the Form Wizard. Use of the Wizard to create a form is
described in Chapter 8, Getting Started with Base, in the Getting Started with LibreOffice guide.
That chapter also explains how you can further modify the form after using the Wizard.

This handbook describes the creation of a form without using the Wizard. It also describes the
properties of the various types of controls in a form.

A simple form

We start by using the task Create Form in Design View in the Forms area of the main Base
window.

[ Create Form in Design View...
i Use Wizard to Create Form... %

This calls up the Form Editor and the Form Shown in Design View window appears (Figure 21).

The Form Controls toolbar is docked on the left side. The Form Design toolbar (Figure 22) is
docked at the bottom. If these toolbars do not appear automatically, use View > Toolbars to
display them. Without these toolbars, it is not possible to create a form.

The blank area shows a grid of dots. This grid helps you to position the controls accurately,
especially in relation to each other. The symbols at the right end of the Form Design toolbar show
that the grid is visible and active.
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Figure 21: Form shown in Design View

Toolbars for form design

Now we will create a form on the empty page. This can be done in two ways:
* Invoke the Form Navigator to set up a form, or
* Design the form controls and set up the form by using the context menu.

Setting up a form with the Form Navigator

To display the Form Navigator, click the Form Navigator button (shown in Figure 22). A window
appears (Figure 23); it shows only one folder, labeled Forms. This is the highest level of the area
that we are editing. Several forms can be accommodated here.
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Display Grid
Snap to Grid

Helplines While Maving

Figure 22: Available buttons on the Form Design toolbar

E Farm Mavigator o) B
i=

Qpenin Design Mode
Automatic Control Focus

Figure 23: Using the Form Navigator to create a new form

In the Form Navigator (Figure 23), right-click on Forms to open a context menu. Choose New >
Form to create a new form. The other choices in the context menu (Open in Design Mode and
Automatic Control Focus) correspond to buttons in Figure 22; we will discuss them later.

The form carries the default name Form. You can change this name immediately or later. It has no
significance unless you need to access some part of the form using macros. The only thing you
need to ensure is that two elements with the same name do not occur on the same level in the
folder tree.
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The context menu of the form (shown below) provides the way to create form properties.

E g Form Mavigator o)

Forms

Creating a form using a form field

The Form Controls toolbar (Figure 24) makes available some fields for your form. The first four
elements are identical to those of the Form Design toolbar; they are followed by commonly used
form control types (a control consists of a field plus a label).

k)
k2
5
=
=

=

EN

Select

Design Mode Onfoff

Contral

Earm

Check Box
Text Box

Faormatted Field
Eush Buttan

Qption Buttan
List Box

Combo Box

Label Field

More Contrals

Farm Design

Wizards On/Off

Figure 24: Available
buttons on the Form
Controls toolbar

=

Mew >
Cut

Delete

Tab Qrder...
Eename

N

Spin Buttan

Scrollpar

Image Button

Image Control
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File Selection
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Currency Field
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Group Box

Tahle Caontral
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Figure 25: Available
buttons on the More
Controls toolbar
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When you select a form control, you automatically create a = B D
form. For example, suppose you choose a text field: the cursor ':D'Lak'*'g"*'” - » )
changes shape and a rectangular shape may be drawn on the i Position and Size...
white surface of the form. Then, on the stippled surface of the Description. .

form, a text field appears. o

Mame...
|E| m il . Bz Control. .
. ! J =
b - oot 'a | E [ |
' Replace wih )
Now you can create the form by right-clicking and using the Arrange >
context menu for the control (Figure 26). Alignment 5
Select the Form menu option (highlighted in the illustration) to Wrap »
set properties for the form you have just created. The form has Anchor 5
the default name Form.
Group >

Figure 26: Context menu for form

Form properties

When the form properties are called up using the context menu in the Form Navigator or the
context menu of a form control, a Form Properties window appeatrs. It has three tabs: General,
Data and Events.

General tab
Here you can change the Name of the form. In addition there are design possibilities that have
no significance inside Base. They show only the more general possibilities for design using a
form editor; when you create a Web form you will need to use them.

B Farm Properties & o l
General | Data | Events

Submission encoding..... |JRL |2

Type of submission......... |Get <
URL: Destination for the data.
Frame: Section of the destination website to be addressed where necessary.

Submission encoding: in addition to the normal character encoding for transmission to the
URL, you can specify here text encoding and multipart coding (for example, for transfer of
data).

Type of submission: GET (visible via the URL attached to the filename; you can see this often
in the web if you use a search engine) or POST (not visible; suitable for large data volumes).
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Data tab

B Farm Properties o
General| Data | Events

Content tEe. oo Table =
Content..... | ~

{2}

Analyze S0L command..... [Yes

FIREN oo [ J [
SO |' |
Allow additions............ Yes v
Allow modifications......... Yes <
Allow deletions. ... Yes <

Add data only............ No v
Mavigation bar................ YEs *
ol - S Default *

For creating internal forms in Base, this is the most important tab. Here you can set the
following initial properties for the form:

Content type: Choose between Table, Query and SQL command. While Table can always be
used for data entry into a form, this is not always the case for Query (for more information, see
Chapter 5, Queries, in this book) or direct entry of a SQL command. Here we are dealing with a
query that is not visible in Base's query container but has in principle the same structure.

Content: According to whether Table or Query was chosen above, all available tables and
queries are listed. If a SQL command is to be created, you can invoke the Query Editor by
using the button with the three dots to the right of the Content field.

Analyze SQL command: If the analysis of SQL commands should not be permitted (because,
for example, you are using code that the GUI cannot show correctly), you should choose No
here. However this will prevent the form accessing the underlying data using a filter or a sort.

Filter: Here you can set a filter. To get help with this, click the button to the right of the field. See
also Chapter 3, Tables, in this book.

Sort: Here you can set up a Sort for your data. To get help, click the button to the right of the
field. See also Chapter 3, Tables.

Allow additions: Should the entry of new data be allowed? By default this is set to Yes.
Allow modifications: Should editing of the data be allowed? By default also Yes.
Allow deletions: The deletion of data is also allowed by default.

Add data only: If you choose this option, an empty form will always be displayed. There will be
no access to existing data, which can neither be edited nor viewed.

Navigation bar: The appearance of the Navigation Bar at the bottom of the screen can be
switched on or off. There is also a possibility, when you have a subform, always to show the
Navigation Bar for the main form, so that activation of this toolbar affects the main form only.
This setting for the Navigation Bar is not relevant to the internal navigation toolbar that can be
added as a form control if required.

Cycle: The Default option for Base databases is that after entry into the last field in a form, the
Tab key takes you to the first field of the next record — that is, a new record will be created. For
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databases, this has the same effect as All records. By contrast, if you choose Active record, the
cursor will move only within the record; when it reaches the last field, it will jump back to the
first field in that record. Current page refers particularly to HTML Forms. The cursor jumps from
the end of a form to the next form on that page further down.

Events tab

Do

Faorm Properties

General Data [Bvents

Priarto reset

After resetting

Before submitting........... [

When loading

Befare reloading
When reloading
Before unloading
When unloading

Canfirm deletion

Before recard action

After recaord action

Before recard change

After recard change

Fill parameters............. [ J [

Error oceummed. ..., [ J [

Events can trigger macros. A click on the button on the right (...) allows macros to be linked to
the event.

Reset: The form is emptied of all new entries that have not yet been saved.
Before submitting: Before the form data are sent. This is only meaningful for Web forms.
When loading: Only when opening the form. Not when loading a new record into the form.

Reloading: This takes place when the content of the form is refreshed, for example by using a
button on the Navigation Bar.

Unloading: This option seems not to function. It would be expected to refer to the closing of the
form.

Record action: This includes, for example, storage using a button. In tests, this action regularly
duplicates itself; macros run twice in succession.

Record change: The opening of a form counts as a record change. Whenever one record
changes to another within the form, this action likewise occurs twice. Macros are therefore run
twice in succession.

Fill parameters: This macro will be run if a parameter query is to be invoked in a subform, but
for some reason the parameter is not correctly transmitted from the main form. If this event is
not caught, a parameter query will follow the loading of the form.

Error occurred: This event could not be reconstructed.
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Properties of controls

Once a form has been created, it can be filled with visible controls. Some controls allow the content
of the database to be displayed, or data to be entered into the database. Other controls are used
exclusively for navigation, for searching, and for carrying out commands (interaction). Some
controls serve for additional graphical reworking of the form.

Data entry and Data display

Control Use

Text field Text entry
Numeric field Entering numbers
Date field Entering dates
Time field Entering times

Currency field

Numeric entry, preformated for currency

Formatted field

Display and entry with additional formatting, for example using
measurement units

List box Choosing between several different possibilities, also for transfer into the
database of values other than those displayed

Combo box Similar to a list field, but with only the displayed value transferred, or you
can enter new values by hand

Check box Yes/No Field

Options button

Radio button; allows you to choose from a small number of possibilities

Image control

Display of images from a database and entry of images into a database
via a path selection

Pattern field

Entry into a preset mask; limits the entry possibilities to specific character
combinations

Table control

Universal entry module, which can display a whole table.
Integrated into this control are many of the above controls

Design

Control Use

Label field Heading for the form, description of other controls
Group box A frame around, for example, a set of option buttons
Interaction

Control Use

Button Button with label

Image Button

Like a button, but with an additional graphic displayed on it

Navigation bar

Toolbar very similar to the one at the bottom edge of the screen

File selector For selecting files, for example to upload in an HTML form—not further
described

Spin box Can only be used with a macro—not further described

Scrollbar Can only be used with a macro—not further described
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Default settings for many controls

As with forms, properties are grouped into three categories: General, Data and Events. General
comprises everything that is visible to the user. The data category specifies the binding to a field in
the database. The Events category controls actions, which can be bound to some macro. In a
database without macros, this category plays no role.

| m - Properties: Text Box < &8 | D s Froperties: Text Box B &
Eeneral m|m| |General Data | Events |
=T T [TEXT Box 1 ] Datafield s [LastName | v |
Label Figld. ... [ | [.) | || Empty string is NULL ... [Yes =
Max. text length........... [U |%] Input reguired.................. [YES 2 l
Enabled.... Yes $] Filter propesal. ... (No ol
Visible . z]
Read-only.....ooooovvvrroreeeees [No z]
Printable. Yes z]
TABSOP o Yes |
Tab order ..o [U |%] E]
ANCNOT. oo, To Paragraph 3
POSHIONY. ..o 5.00cm B : ,
POSHIONY ..o ,33¢m B E‘_‘-‘ — preics Ter o @@
WAGHR.. 3.83cm B [Generall Data Events |
HEIGN oo 0,67cm B CRANGRM. ... [ | (]
Defaulttext. ... [ = Text modified [ | (]
Fort....... .| (Default | [..] | | wWhen receiving focus.............. [ | (-]
Alignment |Lett s When 16Sing fOeuS ..o [ | (]
Vert, Alignment........... | Default ] KEY PrESSEM.......rororososocsn [ | (]
Background color........ | Default C [ || | Keyreleased .. [ | (]
Border ... |Flat $] MOUSE INSIER. oo [ | (-]
Border color. ..o, | Light gray $|[.] | | Mouse moved whils key pressed.... [ | (.
T YR |Single-line ] MOUSE MOVEC oo [ | (]
Text lines end with........... LF (Unix) i Mouse button pressed............. [ ] E]
Scrollbars. . None j Mouse button released.............. [ | (-]
Password character........ [ ] Mouse outside. ... [ l E]
Hide selection.............. Yes <] Prior to reset N | (]
Additional information..... | | After resetiing. ... [ | (]
Help text oo [ ] Before Updating. ... [ | (]
Help URL. oo [ | ARET UPEEHNG. ..o [ | (]
General tab
Mame.....oo |Text Box 1 | The name of a control must be
unique within the form—used for
access using macros.
Label Figlt..o. [ |[..] Does the field have a label? This
groups field and label together.
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<)

<

<]

ENABIE. . |Yes
VISIBIE. oo |Yes
Read-only................ \No
Prntable. ..o |Yes
Tabstop. oo, \Yes
Tab order......oooooovvv [U
ANCROT. oo \To Paragraph
POSHONK oo 15,00em
POSHIONY oo [0,33cm
WG [3,83cm
Height o oo 0,67em
FOM e | (Defaul)
Alianment.......oooo |Left
Vert. Alignment................ \Default

Non-enabled fields cannot be used
and are grayed out. Useful for
control using macros. (Example: If
Field 1 contains a value, Field 2
must not contain one; Field 2 is
deactivated.)

Usually Yes; invisible fields can be
used as intermediate storage, for
example in creating combination
fields with macros. See Chapter 9,
Macros.

Yes will exclude any modification of
the value. This is useful, for
example, for an automatically
generated primary key.

Sometimes it is useful to print a page
from a form rather than a separate
report. In this case, not all fields may
be required to appear.

Within a form, the Tab key is
normally used for navigation.

A field that is read-only does not
need a tab stop; it can be skipped.

Does the field have a tab stop? Here
the activation sequence within the
form is specified.

Anchoring of graphics within a text
field.

Position of the top left corner relative
to the left side of the form.

Position of the top left corner relative
to the top of the form.

Width of the field.
Height of the field.
Font, font size, and font effects can

be set here.

Alignment. Here text entry is left-
justified.

Vertical alignment: Standard | Top |
Middle | Bottom.
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Background color......... | Default
BOrder. .o, Flat

Border color..................... | Light gray
Hide selection............ |Yes

Additional information..... |

Help text oo [

Help URL..ooo oo [

Background color of the text field.
Framing: No frame | 3D-Look | Flat.
If there is a frame, its color can be

set here.

Highlighted text loses the highlight
when the text field loses focus.

Used for information to be read by
macros. See Chapter 9, Macros.

Appears as a tooltip when the
mouse is hovered over the text field.

Points to a help file, useful mostly for
HTML. Can be invoked using F1
when the focus is on the field.

In addition, humeric, date fields, etc have the following properties.

Strict format..........oooo.. |Yes
Mouse wheel scroll........ |Mever
Spin Button........ooocoooeeoe... Mo
Repeat o, |No
Delay. .o 50ms

With testing enabled, only numbers
and decimal points may be entered.

Never does not allow alterations
using the mouse wheel; When
selected allows such changes when
the field is selected and the mouse is
over the field; Always means
whenever the mouse is over the
field.

A spin symbol is incorporated into
the right side of the field.

If a spin arrow is pressed down and
held, this determines if the entry in
the box should be incremented
beyond the next value.

Determines the minimum delay after
a mouse button press that triggers
repetition.
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Data tab
m Properties: Text Box G

General| Data | Events

Datafield ... [Lastiame | ~]
Empty string is NULL..... | Yes 2
Input required................. [ves 4
Filter proposal................. |No 4

[E ]

Data field: Here you create the binding with the table on which the form is based.

Empty string is NULL: Whether an empty string should be treated as (NULL) or the content
simply deleted.

Entry required: This condition should match the one in the table. The GUI will prompt for entry if
the user has not entered a value.

Filter proposal: When the data is to be filtered, the content of this field is temporarily stored as
a suggestion. Caution — with large contents, this choice can use a lot of storage.

Events tab
- m Froperties: Text Box = s 1

General Data[ﬁ]

Changed......., [ ] |:|
Text MOUIIE. ..o [ | (]
When receiving focus....................... [ | (]
When [0Sing focUS....ooovvvvvcvveeeveeen [ | (]
Ky Pressed. s [ | (]
Key released. s [ | (]
MoUSE INSIdE. oo [ | (]
Mouse moved while key pressed..... [ ] |_:_|
MOUSE MOVEL. oo [ | (]
Mouse button pressed........oocoo.., [ ] |,:,|
Mouse button released............. [ ] |:|
Mouse outside. .. [ ] |:|
Priortoreset. ..o [ ] |:|
AftEr reSEtiNG. oo, [ ] |:|
Before updating...oooocoooevoeo [ ] |:|
After updating. ..o [ ] |_:_|

= a4

Changed: This event takes place when a control is modified and afterwards loses the focus.

Text modified: Refers to the content, which can in fact be text, numeric, or whatever. Occurs
after each additional character is entered.
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When receiving focus: The cursor enters the field. Under no circumstances must the macro
create a message dialog on the screen; clicking in such a dialog causes the form field to lose
the focus and then recover it, triggering the macro again. A loop is created which can only be
broken by using the keyboard.

When losing focus: The cursor leaves the field. This can lead to the same kind of interplay
when the handling of the event causes it to recur.

Key: Refers to the keyboard. For example, a key is pressed when you move through the form
using the Tab key. This causes a field to receive the focus. Then the key is released.

Mouse: Self-explanatory; These events only takes place if the mouse is or was already within
the field ("outside" corresponds to the javascript onMouseOut).

Reset: The form is emptied of all data. This happens, for example, when starting a new record.
When a form is first loaded, the two events Prior to reset and After resetting occur in
succession, before the form is available for input.

Updating: If the event is bound to a form control, update takes place when the focus is lost and
jumps to another form control, after altering the content of the field. Changes in the form are
accepted and displayed. When a form is closed, the two events Before updating and After
updating occur in succession.

Text field

As well as the properties set out on page 70, text fields can have the following additional

properties:

General tab

Max. text length........... 0 |:.| When this value is 0, entry is not
' permitted. Usually the length of the

database field to which the text field
corresponds is used here.

Defaulttext........._ ' = Should default text be put into an
empty field? This text must be
deleted if any other entry is to be
made successfully.

TEXEYDE e Single-line ¢ Possible types: Single-line | Multi-
line | Multi-line with formatting (the
last two differ in tabbing behaviour
and, in addition, a pattern field can
not be bound to a database). The
vertical alignment is not active for
multi-line fields.

STl T L LF (Unix Unix or Windows? This mainly

affects line endings. Internally
Windows lines end with two control
characters (CR and LF).

serollbars. None Only for multi-line fields: Horizontal |
Vertical | Both.
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Active only for single-line fields.
Changes characters to see only
points.

Password character........ ]

Data tab
Nothing of significance.

Events tab
Nothing of significance.

Numeric field
In addition to properties already described, the following properties exist:

General tab
Valug Mmoo [1000000,00 B Minimum value for the field. Should
agree with the minimum value
defined in the table.
Valug max ... [1000000,00 B Maximum value.

|A] Scrolling increment when using the

Incridecrement value...... [1 A -
mouse wheel or within a spin box.

|,,] Value displayed when a new record

Defaultvalue.................. - . -
[ is being created.

|a] Number of decimal places, setto 0

Decimal accuracy............ [2 = ;
for integers.

(Mo A Separator for thousands, usually a
comma.

Thousands separatar.....

Data tab
There is no check on whether a field can be NULL. If there is no entry, the field will be NULL
and not 0.

No filter proposal is offered.
Events tab

The "Changed" event is absent. Changes must be handled using the "Text modified" event (the
word text is not to be taken literally here).

Date field
As well as the properties described on page 70, the following are to be noted.
General tab
R [mm*m 200 _| vl Minimum value for the field,
selectable using a drop-down
calendar.
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Date max............... f2131/2200 =~ Maximum value.

Date format.... (Standard (shor) A ] Short form as 10.02.12 or various
forms using ' /' instead of '. "' or
'="' in the American style.

Default date.........c..c........ [ = ~| Here you can enter a literal date but
unfortunately not (yet) the current
date (Today) at the time the form is
opened.

Dropdown...........ooo |Mo > A month calender for selecting dates
can be included.

Data tab

There is no check on whether a field can be NULL. If there is no entry, the field will be NULL
and not 0.

No filter proposal is offered.
Events tab

The "Changed" event is absent. Changes must be handled using the "Text modified" event (the
word text is not to be taken literally here).

Time field
As well as the properties listed on page 70, the following features are available.
General tab

T Mo 00:00:00 B Minimum value for the field, by
default set to 0.

TiMe Max............. [23:59:59 B Maximum value, by default set to 1
second before 24:00.

Time format. ..., |13:45 ) Short form without seconds, long
form with seconds, and also 12-hour
formats with AM and PM.

Default fime. ... [ B You can set a fixed time but
unfortunately not (yet) the actual
time of saving the form.

Data tab

There is no check on whether a field can be NULL. If there is no entry, the field will be NULL
and not 0.

No filter proposal is offered.
Events tab

The "Changed" event is absent. Changes must be handled using the "Text modified" event (the
word text is not to be taken literally here).
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Currency field
In addition to the properties already listed on page 70, the following features are available:

General tab
Min. value, Max. value, Increment, Default value, Decimal places, and Thousands separator.
correspond to the general properties listed on page 75. In addition to these, there is only:

Currency symbaol........... | 5 | The symbol is displayed but not
' : stored in the table that underlies the
form.
Prefix SYMOOl......ooo. No A Should the symbol be placed before
or after the number?
Data tab

There is no check on whether a field can be NULL. If there is no entry, the field will be NULL
and not 0.

No filter proposal is offered.

Events tab
The "Changed" event is absent. Changes must be handled using the "Text modified" event (the
word text is not to be taken literally here).

Formatted field
In addition to the properties listed on page 70, the following features are offered:

General tab
Minimum and maximum values, and the default value, depend on the formatting. Behind the
button for Formating is a flexible field that makes most currency and numeric fields
unnecessary. Unlike a simple currency field, a pattern field can show negative sums in red.

Formatting......................... |: .| The butto_n to the right with the three
dots provides a choice of numeric
formats, as you usually do in Calc.

Among the numeric formats can be seen, alongside Date, Time, Currency or normal numeric
format, possibilities for using fields with a measurement unit such as kg (see Figure 27). See
also the general Help on numeric format codes.

Data tab
Nothing special to report.

Events tab
The "Changed" event is absent. Changes must be handled using the "Text modified" event (the
word text is not to be taken literally here).
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B s Murmnber Format ) 25

Category Farmat Language IT
All ~ B [English (USA) & —]_ :
User-defined -1234 | Cancel |
J 123412 —_—

Percent 3 1234 ——
Currency -1,23412 |$|
Date -1,23412
Time (1,234)
Scientific = (1,23412) 123457
Options

Decimal places 0 [] Megative numbers red

Leading zeroes 1 E] [] Thousands separator

Format code

General

Figure 27: Formatted field with general numeric options

List box

When a list box is created, the List Box Wizard appears by default. This automatic appearance can
be switched off if required using the Wizards On/Off button (shown in Figure 24).

Wizard
B List Box Wizard - Tahle Selection 2 2
Farm
Contenttype Table
Content Loan
Cantral
Qn the right side, you see allthe tables fram  Category -~
the data source ofthe form. lass
Filter
Choose the table from which the data shauld Gender
be used as basis for the list cantent;
Grade
Loan
Media
Mediastyle
Faostcode
Freferences
Fublisher
Recall

rel_Media_Author

ral Raadar Qrhnnlrlace

= Back Mext == Einish ' Cancel
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The form is already defined. It is bound to a Table named Loans. A list box shows the user
different data from what is actually transmitted into the table. This data usually comes from
another table in the database, and not from the table to which the form is bound.

The Loans table is supposed to show which Reader has borrowed which Media. However this
table does not store the name of the reader but the corresponding primary key from the Reader
table. It is therefore the Reader table that forms the basis for the list box.

B > List Box Wizard - Field Selection X
Existing fields Display field
D [LastMame |
Firstbame E :

The contents ofthe selected field will be

Lack shown in the list bax if the linked fields are
Gender_(D identical.

The Surname field from the Reader table should be visible in the list box. This serves as the
Display field.

0O - List Box Wizard - Field Link v X

This is where you select fields with matching contents so that the value from the display field
will be shawn.

Field fram the Yalue Table Field fram the List Tahle
Reader_ID ] [|D
D
Media_ID Firsttlame
LastMame
Loan_Date Lock
Return_Date Gender_(D
Extension
Media_ID_BC
<< Back Next == | FEinish | Cancel

The Reader _ID field occurs in the Loan table which underlies the form. This table is described

here as the Value table. The primary key ID from the Reader table must be bound to this field.
The Reader table is described here as the List table.

The list box has now been created complete with data and default configuration and is fully
functional.

In addition to the properties listed on page 70, the following features are available.
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General tab

List entries...........cocoo.o.. The list entries have already been
set using the Wizard. Here you could
add further entries that are not from
any table in the database. List
entries here means the visible
entries, not those that the form will
transmit to the table.

If the field is not specified as drop-
down, scroll arrows will appear on
the right side of the list box when the
form is loaded. The list field then
automatically becomes a multi-line
field, in which the actual value
selected is highlighted.

L

Dropa oW Yes

-~

Line count ... 2 B If the field is drop-down, this property

gives the maximum visible number of
lines. If the content extends over
more lines, a scrollbar appears when
the list drops down.

Can more than one value be
selected? In the above example, this
is not possible since a foreign key is
being stored. Usually this function is
not used for databases, since each
field should only contain one value. If
necessary, macros can help in the
interpretation of multiple entries in
the list field.

L

Multiselection........co........ Mo

As the deactivated button makes
clear, a default selection makes little
sense in the context of a binding with
a database table, as created by the
List Field Wizard. It could well be the
case that the record corresponding
to the default selection in the
example table Readers is no longer
present.

Default selection............ hl

Data tab
In addition to the usual data properties Data field and Input required, there are significant
properties which affect the binding between the displayed data and the data to be entered into
the table that underlies the form.

Type of list contents: Valuelist | Table | Query | SQL | SQL [Native] | Tablefields

List contents Valuelist. If list entries have been created under General, the corresponding
values to be stored are entered here. The list contents are loaded with individual items
separated by Shift - Enter. The List content field then shows them as
"Valuel";"Value2";"Value3" .. The Bound Field property is inactive.
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|j Properties: List Bo & g5

General| Data | Events

{

sl Dl e |Reader_ID

Input required..... |Yes

Type of listcontents..... | Sdl
Listeontent. ... ['SELECT "LastName","ID" |

(OO < ]

Boundfield. ... f B

List contents Table: Here one of the database tables can be selected. However this is seldom
possible as it requires the content of the table to be so structured that the first table field
contains the values to be displayed in the list field, and one of the following fields contains the
primary key which the table underlying the form uses as a foreign key. The position of this field
within the table is specified in Bound Field, where the Numbering begins with 0 for the first
field of the database table. But this O is reserved for the displayed value, in the above
example the Surname, while the 1 refers to the ID field.

List contents Query: Here a query is first created separately and stored. The creation of such
queries is described in Chapter 5, Queries. Using the query, it is possible to move the ID field
from the first position in the underlying table to the second position, here represented by the
bound field 1.

List contents SQL: The List Box Wizard fills this field. The query constructed by the Wizard

looks like this:

Listcontent............. | | The query is th.e simplest possible.
_ SELECT "Lasthame"."ID" FROM |~ The Surname field occurs at

Boundfield............. ‘Reader 7l position 0, the ID field at position 1.

Both are read from the Reader
table. As the bound field is Field 1, this SQL formula works. Here should be added ORDER BY
"LastName" ASC. So you haven't to scroll to long through the list to find somebody. An
additional problem might be, that LastName could be the same for more than one reader. So
FirstName must be added in the view of the list box. When there are readers with the same
LastName and the same FirstName, the primary key ID must also be shown. See Chapter 5,
Queries, for information on how this works.

List contents SQL [Native]. The SQL formula is entered directly, not using the Wizard. Base
does not evaluate the query. This is suitable when the query contains functions that might
perhaps not be understood by the Base GUI. In this case the query is not checked for errors.
More about direct SQL Mode can be found in Chapter 5, Queries.

List contents tablefields: Here Field names from a table are listed, not their content. For the

Reader table, the List contents would be "ID", "Given name", "Surname", "Lock", "Gender_ID".
Events tab

In addition to the standard events, the following events are available:

Execute action: If a value is chosen by the keyboard or the mouse, the list box executes this
action.

Item status changed: This could be the change of the displayed content of a list box through
the use of the drop-down button. It could also be a click on the drop-down button of the field.

Error occurred: Unfortunately, this event cannot be reconstructed for list boxes.
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Combo box

As soon as a combo box is created, a Wizard appears by default, just as with a list box. This
automatic behavior can be switched off if necessary using the Wizards On/Off button (see

Figure 24).

Combo boxes write the selected text directly into the table underlying the form. Therefore the
following example shows both the table linked to the form and the one selected for the control as

the Reader table.

Wizard

0
Farm

Contenttype
Content

Caontral

2nthe right side, you see all the tables from

Combo Box Wizard - Table Selection

Table

Reader

the data source ofthe form.

Choose the table from which the data shaould
be used as basis for the list cantent:

<< Back

Media
Mediastyle
Faostcode
Freferences
Fublisher

Fecall

rel_Media_Author
rel_Reader_Schoolclass
Schoolclass

Search

Street

Subtitle

Town
Wicwwe FAKA 2 | ahale

Mext== | Einish

| Cancel |

Again the form is predefined, this time with the Reader table. As the data to be displayed in the combo
box is also to be stored in this table, the source selected for the data for the list is likewise the Reader

table.
0
Existing fields
D
LastMame

Laock
Gender_ID

Combo Box Wizard - Field Selection

Display field

[FirstNam-‘:

The cantents of the field selected will be
shown in the combao box list.

In the Reader table the FirstName field occurs. This should be displayed in the combo box.
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0@

You can either save the value ofthe combo boxin a database field or use it for display

PUIPOSES.

Combo Box Wizard - Database Field

Do you want to save the value in a database field?

@ Yes, |wantto save itin the following database ﬂeld:ié

() Mo, | anly want to save the value in the farm.

In a database, there seems to be little point in not storing the value of a combo box within a field.
We want to read given hames from the Reader table, and also to make them available for new

readers, so that new records do not need to be created for a given name that already exists in the

database. The combo box shows the first name, and text input is not necessary.

If a new value does need to be entered, this can be done easily in a combo box, as the box shows
exactly what is going into the underlying table for the form.

In addition to the properties shown on page 70 and described for list boxes, the following features

are available.

General tab

AutoFill. .

Data tab

D

Data field
Empty string is MLULL

Input regquired

General | Data | Events

Properties: Combo Box

Firsthlame

['Yes

['Yes

Type of list contents........ | Sal

List content

[SELECT DISTIMCT "Firstiame" FROM "Reader”

2 ] During entry of new values, a list of
matching values (if any) is displayed
for possible selection.

The data fields conform to the existing default settings and the settings for a list box. The SQL
command however shows a special feature:

SELECT DISTINCT

sorted.

Events tab

"FirstName" FROM "Reader"

Adding the DISTINCT keyword ensures that duplicate given names are shown only once.
However, creation using the Wizard once more makes it impossible for the content to be

The events correspond to those for a list box.
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Check box

The check box appears immediately as a combination of a check box field and a label for the box.

In addition to the properties described on page 70, the following features are available.

General tab

Ward brealk

Graphics

Graphics alignment

Tristate

Data tab

The label for this box appears by
default to the right of the box. In
addition you can bind it to a separate

Here, dependent on the choice in the
Tri-state field, up to three
possibilities are available: Not
selected | Selected | Not defined.
Not defined corresponds to a NULL
entry in the table underlying the

By default, the label is not broken
up. The label is truncated if the field
is not big enough.

Here you can specify a graphic
instead of or in addition to the label.
You should note that these graphics
are not bound into the *.odb
document by default. For small
graphics, it is useful to embed the
graphic and not link it.

If you have chosen to use a graphic,
its alignment with the label can be

By default, checkboxes have only
two states: Selected (Value: 1) and
Not selected (Value: 0). With Tri-
state, a definition of Empty field

[Check Box =]
label field.
|Mot Selected o
form.
|No .
____________________________ [ [~] [
......... entered
set here.
|Ne .
(NULL) is added.
- m i Properies: Check Box
General| Data | Events
Data figlt........ooroee. | Lock | ~]
Input required................. |Yes £

Reference value {on).... [

Reference value (off)..... [
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The check box can be given a reference value. However only the values of 1 (for On) or O (for
Off) can be transferred to the underlying data field (check boxes act as fields for the choice of
Yes and No).

Events tab
The fields "Changed", "Text modified". "Before updating" and "After updating" are all absent.

Additional fields for a check box are "Execute action" (see List box) und "ltem status changed"
(corresponds to "Changed").

Option button

The option button is similar to the check box described above, except for its general properties and
its external (round) form.

When several option buttons in the form are linked to the same table field, only one of the options
can be selected.

General tab
Group Name............. | The O,ption button is designed to be
' used in groups. One of several

options can then be selected. That is
why a Group name appears here,
under which the options can be
addressed.

Data tab

See under Check box. Here, however, reference values that are entered are actually
transferred to the data field.

Events tab
See under Check box.

Image control

A image control handles the entry and display of graphical material in the database. The underlying
data field must be a binary field.

Entry into a image control takes place either by a double-click with the mouse to open a file
selection dialog, or a right-click to choose whether an existing graphic is to be deleted or replaced.

A graphical control by default has no Tab stop.

In addition to the properties described on page 70, the following features are available.

General tab

The graphic selected here is only
shown inside the control, while the
form is being edited. It has no
significance for later input.

Graphics.............ocoo. =
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Data tab

Keep Ratio No: The image will not be fitted to
the field. If it is too big, the field will
show a window into the image. The
image is not distorted.

Keep ratio: The image is fitted to the
control but not distorted (aspect ratio
preserved).

Autom. Size: The image is fitted to
the control and may be shown in a
distorted form.

Nothing further to report.

Events tab

The events "Changed", "Text modified", "Before updating" and "After updating" are missing..

Pattern field

An input mask is used to control input into the field. Characters are pre-specified for particular
positions, determining the properties of entered characters. The preset characters are stored along
with the entered ones.

In addition to the properties described on page 70, the following features are available.

General tab

Edit mask.........

Literal mask......

|‘ '| This determines what characters can
' be entered.

|‘ | This is what the form user sees.

The following content is taken from LibreOffice Help:

The length of the edit mask determines how many characters may be entered. If the user's
entry does not match the mask, the entry is rejected on leaving the control. The following
characters are available for defining the edit mask.

Character | Meaning

L A text constant. This position cannot be edited. The actual character is displayed
at the corresponding position in the literal mask.

a Represents any of the letters a-z/A-Z. Capital letters are not converted into lower
case.

A Represents any of the letters A-Z. If lower-case letters are entered, they will
automatically be converted to upper case.

c Represents any of the characters a-z/A-Z plus the digits 0-9. Capital letters are
not converted into lower case.

C Represents any of the letters A-Z plus the digits 0-9. If lower-case letters are
entered, they will automatically be converted to upper case.

N Only the digits 0-9 can be entered.

X All printable characters are allowed.
All printable characters are allowed. If lower-case letters are entered, they will
automatically be converted to upper case.
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So, for example, you can define the literal mask as "/ /2012" and the edit mask as

"NNLNNLLLLL", to allow the user to enter four characters only for a date.

Data tab
Nothing further to report.

Events tab
The "Changed" event is absent.

Table control

This is the most comprehensive control. It provides a table, which can then be provided with
controls for individual columns. This not only allows the actual data to be viewed during input, but
also the previously entered data, without the need to use the Navigation bar to scroll through the
records.

Not every field that is possible in a form can be selected for a table control field. Push buttons,
image buttons and option buttons are not available.

The Table Control Wizard assembles in a window the fields that will appear afterwards in the table.

B e Table Element Wizard - Field Selection AR
Farm

Content type Tahle

Content Loan

Table element

Existing fields Selected fields
D Media_ID
Media_ID_BC 3 Reader_(D
=== Loan_Date
Return_Date
Extension
| === ]
< Back Next== | [ Finish  |[  cancel

In the control the Loans table is available for editing. In addition to the ID (primary key) field and
the Media_ID_BC field (entry of media using a bar-code scanner), all fields are to be used in the
control.

The previously created table control must now be further developed, to allow entry into the Loans
table. For fields such as Reader_ID or Media_ID, it would be more useful to be able to choose the
reader or the media directly, rather than a number representing the reader or media. For this
purpose, controls such as list boxes can be placed within the table control. This is declared later.
The formatting of the Extension field with two decimal places was certainly not intended.
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Media_ID Reader_ID Loan_Date Return_Date Extension

b 1.00 0.00 1190211 110411 -
] 2.00 2.00 1015111 02/25/12 2.00
] 0.00 3.00 11002111 0404112 1.00 |=
] 3.00 0.00 11104111 11128111 2.00
] 5.00 0.00 1102811 02/0312
] 4.00 0.00 1102811 0404112
] 4.00 0.00 11109/11 04/05/12
] 3.00 0.00 12109/11
] 7.00 0.00 12109/11 0404112 -
Record |1 | of 149 I

Figure 28: Output of the Table Control Wizard

In addition to the properties listed on page 70, the following features are available.

General tab

Row height ..., [

-~
"

Mavigation bar.............. Yes

Record marker............ Yes

Data tab

{3

L

Height of individual lines. With no
value here, the height is
automatically adjusted to the font
size. Multi-line text fields are then
shown as single lines to be scrolled.

As with tables, the lower edge of the
control shows the record number
and navigation aids.

By default there is a record marker
on the left edge of the control. It
indicates the current record. You can
use the record marker to access the
delete function for the whole record.

Since this is a field that contains no data itself but manages other fields, there are no data

properties.

Events tab

The "Changed" and "Text modified" events are missing. The "Error occurred” event is added.

Label field

In addition to the properties described on page 70, the following features are available.

General tab

Word brealk. ... Mo

Data tab
None.

{>

By default a label is not wrapped. If it
is too long for the field, it is
truncated. Caution: word wrapping
does not recognize spaces, so if the
field is too small, a break can occur
within a word.
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Events tab
The label field reacts only to events that are connected with the mouse, a key or the focus.

Group box
A group box graphically groups several controls and provides them with a collective label.

If a group box is created with Wizards active, the Wizard proceeds from the assumption that
several option buttons will occur together within this frame.

B Group Element Wizard - Data v X
Farm

Contenttype Table

Content Reader

Which names do you want to give the Qption fields

option fields?

male | [ 2> | female

<<Back ||  Nest>> | Einish |  Cancel |

This form is based on the Reader table. We are dealing with the choice of gender. The entries are
the labels of the option buttons.

B Group Element Wizard - Default Field Selection AR

Should one option field be selected as a default?

@ Yes, the following: ; T

() Mo, one particular fizld is not going to be selected.

Here the default option is "female”. If there is to be no default field, the default entry in the
underlying table is NULL.
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B Group Element Wizard - Field Values MRS

When you select an option, the option group Qption fislds
is given a specific value.

male
Which value do you want to assign to each
option?

2 ]

The Wizard gives the option buttons separate values by default, here 1 for female and 2 for male.
These values correspond to the examples of primary key fields in the Gender table.

The value selected by clicking an option button is transferred to the Gender_ID field of the form’s
underlying table Readers. In this way the Readers table is provided with the corresponding foreign
key from the Gender table by using the option button.

B Group Element Wizard - Database Field )

You can either save the value of the aption group in a database field or use it for a later action.

Do you want to save the value in a database field?

@ Yes, |wantto save it inthe following database ﬂeld:lé >

() Mo, | only want to save the value in the form.

B Group Element Wizard - Create Option Group g s

Which caption is to be given to your option group?

Gender

The option button group is given a group box (frame) with the label Gender.
Gender
& fermale
3 male
If female is selected in the active form, male is deselected. This is a characteristic of option buttons

that are bound to the same field in the underlying table. In the example shown above, the option
buttons replace a two-element list box.

In addition to the properties described on page 70, the following features are available.
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General tab

The label can be changed from its default value. At present the frame properties (Line
thickness, line color) cannot be changed but you can change the font formatting.

Data tab

None, since this control serves only for visual grouping of fields.

Events rab

The group box reacts to events involving the mouse, a key, or the focus.

Push button

In addition to the properties described on page 70, the following features are available.

General tab

Default button

[Push Button -
Yes o
Mo o
Mot Selected

Mo o
Mone >
Mo o

Label on the button.

The button receives the focus when
it is clicked.

If Yes, the button can be shown
pressed in. The button state is
shown as for a switch. When you
press it a second time, it shows an
unpressed button.

Active, when Toggle is set to Yes.
Selected corresponds to the
pressed-in button.

Word wrapping if the button is too
narrow.

A variety of actions similar to those
for the navigation bar are available.

HTML.: File to be called up with this
button.

Only for HTML forms: The
target-frame (frame arrangement for
different HTML pages) in which the
file should be opened.

The default button is framed when
this is set to Yes. When there are
several alternative buttons on a
form, the one most often used
should have this characteristic. It is
activated by pressing the Enter key,
when no other action needs to
depend on this key. Only one button
on the form can be the default
button.
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Graphics. .o, [ - Should a graphic appear on the

button?
Graphics allgnment....... Centerad Only active when a graphic has been
' selected. Specifies the alignment of
the graphic to the text.
Data tab

None. A button only carries out actions.

Events tab
"Approve action", "Execute action" and "ltem status changed".

Image button
In addition to the properties already described on page 70, the following features are available.

General tab
Similar to a normal button. However this button has no text and the button itself is not visible.
You see only a frame around the graphic.

By default, an image button has no tab stop.

Caution: at the time of writing, hardly any actions work with this button. It is practically only
usable with macros.

Data tab
None; this control only carries out actions.

Events tab
"Approve action" and all events involving the mouse, a key, or the focus.

Navigation bar

Recard of 10 bopl P Pg & i ST

Figure 29: Navigation bar control

The standard Form Navigation bar is inserted into forms at the lower edge of the screen. The

insertion of this toolbar can cause a brief rightward shift of the form as it builds up on the screen.
This can be distracting in cases where the navigation bar is switched off again for some parts of
the visible form, for example when there are subforms or more than one form in the visible form.

By contrast, a navigation bar control that is part of the form, separate from the corresponding
items, makes it clear through which items you navigate with the toolbar. The form for Loans, for
example, needs to search first through the readers and then show the media loaded to the reader.
The navigation bar control is positioned near the reader, so the user notices that the navigation bar
is used for the reader and not for the media loaned to the reader.

The standard Form Navigation bar makes available the buttons shown in Figure 30. The navigation
bar control shows the same buttons except those for Find Record, Form-Based Filters and Data
source as Table.
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Find Record

Recaord

Absolute Record
Text-= Record

Total Mo, of Records

First Record
Previous Record
Mext Record
Last Record

Mew Record

Save Record
Undo: Data entry

Delete Record

Refresh

Refresh Contral

Sont
SortAscending
Sort Descending

AutoFilter
Apply Filter
Form-Based Filters

Remove Filter/Sort

Data source as Takle

Figure 30: Navigation buttons

In addition to the properties listed on page 70, the following features are available for the Navigator

o[ [CH][CH]]€>

Bar control.

General tab
[EON SIZ8...ovvve e |Small
PosHtioning.... ... |Show
Mavigation................... [Shaw
Acting on a record............ [Shaw
Filtering / Sorting........ | Show

Data tab

None, as this control only carries out actions.

Events tab

All events that involve the Mouse, a key, or the focus.

The icon size is adjustable. In
addition you can choose which
groups are displayed. These are
shown in Figure 29 from left to
right using a vertical line as a
group separator: Positioning,
Navigation, Acting on a record,
and groups of commands for
Filtering and Sorting.

Chapter 4 Forms

93



Independent of this form control, the insertable navigation bar naturally continues to exist with
the same items as the above figure.

This insertable navigation bar provides additionally the general record search, the form-based filter
and the display of the form's underlying data source in table view above the form.

If you are working not just with a form but with subforms and ancillary forms, you must be careful
that this insertable navigation bar does not disappear as you switch forms. That creates a
disturbing effect on the screen.

Multiple selection

If you use the Select icon (Figure 24) to select a large region or several elements of a form, the
following modifications may be carried out (see Figure 31).

. B Froperties: Multizelection o 2 ‘
Eeneral
Mame. ..o
Enabled. ..o Yes v
VISTOIE. oo Yes v
PHMtabIE. oo Yes v
ANCAOT oo To Paragraph -
POSHtIONX ... oo [ B
POSHIONY oo [ B
Wit [ B
Height oo [ B
Famt [ ]
Background color............ Default ¥

Additional information..... |

T
T
=
T
=

T
i)
=
C
A
=

Figure 31: General properties of form fields in a
multiple selection

You should not alter the name. That would cause all the selected elements suddenly to acquire the
same name. It would make finding individual elements using the Form Navigator difficult, and
management of the form by using named controls in macros impossible.

Multiple selection is more useful for changing the font, the height or the background color of
controls. Note that changing the background color affects the labels as well.

If you want to alter only the labels, hold down the Control key and click these controls directly or in
the Navigator, or right-click on a field to call up the control properties. Now the choice of properties
that you can change is greater as you are dealing only with similar fields. You can change anything
here that is available in a label field.

The possibilities of multiple selection depend therefore on the choice of fields. You can
simultaneously change controls of the same kind that have all the properties that exist for a single
instance.
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A simple form completed

A simple form has form controls for writing or reading records from a single table or query. Its
construction is shown by the following example.

Control field 1

Control field 2

Control field 3

Control field ...

The example of a simple form for library loans is shown here using several variants. The quick way
to use the Form Wizard is described in Chapter 8, Getting Started with Base, in the Getting Started
with LibreOffice guide. Here we describe the creation in Design View.

-|--|-1-|-2-|-3-|-4-|-5-|-E

al .1
: . E.ﬂan ﬂfMecﬁa

IEE

—

The heading for the form was created using a label field. The font was changed. The label field is
anchored to a paragraph in the top left corner of the document. Using the context menu of the label
field, a form was created that was linked to the Loans table (see “Form properties” on page 66).
The page has also been given a uniformly colored background.

Adding groups of fields
A quick variant for direct entry of fields with labels is to use the Add Field function.

_|AddField
B2 B8 [ I

This function, available on the Formula Design toolbar (see Figure 22), allows all fields of the
underlying table to be selected.

[§ & Add field: Table Loan (&) @8

Media_ID
Reader_ID
Loan_Date
Feturn_Date
Exension
Media_ID_BC

Chapter 4 Forms 95



Double-click on the fields to insert them into the form as a group with labels (unfortunately all on
the same spot). The group needs to be separated out so that the form eventually looks like the
following illustration. For a better view, all unnecessary toolbars have been removed from the
window, which has also been compressed so that not all elements of the Navigation bar are visible.

All fields have been selected except Media_ID_BC, which is designed to be used only with a
barcode scanner.
@ - Media_without_Macros odb : Form? - LibreOffice Base: Database Form S 85

File Edit Wiew |nset Format Takle Tools Window Help

B e H & »
Loan of Media
[ 0
Media_ID 1
Reader_ID ]
Loan_Date 110211
Return_Date 11/0411
Extension
# | Record [7 | of 19 BBl P P | & : >
Page 1/1 | Default STD [SK o ® |

Figure 32: Simple form made by using Add Field

For each table field, an appropriate form control has been automatically selected. Numbers are in
numeric fields and are declared as integers without decimal places. Date fields are represented
correctly as date controls. All fields have been given the same width. If a graphical control had
been included, it would have been given a square field.

Adjusting field proportions

We can now do some creative things, including adjusting the length of the fields and making the
dates into drop-down fields. More important still is for the Media_ID and the Reader_ID fields to be
made more user-friendly, unless every library user has a library ID card and every medium is
supplied with an ID on accession. That will not be assumed in what follows.

To adjust individual fields, we must edit the group. This can be done with a right-click on the group
and then following the context menu (Figure 33). For future work, it will be clearer if we use the
Form Navigator.

f Farm Mavigatar

ql_ilt}u W T e Lk
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i =dia_ID

-]
Feader_ID
Laan_Date
Feturn_Date

Extznsion

Figure 33: Form controls: editing the group
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Fosition and Size...

Description...
Mame...

Arrange
Alignment
Wrap
Anchar

Caontral...

Farm...
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..
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[15]
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[1¥]
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The Form Navigator displays all the elements of the form with their labels. For controls, the names

are taken directly from the names of the fields in the underlying table. The names of the labels

have the suffix Label.

A click on Media_ID selects this field (Figure 34). Right-click to replace the selected field with a

different type of field, using the context menu (Figure 35).

Loan of Media

[l

Wedia_lD
Feader_ID

Loan_Date
Feturn_Date

Extension

Figure 34: Selecting form controls directly using the Form Navigator

BEE

)

=

Farm Mavigator

Forms

A=

Farm

asc Label Field 1

asc 1D label

123 1D

asc Media_ID label
123

asC Reader_|D label
123 Reader_ID
Loan_Date label
Loan_Date

gC Return_Date label
Feturn_Date
asc Extension label
123 Extension

FE & E &
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Currency Field
EBattern Field

Image Control

Formatted Field

B - Farm Mavigator ) e
Forms
~ Farm

asc Label Field 1

asc |0 [abel

123 1D

agc Media_ID label

123

Agc Read @By TextBox

123 Read .

Edd| Zut ) Button

aBC Loan_ D

=n Delete

1] Loan asc  Lapelfield

aec Returs Rename |

T Retur Properies i=] Group Box

o Exiar o E .

-]

7] CheckBoX®
= Radio Button
=i Combo Box
(&) Image Button
[l File Selection
Ffl  Date Field
€ Time Field
&
]
&
=]

k|

&

Scroll bar
Spin Button

Mavigation Bar

Figure 35: Replacing one kind of control by another

using the Form Navigator

This replacement is carried out for the Media_ID and Reader_ID controls.

asc Media_ID label

EE
EE

;Bc Reader_ID label

The change is made visible in the Form Navigator by the change in the accompanying icon.
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|j : Properties: List Box & 25

General| Data | Events

Data field.o | Media_ID |~

Input required............... |Yes

Type of list contents..... | Sal

List content................... |. 'T'| t}
Bound figld.................. L =

The SQL query for the list field can now be created through the graphical user interface by clicking
on the button at the right. This is carried out automatically when a list box is created directly, but
not when it is formed by conversion from another type of control. For the SQL command, see
Chapter 5, Queries.

Since the list boxes are to be made drop-down, the following defects can be corrected at the same
time:
* The labels for the list boxes should be Media instead of Media ID and Reader instead of
Reader_ID.

* The ID control should be declared as read-only.

* Any fields which are not absolutely necessary for issuing loans for a new medium do not
need a tab stop. Without it, the form can be traversed much faster. If necessary, the tab
stop can also be adjusted using the activation sequence (see page 70). Only the Media,
Reader and Loan date fields must be accessible in all cases using the Tab key.

* If the form is intended for carrying out loans, it is unnecessary and also confusing for
returned media to be displayed. Media with a return date should be filtered out. In addition,
the display order could be sorted by Reader, so that media on loan to the same person are
displayed successively. See the note on “Form properties” on page 66. However there is a
problem here in that readers can be sorted only by ID, not alphabetically, because the table
underlying the form only contains the ID.

Adding single fields

The addition of single fields is a bit more complicated. The fields must be selected, dragged onto
the form surface, and the appropriate field from the underlying table specified. In addition, the type
of field must be correctly chosen; for example, numeric fields have two decimal places by default.

Only when creating list boxes does the Wizard come into play, making it easier for a novice to carry
out the steps for creating correct fields—up to a point. Beyond that point, the Wizard ceases to
meet requirements because:

* The entries are not automatically sorted.
* Combining several fields in the list box content is not possible.

Here again we need to make retrospective improvements, so that the required SQL code can be
created quite quickly using the built-in query editor.

When adding single controls, the field and its label must be explicitly associated (see “Default
settings for many controls” on page 70). In practice it could be better if you do not associate fields
with the labels. So you must not choose Edit Group before changing the properties of a field.
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Table control

The use of the Table Wizard to create a table control has already been described on page 87. It
has however some defects which need to be improved:

e The Media_ID and Reader_ID fields must become list boxes.

* Numeric fields must be stripped of their decimal places, since the Wizard always specifies
two decimal places for numbers.

m &/ Form Mavigator L) @S

Forms

= [=] Form
agC Label Figld 1
SEE|

Changing fields within the table control is not possible using the same method as described for
other controls. In the Navigator, the description of fields ends with the table control. The Navigator
knows nothing about the controls that lie within the table control, referring to fields in the underlying
table. This equally applies later, when attempts are made to access the fields using macros. They
cannot be accessed by name.

Loan of Media

| Me | Reader ID | Loan_Date Retur
Insert Calumn 3
| | (B TextBox
Delete Column 7| CheckBox
Eidle Column IEB Combo Box
Record | | alumn... Ij 3
MY Date Field
€53 Time Field
5 Currency Field
tvl]  Pattern Field
|=1  Formatted Field

The controls within the table control are called columns. Using the context menu, it is now possible
to replace one type of field by another. However the whole range of types is not available. There
are no push buttons, option boxes, or graphical controls.

1
J— Insert Column

Eeplace with >
Delete Column
Hide Column

——

The properties of the fields are hidden in the context menu behind the concept of columns. Here,
for example, the numeric field Extension can be changed so that no decimal places are shown.
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Also the default minimum value of —1,000,000.00 hardly makes sense for a loan extension. The
number should always remain small and positive.

As soon as the properties of a column are called up, you can select another column without
shutting the properties dialog. In this way you can work on all the fields, one after another, without
having to save in between.

End by saving the entire form, and finally the database itself.

The properties of the fields built into a table control are not so comprehensive as for those outside.
The font, for example, can be set only for the entire table control. In addition, you do not have the
option of skipping individual columns by removing their tab stops.

You can move through a form using either the mouse or the Tab key. If you tab into a
. table control, the cursor will move one field to the right for each additional tab; at the
Tip end of the line, it will move back to the first field of the next record in the table
control. To exit the table control, use Ctrl+Tab.

The order of the columns can be changed by dragging the column header:

Loan of Media

|1—hﬂ%;ﬂ+ﬁ-ﬂﬁi—t&ﬂix |

If this is done in form design view, it is permanent. A temporary change in order can be carried out
during data entry by using the same method.

If only certain fields should be visible during use, you can use several different table controls in the
form, as the Tab is captured by default by each table control.

The form shown in Figure 36 is for the loan of media. Only the fields immediately necessary are
shown in the upper table control. The lower one shows all the fields, so that it is apparent which
person and medium the return is for.

Loan of Media
Reader Medium Loan_Dats |
i |(Lederstrumpf, BEert ﬁ Das sogennante Base 110211
~ |Gerd, Lisa Eine kurze Geschichte der Zeit 10MEM1 H
~|Mirinda, Monika Der klzine Hobbit 1100211 ||
] Lederstrumpf, Bert Traditionelle und kritische Theori 1104711
~|Lederstrumpf, Bert | hearyou knocking 11128111

Lederstrumpf, Bert Die neus deutsche Rechtschreib 1172811
aploretr . omane e A= hraih 14man 4

of 149 ¥ |[M

Feader Medium Loan_Date | Extension Feturn_Date

i |[Leders Q Das sogenn 1100211 1104111 |~
"~ |Gerd, Lisa Eine kurze G 10115111 2 02125112 H
"~ |Mirinda, Mor Der kleine H 11402111 1 o4ioanz |
" |Lederstrum Traditionelle 11004111 2 11028011
~ |Lederstrum | hearyou kn 11J28111 02/03112
"~ |Lederstrum Die neue de 11J28111 040412

| efderetriim Dis neje de 1100911 1 namemM 2
Record |1 | of 19 b (M

Figure 36: A form with multiple table controls
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This figure shows an aesthetic failing that needs urgent attention. In the upper table control, the
same medium sometimes occurs more than once. This happens because the table also shows

media that have been returned earlier. Therefore the data needs to be filtered to show only the

loans. Records with a return date should not appear.

This filtering is possible either by a query or directly using the form properties. If it is done using the
form properties, the filter can be temporarily switched off during input. Filtering using a query is
described in Chapter 5, Queries. Here we describe how to do it using form properties.

E Form Properties -~

General | Data | Events

Content e oo Tahle =
COMEM. oo | Loan ks

Analyze SOL command..... [V&s

FIEN oo |_ | N

111 S | |
Allow additions............. Yes v
Allow modifications..._.... Yes <
Allow deletions.......... Yes <
Add data only.............. No v
Mavigation bar................... Yes ¥
ol Default ¥

The filtering is carried out using the button with the three dots, which opens the dialog shown
below. You can also enter the filter directly into the Filter text field if you know the SQL coding.

m e Fitter v X
Criteria
. . QK
Cperator Field name Condition WValue
'Return_Date & [ 15 Cancel
AND - none - C [ - Help
AMD - nane -

Using the GUI, you can now select the field named Return_Date. It will show only the records for
which the field is empty, where “empty” stands for the SQL designation NULL.

The cleaned-up form (shown in Figure 37) now looks rather simpler.

Of course there is still room for improvement, but compared with the earlier form, this version has
a clear advantage in that all the media are visible at a glance.

The processing of data using table controls is similar to using an actual table. A right-click on the
record header of an existing record causes it to be deleted, and an entry can be canceled or saved
in the case of new records.

When you leave a line, the record is automatically saved.
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Loan of Media

Feader Medium Loan_Date
g |[Lederstrumpf, Bert = || Traditionelle und kritische Theari 120911~
~|Lederstrumpf, Bert Das Postfix-Buch 02125112
~ |Mobody, Terence Der kleine Hobbit 04/04/12 | =
~|mdller, Heinrich Eine kurze Geschichte der Zeit 04i04/12
"~ |Lederstrumpf, Bert Das sogennante Bise 0404112
| maller, Heinrich Im Augenblick 0412212
Gord lica Diatonbanban it SOnanOiffice srm 1AM 7D
Recaord |1 | of T (][]
Reader | Medium Loan_Date | Extension Return_Date
B |(Leders 2 | Traditionelle 12109011 -
~|Lederstrum Das Postfix| 02125112
~ |Mobody, Ter Der kleine H 04/04/12 =
~|Miiller, Hein Eine kurze G 04/04/12 1
" |Lederstrum Das sogenn 0404112
| maller, Hein Im Augenblit 04122112
Gerd |isa Oatenhanks 104 712 >
Recaord |1 | of T (1M

Figure 37: Amended form

We can still improve the Loan of Media form in a number of ways.

* It would be nice if selecting a reader in one part of the form caused the media on loan to
this reader to be displayed in another.

* In the table shown above, you can see a lot of records that are not necessary because
these media are already on loan. The table was created to allow loans to be made, so it
would be better if only an empty page appeared, which could then be filled with the new
loan.

Such solutions are available using further forms that are hierarchically arranged and make possible
separate views of the data.

Main forms and subforms

A subform lies within a form like a form control. Like a form control, it is bound to data from the

main form. However its data source can be another table or a query (or a SQL command). The
important thing for a subform is that its data source is somehow linked to the data source of the
main form.

Control field 1 Control field 1

Control field 2 Control field 2

Control field 3 Control field 3

Control field ... Control field ...
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Typical table structures that lend themselves to use as subforms are tables with a one-to-many
relationship (see Chapter 3, Tables). The main form shows a table with records to which many
dependent records in the subform can be linked and displayed.

First we will use the relationship of the Reader table to the Loan table (see Chapter 3, Tables). The
Reader table will form the basis for the main form and the Loan table will be reproduced in the

sub-form.

General| Data | Events

Farm Properties & 2

Content type. ..o Tabl -
Content. ... [Ruadur | v L
Analyze SQL command..... |Yes *

FIRBT. oo [ | (]
SO "Lasthame" ASC, "Firs] [.. |
Allow additions................ |Yes 3
Allow modifications...______. |Yes o
Allow deletions.._.._.... |Yes o
Add data only.................... |No 3
Mavigation bar............... |No -8
CYEIR ., \Default -

Here the main form is linked to the Reader table. To speed up the search for readers, the table is
sorted alphabetically. We will do without a navigation bar, since the content of the subform would
come between the main form and the navigation bar. Instead we will use the built-in form control

(Figure 29).
B .. Form Navigator = (%
Forms
W
ABC |_|

Cut
Delete
Tah Order...
Eename
Properies

71 Hidden Control

Right-click on the main form in the Form Navigator to use the context menu to create a new form.
Once again this form has the default name of Form, but it is now an element in the subfolder of the

main form.
. m &/ Form Mavigator 2 25
Forms
~ Form
agc Label Figld 1
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The properties of the subform must now be set up to give it the right data source, in order to
reproduce the data for the correct reader.

| m Farm Properties e @8 1
General| Data | Events
Contenttype. ..o Table *
COMEN e, [Luan | v ] L
Analyze SQL command..... |Y&S v
FIET oo (("Loan""Return_Date'| [ .|
SOMeree s "Loan_Date" ASC | [..
Link master fields............ [ =) L
Link slave fields................ [ (=] L.
Allow additions................ |Yes <)
Allow modifications....... \Yes ]
Allow deletions............. \Yes ]
Add data only.................... \No <)
Mavigation bar............... |Yes Sl
Lo S \Default Sl

The Loans table is chosen for the subform. For the filter we specify that the Return date field
should be empty ("Return_Date" IS NULL). This prevents any media that have already been
returned from appearing. The records should be sorted by loan date. The ascending sort shows
the medium on loan for the longest period at the top.

Link master fields and Link slave fields are used to create a linkage to the main form, in which the
subform lies. The button with three dots shows once again that a helpful dialog is available for
creating these.

0y Link figlds 2 2%
Sub forms can be used to display detailed data about the current | oK |
record ofthe master form. To do this, you can specify which columns -
in the sub form match which columns inthe master form.

| Cancel |
Loan Reader
(Reader_ID ~] (D ] [ Hetb |
[ ) 1~)
[ B [¥]
[ ] | [ [ _seasest ]

Under Loans, the fields in the Loans table are shown, under Readers those of the Reader table.
The Reader_ID from Loans should be set as equivalent to the ID from the Reader table.

Although this linkage has already been created in the database using Tools > Relationships (see
Chapter 3, Tables), the function that lies behind the Suggest button in this dialog does not
reference this and would suggest that the first foreign key in the Loan table, namely Media_ID,
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should be linked with ID from the Reader table. The Form Creation Wizard solves this better by
reading the relation from the relationship of the database.

Link master fislds..... D" ]| ..

Link slave figlds................. 'Reader_ID" 7)

The chosen link between the table for the subform and the table for the main form is now specified
in terms of fields from the tables.

To create a table control for the main form, we must now select the main form in the Form
Navigator. Then, if the Table Control Wizard is enabled, it will show the fields available in the main
form. We deal with the subform in a similar way.

Once the table controls have been set up, we need to carry out the modifications already
discussed when creating the simpler form:

* Replacing the numeric field Media_ID in the subform with a list box.
* Renaming the Media_ID field Media.

* Modifying the numeric fields to a format without decimal places.

e Limiting the minimum and maximum values.

* Renaming other fields, to save space or to add non-ASCII characters which should not be
used in field names in database tables.

Sort and filter functions are supplemented for the main form by adding a navigation bar. The other
fields on the navigation bar are not needed, as they are mostly available from the table control
(record display, record navigation) or else carried out by movement through the table control (data
storage).

The final form might look like the figure below.

Loan of Media
i RYT #
ID | LastName Firsthame | Lock | Gender |
4 Keindurchblick Hein [ male -
0 Lederstrumpf Bert [ male
3 Mirinda Monika [ female |E|
_b ] L]
T MOGiggang Kerstin [] |[female =
Recard |7 | of 10 (1) M4 ][M
Leaned Media of the chosen Reader
Media | Loan_Date | Return_Date | Extension
p |[Eine kurze Geschichfe d 7 04/0412
Im Augenblick - Mo, &8 04422112
Record [1 [ of 2 I

Figure 38: Form consisting of a main form (above) and a
subform (below).
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If a reader is now selected in the main form, the subform will show the media on loan to that
reader. When an item is returned, it continues to appear on the form until the form itself is
refreshed. This occurs automatically when another record is loaded into the main form. If the
original reader is selected again, returned media are no longer displayed.

This delayed updating is actually desirable in this case, as it allows one to inspect the media
currently lying on the library counter and see at once whether these have been registered.

This form structure is significantly easier to use than the previous one with only a single form.
However there are still details that can be improved:

* Media and loan dates might be changed when the media is to be loaned out for longer.
Changing the media date might make it impossible to trace which item is still available in
the library and which is on loan. Changing the loan date could lead to errors. Recall notices
could not be verified.

* If areader record is not selected by clicking on the record header at the left, only the little
green arrow on the header shows which record is currently active. It is quite possible that
the active record will be scrolled right out of the table control window.

e Instead of the text “Loaned Media of the chosen Reader”, it would be better to have the
reader’s name.

e |tis possible to loan out the same medium twice without it having been returned.
e Itis possible to delete the record for an item on loan quite easily.

* Data can be changed or deleted in the main form. This can be useful for small libraries with
little public traffic. However when things become hectic at the loans counter, editing of user
data should not take place at the same time as issuing loans. It would be better if new
users could be registered but existing user data left untouched. For libraries, this applies
equally to deletions or complete name changes.

First let us improve the selection of readers. This should protect us from changes to the loan
records. A simple solution would be not to allow any modification except the entry of new records.
This still requires a search function when a reader wishes to borrow an item. It would be better to
use a list box to find the reader and carry out the issue and return operations in separate table
controls.

For the main form we need a table, into which the list box can write a value linked to this table. The
table requires an integer field and a primary key. It will always contain only one record, so the
primary key field ID can safely be declared as Tiny Integer. The following table named Filter should
therefore be created.

Table name: Filter

Field name Field type

ID Tiny Integer, Primary key
Integer Integer

The table is given a primary key with the value 0. This record will be repeatedly read and rewritten
by the main form.

Chapter 4 Forms 107



B Farm Properties

General| Data | Events

Content tpe. oo |Table =
Content. ... [F”’EEF | v L
Analyze SQL command..... |Yes *

FIBT. oo (Fitter D" ="0) ][]
T S [ | (]
Allow additions.......... |No <)
Allow modifications........... |Yes S
Allow deletions............. |No S
Add dataonly.......... |No <)
Mavigation bar.............. |No -
CYEIE. | Default <]

The main form is based on the Filter table. It will just read the value from the table which is
associated with the primary key (/D) of 0. No data will be added; the current record will just be
repeatedly rewritten. As only edits of a single record are allowed, a navigation bar would be

superfluous.

Link master fields. ... Mnteger”

=] ..

Link slave fields_........... 'Reader_ID"

(=] ...}

This main form is linked to the subform in such a way that the value of the Integer field in the Filter
table is the same as the value of the Reader_ID field in the Loan Table. The subform’s properties
are unchanged from the version shown above.

Before we create a list box in the main form, we must switch off the wizards. The list box Wizard
only allows you to create a box that shows the content of a single field; it would be impossible to
have surname and given name and an additional number in the display area of a list box. As in the
simpler form, we now enter for the list box contents Surname, Given name — ID Nr. The list box
transmits the ID to the underlying table.

0o Properties: List Box 2 (9
General | Data | Events
Datafield. ... (Integer |~}
Input required.......... |Yes =l
Type of list contents.... | Sal < |
List content.............. [ (=] .-}
SELECT "LastMame"||", -
Bound figld................. |.”..FirStNamE..”._ Mo D" D"
FROM "REeader ORDER BY
"Lasthame" 3
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Next to the list box, a button is created. This button is actually part of the subform. It takes over two
functions: saving the record in the main form and updating the table in the subform. It is good
enough to entrust the update to the button in the subform. The save process for the modified main

form is then carried out automatically.

The button can simply be labeled OK. The action assigned to it in the general properties of the
button is Refresh Form.

Loan of Media

B Form Mavigator o 5

Forms
Loaned Media of the chosen Reader v :;I Tabemem
=j Listfield 1
= Form
EH Tablecontral 1
asc Labelfield 1
() Button 1

- OK|

Media | LoanDats | R

L

Record | | of < 1 >

Figure 39: Main form as a filter for a subform

The main form consists only of the heading and the list box; the subform contains another heading,
the table control from the previous version and the button.

The form now functions better in that:
* No reader can now be edited, altered or deleted, and
* Readers can be found more quickly by typing into the control than by using a filter.

For a greater degree of functionality (returns without alteration of previous data) a second subform
must be created, linked to the same Loans table. To ensure the functionality of the list box in Figure
39, both subforms must be placed one level further down, as subforms of a subform. Data is
updated hierarchically from the main form down through the subforms. The button in the previously
described form must now be placed in the first subform and not in the two subforms that come

under it.

B Farm Mavigator & 25

Forms
= Form
agc Labelfield 1
= Listfield 1
= Farm
() Button 1
~ Form
E=o Tablecontral 1
= Form 1
EH Tablecontral 1
asc Labelfield 1

Here the Form Navigator is used to show the different levels. In the main form we have the text
field for the form title and the list box for finding the reader. The list box appears at the bottom of
the form, as it is declared after the subform. Unfortunately this display sequence cannot be altered.
The subform has only one button, for updating its contents and at the same time saving the main

Chapter 4 Forms 109



form. One level further down are the two additional subforms. These are given different names
when created so that no confusion arises in any level of the tree.

Basically the names of forms and controls are without significance. However if these
names are to be accessed by macros, they must be distinguishable. You cannot
distinguish identical names at the same level.

N . . .
o Naturally it makes sense, when creating larger form structures to have meaningful
names for forms and their controls. Otherwise finding the right field could quickly
become problematic.
SR B g Faorm Mavigater B & Form Properties & & |
BOK
Forms General| Data | Events
- Form —
aBC Labelfield 1 || Contenttype. ... |Table v |
Listfield 1 content......... (Filter [v] [
- N
() Buttan 1 Analyze SQL command..... |_‘f’ES et
v B Form ¥ Fijer (]
i o Taprd | FIET [ |
£ i - Farm 1 b e e o e o B [ ] |_|
EH Table | | i masterfislds.. ... ['Integer' (=]l
asc Label [I . =Tm
i 'Integer” [=] |...
i = . _4 Link slave fields................ _| e
Allow additions.................. Mo o
Allow modifications ... Mo -
Allow deletions.......... (Mo -
Add data only............... (Mo 2
T« i E s -~
Mavigation bar............. [No 2
e R \Default o

The main form and the subform use the same table. In the subform, no data are entered. That is
why all the fields for this form are set to No. The main form and the subform are linked through the
field, whose value is to be transmitted to the sub-subforms: the Integer field in the Filter table.

Filter oo ("Loan""Loan_Date" 1S NULL) | [...|

In the first sub-subform, no existing data are displayed; it is used only for creating new data. For
this, the suggested filter is adequate. Only records matching the Reader_ID and with an empty
loan date field ("Loan_Date" IS NULL) will be displayed. In practice, this means an empty table
control. As the table control is not continuously updated, newly loaned media will remain within it
until the OK update button is used either to select a new name or to transfer the data into the
second sub-subform.
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The second sub-subform requires more settings. This form too contains data from the "Loans"
table. Here the data is filtered for an empty return date. ("Return_Date" IS NULL). The data are
sorted as in the previous form, so that the media on loan for the longest time are immediately

visible.

B _ Farm Properties

General | Data | Events

Content type.....ooooo. Table =
Content............... [L-::.an i
Analyze SOL command..... V&S v
T |("Loan""Return_Date" IS NULL)| [...
SOM 'Loan_Date" ASC J L.
Link masterfields......... Integer” M|
Link slave fields................ 'Reader_ID" M|
Allow additions........... Mo .
Allow modifications ... Yes .
Allow deletions. ... Mo .

Add data only............. Mo =
Mavigation bar............... Mo v

O LY Default v

The following points are also important. Old records can be changed, but no new records can be

added. Deletion is also impossible. This is the first necessary step to prevent loan records from
being simply deleted later on. But it would still be possible to change the medium and the loan

date. Therefore the properties of the columns will require adjustment. Eventually the medium and
the loan date should be displayed but protected from modification.

The table control is simply duplicated after the creation of the form. This is done by selecting it,
copying, deselecting, and then pasting it in from the clipboard. The copy will be at the same

position as the original, and will therefore need to be dragged away. After that, both table controls

can be edited separately. The table control for the media return can be left practically the same.
Only the write access for the Media and Loan date columns need to be changed.

While for the Loan date it is only necessary to choose Read only, this is not sufficient for list boxes.
This setting does not prevent the list box from being used to make changes. However if Enabled is

set to No, a choice cannot be made there. A list box contained within the table control is then

displayed as a read-only text field.

In the above table control, all fields that have nothing to do with the loan are removed. Only the

medium as a selection field and the loan date Loan_Date remain.

If finally the query for the list box in the upper table control is selected, only those media are
displayed which can actually be loaned out. More about this is in Chapter 5, Queries.
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Loaned Media of the chosen Reader

| Loan Date Return Date Extension
m Properties: List Box 2 P_:
eneral | Data Events
NGME. oo |MumericField1 |
Record | [of Label. oo Media =
ENabled. .o ; =
Read-only...................... |Yes N -
Mouse wheel scroll......... \Never A
WA, o 16.01cm B
List enfries.........cccoooeee
Alignment......... | Default <
Ling Count ..o 5 B
Default selection............. [ IEI| :
Additional information..... | |
Help text oo [ |
Help URL. oo [ |
Loan of Media
Miller, Heinrich - Mo, 1 - (4] .4 |
Media LoanDate
B |l oD 04/29/12
4 - Die neus deutsche Rechtschreibung - by Hermann, Ursula
s
Record [1 [ of 1
Leaned Media of the chosen Reader
Media | Loan Date Return Date Extension
> |Eine kurze Geschichte der Zeit- Mo. 2 04/04112 1
Im Augenblick- Mo, 8 042212

Record [1 [ of 2 [»]m]

Figure 40: The selection field in the upper subform shows only media that are not

on loan.

The media loan form is already significantly more useful. When a reader arrives at the loan
counter, his or her name is searched. The media to be loaned can be selected using the list box

and the loan date entered. The Tab key then takes you to the next record.
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Afinal improvement is also desirable: at present the loan date must be selected each time.
Imagine a day in the library with perhaps 200 loan transactions, perhaps just one person, who has
to loan out about 10 media each time. That would require the same entry for the date field over and
over again. There must be a way to simplify this.

Our main form is linked to the Filter table. The main form works only with the record that has as its
primary key the "ID" 0. But additional fields can be built into the Filter table. At present there is no
field that can store a date, but we can easily create a new field with the field name Date and the
field type Date. In the Filter table we now have stored not only the Reader_ID ("Filter"."Integer") but
also the Loan_Date ("Filter"."Date").

Loan of Media [§ &  Form Navigater -
Forms

] - Farm
:E a6 Labelfield 1

=M Listfield 1
Medi asc Labelfield 2
o=t —
(L]

= Farm
() Button 1
- Farm
= Tablecontral 1
- - Faorm 1
o] i F Tablecontral 1 L
Loaned Media of the chosen Reader asc Labelfield 1

Date of Loan:

[ B =]

[ ] Media | Loamoate T Remrmmoae T EXNENSTn

In the main form, an additional date field appears, along with a label referring to its content. The
value from the date field is stored in the Filter table and transferred by the linkages from subform to
sub-subform.

Link master fields.............. [Integer;"Date” ) L.

Link slave fields............. [Reader_ID""Loan_Date" ] ...

The linkage between the two forms now refers to two fields. The Integer field is bound to the
Reader_ID field of the sub-subform. The Date field is bound to the Loan Date field. This ensures
that the Loan_Date is automatically transferred from the Filter table to the Loans table when the
loan is made.

Loan of Media
Elau, Annelise - Mo, & - OK
Date of Loan: 1117H 2 j
Media |
[ =

Figure 41: The date of the loan is entered only once. When the Reader changes, it
must be reentered.

The date field is now removed from the table control, so that the latter contains only one search
field. This would be the ideal requirement for speeding up even more the work of the library. For in
fact each medium will have a printed accession number, so why does that have to be searched?
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You can just enter the number directly. Or, better still, it could be scanned in with a barcode reader.
Then media can be loaned as rapidly as the borrower can stow them in his bag.

This is illustrated in the example database. The above example should suffice for understanding
the initial form design but, as the example database, Media_without_Macros.odb, develops the
form further, the extra refinements are briefly presented below.

Loan
First Name Last Name | 10| Fitber (Last Name)
Annelise Elau 8 |- oK
Garba 8 |
Keindurchblick 4
Lederstrumpf 1]
k3 lfrinda 3l X
[af 10 (1) W[ [
Record of 10 I 4 b Bl P & P I

Loan for Reader Gerd, Lisa

Loan D ate: 1wz

cumrent Loan
hdediurm | Loan Date |
[ |1 - Das sagennante Bdse - by Lorenz, Konrad 1117012
Riecord [I [af [
Return
hediurm Loan Date | Retum Date | BExtension | Loan Days | Balance Time
[+ |G - Datenbanken mit OpenOffice.ang 3 - by 7 11072 10 Days 4 Days
Riecord [I [af [

The Loan form shows the following properties:
* Readers are displayed in a table control. Here you can also enter new readers.

* Using a filter, linked to the Filter table, names can be filtered using their initial letter. So, if
you enter A, only people whose surname begins with A will be displayed. This filtering is
case-independent.

* The subtitle shows again the name of the person to whom the loan is to be made. If a lock
has been placed on this borrower, this is also displayed.

* The loan date is set to the current date. This is done in the filter table using SQL such that,
when no date is entered, the default value to be stored is the current date.

* Loanable media are selected using a list box. When the Update button is pressed, the loan
is transferred to the table control below.

* The table control in the middle serves only to display the actual date of loan for the media.
Here it is also possible to correct an error retrospectively by deleting the line.
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* Inthe lower table control, as in the above example, alteration of media and loan dates is
not possible. Nor is it possible to delete records.

* Apart from the entry of the return date or, if appropriate, an extension of the loan, this table
also displays the number of days for which the medium can be loaned and how many days
remain of the current loan period.

* If this remaining time becomes negative, the medium must be returned immediately. The
issue is then locked. It becomes possible again only when the medium is returned. After the
return, the Update button need only be pressed once.

This form, made by using queries, is significantly more complex in its structure than the previously
shown version. You can learn more about the essentials of this in Chapter 5, Queries.

One view — many forms

While the example for the Loans form only involves entries into one table (the Loans table) and
additionally allows entry into the simpler form for new readers, the entry procedure for media is
significantly more extensive. In its final form, the media table is surrounded by a total of eight
additional tables (see Chapter 3, Tables).

The Subtitle and rel_Media_author tables are linked to subforms of the Media form through a n:1
relationship. By contrast, tables with a 1:n relationship to the Media table should be represented by
forms that lie above the Media table. As there are several such tables, their values are entered into
the main form using list boxes.

The table of a main form stands to the table of a subform in a 1:n relationship, or in some
exceptional cases 1:1. Therefore, after long use of the database, the main form usually manages a
table which has significantly fewer records in it than the table belonging to the subform.

Multiple main forms cannot include the same subform. Therefore it is not possible to create a form
arrangement for many simultaneous 1:n relationships in which the subform has the same content.
When there is a 1:n relationship for the table belonging to a form, you can use a list box. Here
there are only a few terms available from another table, those whose foreign keys can be entered
into the main form's table in this way.

| Listfield | | Listfield | | List field |
1 1 1
n n n
Mainform
1 1
n n
Subform Subform

Using list boxes, the main form based on the Media table can be assigned values from the
Category, Town or Publisher tables. Subforms are used to link the rel_Media_Author and Subtitle
tables with the main form and through it with the Media table.

The subform for the rel_Media_Author table again consists of two list boxes so that the foreign
keys from the Authors and Author_Add_ID (additions might be for example editor, photographer,
and so on) do not have to be entered directly as numbers.

For the media entry form, the list boxes usually have to be filled up gradually during the entry
process. For this purpose, further forms are built in alongside the main form. They exist
independently of the main form.
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Control field 1

Control field 2

Control field ...

Control field 1

Control field 2

Control field ...

The overall form for entering media looks like this:

Media - Input and Searching

Searchiten Editing Cortert of Listfields
Wan ueen oK Category Description [
. |Fantasy
£
[ln] Title Liedermache
8 | [im Augenbiick | |_|Roek
Categary Iediastyle Fecord |1 [of 3
|IJederrnacher J |GD j ediastyle | Loantime
Town Publisher Pub-Year Edition Price [§] i |Buch 14 Days
= - co T Days
i K I | [0 ] —{owo 7 Days
Author Sort. | Author [ Ahor Add T ISENISSN Fecord [1 [of 3
; 1 ween, H
L T —
— i |Dresden -~
Harriburg L
Miimberg 7
Fecord [1 [of 1 Pusemuckel -
Comment Fecord |1 [of 4
No | Subtitle [ Length ] Publisher
b 1 Amsterdam e | L |
2 Hier unten arn Deich N
3 Hiln- Ehrenfeld E
4 Bei Mir
5 Goft sei Dank A Record [i [of 1
Fecord |1 |of H AT »

On the left side is the main form with a view to searching and entry of new media. On the right side
of the form is a group box with the label Edit list box contents, providing a separate area intended

First Name Anhor] Last Name Author |

| @ |Dave Edrmunds e
Or. Lutz Gitze £l
[ | stewen w. Hawking | N
[ |Dr. Kaus Heller 1
Fecond [1 [af 10
Author Add
| & | Geleitwort -
Hrsyg. =
[ | Mustration ]
[ liberarbeitst -
Fecord |1 [of £}

for filling up the list boxes in the main form. If the database has not existed for long, it will often be

necessary to make entries into these fields. However, the more entries that are available for the list

boxes of the main form, the less often will access to the table controls in the group box be

neces

sary.
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The following table controls are all subordinated as individual side forms to the main form, the entry
form.

Editing Content of Listlields

Category Description
i |Fantasy
Liedermache
Fock
Record [1 | of 3 k(M
Mediastyle | Loantime
i |Buch 14 Days
cD 7 Days
owD 7 Days
Record [1 [ of 3 k(M
Taown
i |Dresden -
Hamburg -
Mirmberg
Fusemuckel =
Record [1 [ of 4 A
Fublisher
K]
Record [1 | of 1
First Name Author | Last Name Author |
i |Dave Edmunds -
Dr. Lutz Gitze -
Steven W, Hawking
Dr. Klaus Heller =
Record [1 [ of 10 b [
Author Add
B |Geleitwort -
Hrsg. -
llustration
Uberarbeitet bl
Record [1 of 4 kM

Here in each case the complete data for a table are entered. In the early stages, it is often
necessary to have recourse to these side forms, since not many authors are yet stored in the
corresponding table.

When a new record is stored in one of the table controls, it is necessary to find the corresponding
list box in the main form and use the Update control (see Navigation bar) to read in the new values.

The Form Navigator shows a correspondingly large list of forms.

Chapter 4 Forms 117



m o/ Form Mavigator

(F5 Forms

[=] Filter
[=] MainFarm
[=] Category
=] Mediastyle
=] Town
=] Publisher
=] Author
=] Author_Add

R i A A i~

The forms have been individually named to aid recognition. Only the main form still has the name
of MainForm given to it by the Wizard. Altogether there are eight parallel forms. The Filter form
hosts a search function while the MainForm form is the main input interface. All the other forms
relate to one or other of the table controls shown above.

Without the table controls, the main form looks somewhat simpler.

Media - Input and Searching

Searchitemn
‘Jan ‘Jeen 0K |
10 Title
8 | [1m Augenbiick |
Category hediastye
|Uederrnacher j |l3l:l j
Tawn Publisher Pub- Year Edition Price [§]
N o] feoe | | (s |
Author Sort. | Authar | Adthor Add | ISEMISSN
i 1 wan ween, Herman |:|
Recard [1 [of 1 .
Carmment
No | Subtitle | Length |
[ 1 Amsterdamn -
2 Hier unten am Deich L
3 Kdin-Bhrenfeld =
4 Bei hir
5 Gott sei Dank s
Record [i [af 5 Bt AT

The field for the search term lies in the Filter form, the two table controls (for the author and the
subtitle) lie in the subform of the Media Entry main form.

In the Form Navigator, this form looks much more complex, as all the controls and labels appear
there. In the previous form, most of the fields were actually columns within the table controls and
were thus invisible to the Form Navigator.

Unfortunately the sequence within the Form Navigator cannot easily be changed. So, for example,
it would seem more sensible to place the subforms Subtitle and Author as branches of MainForm
right at the beginning. But within the Form Navigator, individual controls and subforms are simply
shown in the order in which they were created.
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m o/ Form Mavigator L&) 25

Forms
[ Filter
- MainForm
agc |bID
[=] fmtiD
asc |hbITitle
[E8g] ttTitle
asc |bIEdition
[z8c] tdEdition
asC |bIPub_Year
=] frtPub_Year
agc [hIComment
[E8g] ttAnmerkung
asc |blCategory_ID
=l frtCategory_ID
asc [bIMediastyle_ID
=W fritMediastyle_ID
asc [blTown_ID
=@ fmiTown_ID
asc [bIPublisher_|ID
El fmtPublisher_ID
asC |bIPrice
|| fmitPrice
asc |blIPicture
e imgPicture
() Button
asc [BIISBM
123 numMISBM
[aeg] tAISEM
= Authaor
EEH Tablecantrol
= Subtitle
EEH Tablecantrol
Categaory
Mediastyle
Town
Fublisher
Author
Author_Add

T R v v

The Form Wizard provides the controls with particular abbreviations which appear next to the icons
and indicate what type of control this is. Labels begin with 'Ibl', text fields with 'txt' and so on.
Altogether labels provide only secondary information for data entry. They can also be placed
directly above text frames and then do not appear in the Form Navigator.

The sequence of the elements in the navigator has nothing to do with the tab sequence. That is
determined by the Activation Order.

 |Activation Grder

OGRS

The activation sequence for a particular form is invoked, when an element of the form is selected
and then the Activation sequence button is clicked. For a simple form, it is not necessary to do
things in this order, but where there are many parallel forms, the function needs to know which
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form is intended. Otherwise, by default, it is the first form in the Form Navigator. In the above
example, this contains only a single text field.

B o Tak Crder ) X

Controls

(@B b UTton; Move Up
Esg| fmtiD —

[mB] beATitle Move Down
EM fmtCategory_ID _ :
|_H frtediastyle_ID Autornatic Sort
=8 fiTown_ID ~

=@ fmtPublisher_ID

[zsc] fmtPub_Year

[zsc] ttEdition

[#8g] frmtPrice 5
|| imgPicture =
123 numlsSBM

[Eg| betAnmerkung _ Cancel
[z5c| betlSEM ; e

The activation sequence allows all the elements that transmit data to the underlying table of the
form or can carry out actions, to be put in order. This corresponds to setting the activation
sequence in the control properties listed on page 70.

Note that in the activation sequence, some controls appear for which the tab stop is actually
switched off. They are included in the list, but are not in fact accessed through the keyboard when
working with the form.

Fields can be automatically sorted in the order in which they appear on the form background. The
higher up a field lies, the earlier it comes in the sequence when you use Automatic Sort. For fields
at the same height, the leftmost field comes first. This sorting functions without error only when the
elements were exactly positioned using the grid when the form was created. Otherwise you will
need to adjust them. Simply select a control and use Move Up or Move Down to move it higher or
lower in the sequence.

If there is a subform, Automatic Sort jumps directly into the subform after completing the main
form. In the case of a table control, this causes the cursor during keyboard input to be trapped
within this subform; you can only free it by using the mouse or by pressing Ctrl+Tab.

The Automatic Sort functions only once for a table control. A subsequent subform with a table
control will not be included. Parallel forms are not taken into account either. An Automatic Sort
cannot be made retrospectively for a subform with a table control. The subform must be completely
removed (temporarily moved to another form).

m Form Properties
General|Data | Events

CONtENttYPE...oocccccer |Query *

Bhomient . (Media_Input_Search_Result | ~

The data substrate for the form for media entry is in this case not a table but a query. This is
necessary as the form is to be used not just for entering records but also for searching. The form
also contains a text field which shows, after saving, whether the ISBN number entered was correct.
This too is only possible using a comprehensive query. To understand the background of this, it is
therefore necessary to discuss the fundamentals of queries, covered in Chapter 5.
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General information on queries

Queries to a database are the most powerful tool that we have to use databases in a practical way.
They can bring together data from different tables, calculate results where necessary, and quickly
filter a specific record from a mass of data. The large Internet databases that people use every day
exist mainly to deliver a quick and practical result for the user from a huge amount of information
by thoughtful selection of keywords — including the search-related advertisements that encourage
people to make purchases.

Entering queries

Queries can be entered both in the GUI and directly as SQL code. In both cases a window opens,
where you can create a query and also correct it if necessary.

Creating queries using the Query Design dialog

The creation of queries using the Wizard is briefly described in Chapter 8 of the Getting Started
guide, Getting Started with Base. Here we shall explain the direct creation of queries in Design
View.

In the main database window, click the Queries icon in the Databases section, then in the Tasks
section, click Create Query in Design View. Two dialogs appear. One provides the basis for a
design-view creation of the query; the other serves to add tables, views, or queries to the current
query.

As our simple form refers to the Loan table, we will first explain the creation of a query using this
table.

Do Add Table or Query

@ Tables () Queries | Add |

= Filter & | |
HH Gender

HH Grade |
B

= Media

e Mediastyle

A Posteode

Hx Preferences

= Fublisher

HH Reader

A Recall

= rel Media Author

S

From the tables available, select the Loan table. This window allows multiple tables (and also
views and queries) to be combined. To select a table, click its name and then click the Add button.
Or, double-click the table’s name. Either method adds the table to the graphical area of the Query
Design dialog.

When all necessary tables have been selected, click the Close button. Additional tables and
gueries can be added later if required. However no query can be created without at least one table,
so a selection must be made at the beginning.
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'IE - Media_without_Macros.odb : Query1 - LibreOffice Base: Query Design > =~ %
Ellz Edt ¥ew Insert Tools Window Help

HE -« & ne #E* = KEEY
E Loan . =
. Graphical Area E
7o (for representing tables and
Media_ID relationships between them)
Reader_|D
Loan_Datz
Feturmn_[Data
Extension
Media_ID_BC
{ I | 3 =
| |
Field —
Alias
Table Tabular Area

= Choice of fields from the tables shown above
ia— » Display names for fields (aliases)

Visible = Sorting by a selected field I
- = Setting a field as invisible

son

Function | - Functions (database-dependent) |
Criterion = Criteria for filtering data
ar

of i | >
Figure 42: Areas of the Query Design dialog

Figure 42 shows the basic divisions of the Query Design dialog: the graphical area displays the
tables that are to be linked to the query. Their relationships to each other in relation to the query
may also be shown. The table area is for the selection of fields for display, or for setting conditions
related to these fields.

Click on the field in the first column in the table area to reveal a down arrow. Click this arrow to
open the drop-down list of available fields. The format is Table_name.Field_name — which is
why all field names here begin with the word Loan.

Field | hd
Al|as— Loan.lD b
Tahle Loan.Media_ID
—  Loan.Reader_ID
Sort Loan.Loan_Date
- Loan.Return_Date
Visible Loan.Extension
Function Loan.Media_ID_BC

The selected field designation Loan. * has a special meaning. Here one click allows you to add all
fields from the underlying table to the query. When you use this field designation with the wildcard
* for all fields, the query becomes indistinguishable from the table.
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rm -~ Media_without_Macros.odb : Query1 - LibreOffice Base: Query Design >~ = X
Eile Edit “iew [nsert Tools Window Help

H =2 B D (]| P FA=] kg
=] #€ B i F - T R v
ID | Media_lD | Reader_D | Dateoflssue | ReturnDate |
24 a 1 12.0313 -
26 i 1 280313
28 3 i 01.0413
24 4 i 040413 =
21 0 9 04.0313
=AutoF
Record [1 [ of [ b M
H: Loan E
71D
Media_ID
Feader_ID
Loan_Date
Return_Date
Extension
Media_ID_BC
< i | ¥
Field In} Media_ID Reader_(D Loan_Date Return_Date =
Alias Date oflssue  |Return Date
Table Loan Loan Loan Loan Loan =
Sort ascending ascending
Visible U h
Function
Criterion IS EMPTY
Qr =
< I | ¥

[N 4

The first five fields of the Loan table are selected. Queries in Design Mode can always be run as
tests. This causes a tabular view of the data to appear above the graphical view of the Loan table
with its list of fields. A test run of a query is always useful before saving it, to clarify for the user
whether the query actually achieves its goal. Often a logical error prevents a query from retrieving
any data at all. In other cases it can happen that precisely those records are displayed that you
wished to exclude.

In principle a query that produces an error message in the underlying database cannot be saved
until the error is corrected.
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ID [ Wedia_D Media_ID | Re:
p |2 f

24
26
28
29
21

=AutoF

O F ) L R 00 k2

D) P L) R OO0 R
[T=1R=r 10 = I Y e

Figure 43: An editable query Figure 44: A non-editable query

In the above test, special attention should be paid to the first column of the query result. The active
record marker (green arrow) always appears on the left side of the table, here pointing to the first
record as the active record. While the first field of the first record in Figure 43 is highlighted, the
corresponding field in Figure 44 shows only a dashed border. The highlight indicates that this field
can be modified. The records, in other words, are editable. The dashed border indicates that this
field cannot be modified. Figure 43 also contains an extra line for the entry of a new record, with
the ID field already marked as <AutoField>. This also shows that new entries are possible.

) A basic rule is that no new entries are possible if the primary key in the queried
Tip table is not included in the query.

Field In] Media_ID Reader_[D Loan_Date Return_Date

Alias Date of Issue  |Return Date

The Loan_Date and Return_Date fields are given aliases. This does not cause them to be
renamed but only to appear under these names for the user of the query.

ID | Media D | Reader ID | Dateoflssue | RetunDate |
122 B 1 04.03.13

The table view above shows how the aliases replace the actual field names.
Return_Date
Return Date

Loan

IS EMPTY

The Return_Date field is given not just an alias but also a search criterion, which will cause only
those records to be displayed for which the Return_Date field is empty. (Enter IS EMPTY in the
Criterion row of the Return_Date field.) This exclusion criterion will cause only those records to be
displayed that relate to media that have not yet been returned from loan.
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%] A==

H 2 - A ALy s
Switch Demgn Wiew On/Off

Date of [ssue Return Date

To learn the SQL language better, it is worth switching from time to time between Design Mode and
SQL Mode.

'B - Media_without_Macros.odb : Query1 - LibreOffice Base: Query Design =~ =~ )
File Edit VWiew Insert Tools Window Help

=] Hg- 288K v
ID | Media D | Reader ID | Dateoflssue | ReturnDate |
B |22 2 1 040313
24 ] 1 120313
26 4] 1 290313
28 3 ] 01.0413
29 4 ] 040413
21 0 ] 040313
=AutoF
Record [1 [ of B kM
SELECT "In", "Media ID", "Beader ID", "Loan Date" AS "Date of Issue=", -
"Return Date” AS "REeturn Date" N
FROM "Loan” .
WHERE "Feturn Datce™ T3 NULL
ZEDEER EBEY "E= .-'Lﬁﬂ_'_III“ ASC, "Date of Issu=" ASC -

Here the SQL formula created by our previous choices is revealed. To make it easier to read, some
line breaks have been included. Unfortunately the editor does not store these line breaks, so when
the query is called up again, it will appear as a single continuous line breaking at the window edge.

SELECT begins the selection criteria. AS specifies the field aliases to be used. FROM shows the
table which is to be used as the source of the query. WHERE gives the conditions for the query,
namely that the Return_date field is to be empty (IS NULL). ORDER BY defines the sort criteria,
namely ascending order (ASC — ascending) for the two fields Reader_ID and Loan date. This sort
specification illustrates how the alias for the Loan_Date field can be used within the query itself.

When working in Design View Mode, use IS EMPTY to require a field be empty.
_ When working in SQL Mode, use IS NULL which is what SQL (Structured Query
Tip Language) requires.

When you want to sort by descending order using SQL, use DESC instead of ASC.

So far the Media_ID and Reader_ID fields are only visible as numeric fields. The readers’ names
are unclear. To show these in a query, the Reader table must be included. For this purpose we
return to Design Mode. Then a new table can be added to the Design view.

f BEE

ST
Fn.dd Tahle ar Query_
ile | Return Date |

I
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Here further tables or queries can subsequently be added and made visible in the graphical user
interface. If links between the tables were declared at the time of their creation (see Chapter 3,
Tables), then these tables are shown with the corresponding direct links.

£ Loan B Reader

& 1D F 1D
Media_ID ]J_[ Firsttlame
Feader_ID Lasthame
Loan_Date Lock
Return_Date Gender_ID
Extension
Media_ID_BC

If a link is absent, it can be created at this point by dragging the mouse from "Loan"."Reader_ID" to
"Reader"."ID".

Now fields from the Reader table can be entered into the tabular area. The fields are initially added
to the end of the query.

4 | | | |
. [

[
Reader_[D Loan_Date % Return_Date Firsthlame LastMame
Date of Issue Feturn Date
Loan Loan Loan Reader Reader

The position of the fields can be corrected in the tabular area of the editor using the mouse. So for
example, the First_name field has been dragged into position directly before the Loan_date field.

ID | MedialD | Reader D | FirstName | LastName | Dateoflssue | Return Date |
|22 2 1 Heinrich Miller 04.0313
24 8 1 Heinrich Miller 12.0313
26 g 1 Heinrich Miller 28.0313
28 3 @ Greta Garbo 01.0413
29 4 @ Greta Garbo 04.0413
21 0 ] Terence Mokbody 04.03.13
Record [1 [ of [ b I[M

Now the names are visible. The Reader_ID has become superfluous. Also sorting by Surname and
First_name makes more sense than sorting by Reader_ID.

This query is no longer suitable for use as a query that allows new entries into the resulting table,
since it lacks the primary key for the added Reader table. Only if this primary key is built in, does
the query become editable again. In fact it then becomes completely editable so that the readers’
names can also be altered. For this reason, making query results editable is a facility that should
be used with extreme caution, if necessary under the control of a form.

Having a query that you can edit can create problems. Editing data in the query also
Caution edits data in the underlying table and the records contained in the table. The data
may not have the same meaning. For example, change the name of the reader, and
A you have also changed what books the reader has borrowed and returned.

If you have to edit data, do so in a form so you can see the effects of editing data.
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Even when a query can be further edited, it is not so easy to use as a form with list boxes, which
show the readers’ names but contain the Reader_ID from the table. List boxes cannot be added to
a query; they are only usable in forms.

[SELECT "L an"."ID", "Loan"."Media ID", "Loan"."REesadsr ID", |
"BEeader"."Firstlam=", "Reader"."Lastllam=", "Loan"."Loan Date" AS "Date of
Issus", "Loan"."Return Date" A5 "Return Date"

FREOM "Loan'", "Eeader"

WHERE "Loan'."Feadsr ID" = "Eeacdsr™."ID" AND "Loan"."Eeturn Date" I3 NULL
ORDEE BY "Loan'"."Eesader ID" ASC, "Date of Issus" ASC i

If we now switch back to SQL View, we see that all fields are now shown in double quotes: "Table
_hame" ."Field_name". This is necessary so that the database knows from which table the
previously selected fields come from. After all, fields in different tables can easily have the same
field names. In the above table structure this is particularly true of the ID field.

The following query works without putting table names in front of the field names:

SELECT "ID", "Number", "Price" FROM "Stock", "Dispatch"
WHERE "Dispatch"."stockID" = "Stock"."ID"

Note Here the ID is taken from the table which comes first in the FROM definition. The
table definition in the WHERE Formula is also superfluous, because stockID only
occurs once (in the Dispatch table) and ID was clearly taken from the Stock table
(from the position of the table in the query).

If a field in the query has an alias, it can be referred to — for example in sorting — by this alias
without a table name being given. Sorting is carried out in the graphical user interface according to
the sequence of fields in the tabular view. If instead you want to sort first by "Loan date" and then
by "Loan"."Reader_ID", that can be done if:

* The sequence of fields in the table area of the graphical user interface is changed (drag
and drop "Loan date" to the left of "Loan"."Reader_ID", or

* An additional field is added, set to be invisible, just for sorting (however, the editor will
register this only temporarily if no alias was defined for it) [add another "Loan date" field just
before "Loan"."Reader_ID" or add another "Loan"."Reader_ID" field just after "Loan date"],
or

* The text for the ORDER BY command in the SQL editor is altered correspondingly (ORDER
BY "Loan date", "Loan"."Reader_ID").

Specifying the sort order may not be completely error-free, depending on the LibreOffice version.
From version 3.5.3, sorting from the SQL view is correctly registered and displayed in the graphical
user interface, including the fields that are used in the query but are not visible in the query output.
(These fields do not have a check in the Visible row.)

A query may require a field that is not part of the query output. In the graphic in the
next section, Return_Date is an example. This query is searching for records that do
not contain a return date. This field provides a criterion for the query but no useful
visible data.

Tip

Using functions in a query

The use of functions allows a query to provide more than just a filtered view of the data in one or
more tables. The following query calculates how many media have been loaned out, depending on
the Reader_ID.
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Field 1] Reader_ID Return_Date
Alias Count

Tahble Loan Loan Loan

Sort

Visible L]
Function Count Group

Criterion IS EMPTY

For the ID of the Loan table, the Count function is selected. In principle it makes no difference
which field of a table is chosen for this. The only condition is: The field must not be empty in any of
the records. For this reason, the primary key field, which is never empty, is the most suitable
choice. All fields with a content other than NULL are counted.

For the Reader_ID, which gives access to reader information, the Grouping function is chosen. In
this way, the records with the same Reader_ID are grouped together. The result shows the number
of records for each Reader_|ID.

As a search criterion, the Return_Date is set to “IS EMPTY”, as in the previous example. (Below,
the SQL for this is WHERE “Return_Date” IS NULL.)

Count | Reader_ID |
B |1 9

3 1

2 G
Record [1 [ of 3 ¥ M
|SELECT COUNT({ "ID"™ ) AS "Count", "REeadesr TID" |
FROM "Loan" L
WHERE "Eeturn Date" I35 NULL I
GROUP BY "Readesr ID" =

The result of the query shows that Reader_ID '0' has a total of 3 media on loan. If the Count
function had been assigned to the Return_Date instead of the ID, every Reader_ID would have '0'
media on loan, since Return_date is predefined as NULL.

The corresponding Formula in SQL code is shown above. ’“%

Altogether the graphical user interface provides the following functions, which (no function)

correspond to functions in the underlying HSQLDB. “é‘fdﬁ?e

For an explanation of the functions, see “Query enhancement using SQL Mode*  Maximum

on page 134. Minimum
sum
Every
Any
Some
STDDEY_FPOP
STODEY_SAMP
VAR _SAMP
VAR_FOP
Collect
Fusion
Intersection
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If one field in a query is associated with a function, all the remaining fields mentioned in the query
must also be associated with functions if they are to be displayed. If this is not ensured, you get the
following error message:

0. LibreOffice Base v (8

@ The data content could not be loaded.

Matin aggregate function ar group by clause:
org.hsgldb.Expression@ be87al in statement [SELECT
COUNT("ID" ) AS "Count”, "Reader_|D", "Return_Date" FROM
"Loan" WHERE "Return_Date" IS NULL GROUP BY "Reader_ID"]

| 0K || More

A somewhat free translation would be: The following expression contains no aggregate function or
grouping.

When using Design View Mode, a field is only visible if the Visible row contains a
Tip check mark for the field. When using SQL Mode, a field is only visible when it follows
the keyword, SELECT.

When a field is not associated with a function, the number of rows in the query
output is determined by the search conditions. When a field is associated with a
function, the number of rows in the query output is determined by whether there is
any grouping or not. If there is no grouping, there is only one row in the query
output. If there is grouping, the number of rows matches the number of distinct
values that the grouping field has. So, all of the visible fields must either be
associated with a function or not be associated with a function to prevent this
Note conflict in the query output.

After this, the complete query is listed in the error message, but unfortunately
without the offending field being named specifically. In this case the field
Return_Date has been added as a displayed field. This field has no function
associated with it and is not included in the grouping statement either.

The information provided by using the More button is not very illuminating for the
normal database user. It just displays the SQL error code.

To correct the error, remove the check mark in the Visible row for the Return_Date field. Its search
condition (Criterion) is applied when the query is run, but it is not visible in the query output.

Using the GUI, basic calculations and additional functions can be used.

Field D |Media_ID |F€eader_ID |Date |Cnunt{"Recall"."Date"]l*2 |F{eturn_Date |
Alias RecallCount RecallAmount

Tahble Loan Loan Loan Recall Loan

Sort

Visible O
Function Group Group Group Count

Criterion IS EMPTY
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Suppose that a library does not issue recall notices when an item is due for return, but issues
overdue notices in cases where the loan period has expired and the item has not been returned.
This is common practice in school and public libraries that issue loans only for short, fixed periods.
In this case the issue of an overdue notice automatically means that a fine must be paid. How do
we calculate these fines?

In the query shown above, the Loan and Recalls tables are queried jointly. From the count of the
data entries in the table Recalls, the total number of recall notices is determined. The fine for
overdue media is set in the query to 2.00 €. Instead of a field name, the field designation is given
as Count (Recalls.Date)*2. The graphical user interface adds the quotation marks and
converts the term “count” into the appropriate SQL command.

Only for people who use a comma for their decimal separator:

) If you wish to enter numbers with decimal places using the graphical user interface,
Caution you must ensure that a decimal point rather than a comma is used to separate the
decimal places within the final SQL statement. Commas are used as field
A separators, so new query fields are created for the decimal part.

An entry with a comma in the SQL view always leads to a further field containing the
numerical value of the decimal part.

ID | MediaID | Reader_ID | RecallCount | RecallAmount |
B 24 8 1 1 2
22 |2 1 1 2

Record [1 | of 2 b M
[SELECT "L an'."1D", "Loan"."Media ID", "Loan"."Reader ID", ~|
COUNT( "Fecall"."Date™ )} AS "EecallCount',

COUNT( "REecall"."Date" )} * 2 AS "FecallAmount"

FROM "Recall", "Loan" =
WHERE "Fecall"."Loan ID"™ = "Loan'"."ID"

AWD "L hn”.”PLtuLn_DﬁtL” IS NULL
GROUP BY "Loan"."ID", "Loan"."Msdia ID", "Loan"."Reader ID"

The query now yields for each medium still on loan the fines that have accrued, based on the recall
notices issued and the additional multiplication field. The following query structure will also be
useful for calculating the fines due from individual users.

Field Feader_ID |Date |Cnunt{"Recall"."Date":l*2 |Heturn_Date |
Alias FecallCount RecallAmount

Table Loan Recall Loan

Sort

Visible O
Function |Group Count

Criterion IS EMPTY

The "Loan"."ID" and "Loan"."Media_ID" fields have been removed. They were used in the previous
query to create by grouping a separate record for each medium. Now we will be grouping only by
the reader. The result of the query looks like this:
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Reader_ID | RecallCount RecallAmount
B |1 2 4

Record |1 [ of 1

Instead of listing the media for Reader_ID = 0 separately, all the "Recalls"."Date" fields have been
counted and the total of 8.00€ entered as the fine due.

Relationship definition in the query

When data is searched for in tables or forms, the search is usually limited to one table or one form.
Even the path from a main form to a subform is not navigable by the built-in search function. For
such purposes, the data to be searched for are better collected by using a query.

Title | Title | Subtitle |
i |Der kleine Hobhit i |l hearyou knocking |Youn cant catch me
Das sogennante Bise | hearyou knocking  The stumble
Eine kurze Geschichte der Zeit | hearyou knocking (Sahre dance (Single version)
Traditionelle und kritische Theorie Im Augenhblick Amsterdam
Die neue deutsche Rechtschreibung Im Augenhblick Hier unten am Deich
| hearyou knocking Im Augenhblick Kaln-Ehrenfeld
Datenbanken mit OpenOffice.org 3 Im Augenhblick Bei Mir
Das Postfix-Buch Im Augenhblick Gottsei Dank
Im Augenblick
Record [1 [ of g Record [1 [ of B b M
Field Title Field Title Subtitle
Alias Alias
Table Media Takle Media Subtitle
Sort Sort
Visible O Visible O

The simple query for the Title field from the Media table shows the test entries for this table, 9
records in all. But if you enter Subtitle into the query table, the record content of the Media table is
reduced to only 2 Titles. Only for these two Titles are there also Subtitles in the table. For all the
other Titles, no subtitles exist. This corresponds to the join condition that only those records for
which the Media_ID field in the Subtitle table is equal to the ID field in the Media table should be
shown. All other records are excluded.

EH Media B Subtitle

* *

Wl % ID
Title Delete

Edition Mo
Fub_ear q Subtitle
Comment Length

Category_ID
Mediastyle_ID
Town_ID
Fublisher_ID
Frice

Ficture

ISBM
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The join conditions must be opened for editing to display all the desired records. We refer here not
to joins between tables in Relationship design but to joins within queries.

A Join Properties v, X
Tables inolyed ———7—7n0iinin i oo —n —m — 007000000
Ok
Subtitle Media
Cancel
Qptions
Type Inner join - Help
[] Matural
Fields involved
Subtitle | Media
Media_ID D

Includes only recaords for which the contents of the related fields of
baoth tables are identical.

By default, relationships are set as Inner Joins. The window provides information on the way this
type of join works in practice.

The two previously selected tables are listed as Tables Involved. They are not selectable here. The
relevant fields from the two tables are read from the table definitions. If there is no relationship
specified in the table definition, one can be created at this point for the query. However, if you have
planned your database in an orderly manner using HSQLDB, there should be no need to alter
these fields.

The most important setting is the Join option. Here relationships can be so chosen that all records
from the Subtitle table are selected, but only those records from Media which have a subtitle
entered in the Subtitle table.

Or you can choose the opposite: that in any case all records from the table Media are displayed,
regardless of whether they have a subtitle.

The Natural option specifies that the linked fields in the tables are treated as equal. You can also
avoid having to use this setting by defining your relationships properly at the very start of planning
your database.

For the type Right join, the description shows that all records from the Media table will be displayed
(Subtitle RIGHT JOIN Media). As there is no Subtitle that lacks a title in Media but there are
certainly Titles in Media that lack a Subtitle, this is the right choice.
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0. Join Properties 2 &
Tables involved

QK
Subtitle Media
] Zancel
Qptions
Type o Help
[] Matural

Fields involved

Subtitle | Media
Media_ID ID

Contains ALL records from table 'Media' but only records from table
'Subtitle’ where the values in the related fields are matching.
Flease note that some databases may not support this join type.

[ 4

After confirming the right join the query results look as we wanted them. Title and Subtitle are
displayed together in one query. Naturally Titles appear more than once as with the previous
relationship. However as long as hits are not being counted, this query can be used further as a
basis for a search function. See the code fragments in this chapter, in Chapter 9 (Macros), and in
Chapter 8 (Database Tasks).

Title | Subtitle |
i |Der kleine Hobhbit

Das sogennante Bise

Eine kurze Geschichte der Zeit

Traditionelle und kritische Theorie

Die neue deutsche Rechtschreibung

| hear you knocking Youn can't catch me
| hear you knocking The stumble
| hear you knocking Sabre dance (Single version)

Datenbanken mit OpenOffice.org 3
Das Fostfix-Buch

Im Augenblick Amsterdam

Im Augenblick Hier unten am Deich

Im Augenblick Kiln-Ehrenfeld

Im Augenblick Bei Mir

Im Augenblick Gott sei Dank
Record J1 [ of 15 ¥ M

Query enhancement using SQL Mode

If during graphical entry you use View > Switch Design View On/Off to switch design view off,
you see the SQL command for what previously appeared in Design View. This is the best way for
beginners to learn the Standard Query Language for Databases. Sometimes it is also the only way
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to enter a query into the database when the GUI cannot translate your requirements into the
necessary SQL commands.

SELECT * FROM "Table_name"

This will show everything that is in the Table_name table. The "*" represents all the fields of the
table.

SELECT * FROM "Table_name" WHERE "Field_name" = 'Karl'

Here there is a significant restriction. Only those records are displayed for which the field
Field_name contains the term 'Karl' — the exact term, not for example 'Karl Egon'.

Sometimes queries in Base cannot be carried out using the GUI, as particular commands may not
be recognized. In such cases it is necessary to switch Design View off and use Edit > Run SQL
command directly for direct access to the database. This method has the disadvantage that you
can only work with the query in SQL Mode.

G [ %—' 5
ﬁ?a - A Ap 2 RunSQL command directly
i i A 0% o

Direct use of SQL commands is also accessible using the graphical user interface, as the above
figure shows. Click the icon highlighted (Run SQL command directly) to turn the Design View
Off/On icon off. Now when you click the Run icon, the query runs the SQL commands directly.

Here is an example of the extensive possibilities available for posing questions to the database
and specifying the type of result required:

SELECT [{LIMIT <offset> <limit> | TOP <limit>}][ALL | DISTINCT]
{ <Select-Formulation> | "Table_name".* | * } [, ...]

[INTO [CACHED | TEMP | TEXT] "new_Table"]

FROM "Table_ list"

[WHERE SQL-Expression]

[GROUP BY SQL-Expression [, ...]]

[HAVING SQL-Expression]

[{ UNION [ALL | DISTINCT] | {MINUS [DISTINCT] | EXCEPT [DISTINCT] } |
INTERSECT [DISTINCT] } Query statement]

[ORDER BY Order-Expression [, ...]]

[LIMIT <limit> [OFFSET <offset>]];

[{LIMIT <offset> <limit> | TOP <limit>}]:
This limits the number of records to be displayed. LIMIT 10 20 starts at the 11th record and
shows the following 20 records. TOP 10 always shows the first 10 records. This is the same as

LIMIT 0 10. LIMIT 10 0 omits the first 10 records and displays all records starting from the
11th.

You can do the same thing by using the last SELECT condition in the formula [LIMIT
<limit> [OFFSET <offset>]]. LIMIT 10 shows only 10 records. Adding OFFSET 20
causes the display to begin at the 21st record. Before you use this final form of display
limitation, you need to include a sorting condition (ORDER BY ...).

Limiting the display of query results is only possible using direct SQL commands. By doing this,
you determine how the query data is sorted and hence what data will be shown.

[ALL | DISTINCT]
SELECT ALL is the default. All records are displayed that fulfill the search conditions. Example:
SELECT ALL "Name" FROM "Table_name" yields all names; if "Peter" occurs three times
and "Egon" four times in the table, these names are displayed three and four times
respectively. SELECT DISTINCT "Name" FROM "Table_name" suppresses query results
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that have the same content. In this case, ‘Peter’ and ‘Egon’ occur only once. DISTINCT refers
to the whole of the record that is accessed by the query. So if, for example, the surname is
asked for as well, records for ‘Peter Miller’ and ‘Peter Maier’ will count as distinct. Even if you
specify the DISTINCT condition, both will be displayed.

<Select-Formulation>

{ Expression | COUNT(*) |

{ COUNT | MIN | MAX | SUM | AVG | SOME | EVERY | VAR_POP | VAR_SAMP |
STDDEV_POP | STDDEV_SAMP }

([ALL | DISTINCT]] Expression) } [[AS] "display_name"]

Field names, calculations, record totals are all possible entries. In addition different functions
are available for the field shown. Except for COUNT ( *) (which counts all the records) none of
these functions access NULL fields.

COUNT | MIN | MAX | SUM | AVG | SOME | EVERY | VAR_POP | VAR_SAMP |
STDDEV_POP | STDDEV_SAMP

COUNT ("Name") counts all entries for the field Name.

MIN("Name") shows the first name alphabetically. The result of this function is always
formatted just as it occurs in the field. Text is shown as text, integers as integers, decimals as
decimals and so on.

MAX("Name") shows the last name alphabetically.

SUM("Number") can add only the values in numerical fields. The function fails for date fields.
AVG ("Number") shows the average of the contents of a column. This function too is limited to
numerical fields.

SOME("Field_Name"), EVERY("Field_Name"): Fields used with these functions must
have the Yes/No [BOOLEAN] field type (contains only O or 1). Furthermore, they produce a
summary of the field content to which they are applied.

SOME returns TRUE (or 1) if at least one entry for the field is 1, and it returns FALSE (or 0) only
if all the entries are 0. EVERY returns 1 only if every entry for the field is 1, and returns FALSE
if at least one entry is 0.

The Boolean field type is Yes/INo[BOOLEAN)]. However, this field contains only O or
1. In query search conditions, use either TRUE, 1, FALSE or 0. For the Yes

Tip condition, you can use either TRUE or 1. For the No condition, use either FALSE or
0. If you try to use either “Yes” or “N0” instead, you get an error message. Then you
will have to correct your error.

Example:
SELECT "Class", EVERY('"Swimmer") FROM "Tablel" GROUP BY '"Class";

Class contains the names of the swimming class. Swimmer is a Boolean field describing
whether a student can swim or not (1 or 0). Students contains the names of the students.
Tablel contains these fields: its primary key, Class, Swimmer, and Students. Only Class and
Swimmer are needed for this query.

Because the query is grouped by the entries of the field Class, EVERY will return a value for
the field, Swimmer, for each class. When every person in a swimming class can swim, EVERY
returns TRUE. Otherwise EVERY returns FALSE because at least one student of the class can
not swim. Since the output for the Swimmer field is a checkbox, A check mark indicates TRUE,
and no check mark indicates FALSE.

VAR_POP | VAR_SAMP | STDDEV_POP | STDDEV_SAMP are statistical functions and affect
only integer and decimal fields.
All these functions return 0, if the values within the group are all equal.
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The statistical functions do not allow the DISTINCT limitation to be used. Basically they
calculate over all values covered by the query, whereas DISTINCT excludes records with the
same values from the display.

[AS] "display_name": The fields can be given a different designation (alias) within the
query.

"Table_name".* | * [, ...]
Each field to be displayed is given with its field names, separated by commas. If fields from
several tables are entered into the query, a combination of the field name with the table name
is necessary: "Table_name"."Field_name".

Instead of a detailed list of all the fields of a table, its total content can be displayed. For this
you use the symbol "*". It is then unnecessary to use the table name, if the results will only
apply to the one table. However, if the query includes all of the fields of one table and at least
one field from a second table, use:

"Table_name 1".*, “Table_name 2"”.”Field_name”.

[INTO [CACHED | TEMP | TEXT] "new_table"]
The result of this query is to be written directly into a new table which is named here. The field
properties for the new table are defined from the field definitions contained in the query.
Writing into a new table does not work from SQL Mode as this handles only displayable results.
Instead you must use Tools > SQL. The resultant table is initially not editable as it lacks a
primary key.

FROM <Table_list>
"Table_name 1" [{CROSS | INNER | LEFT OUTER | RIGHT OUTER} JOIN
"Table_name 2" ON Expression] [, ...]

The tables which are to be jointly searched are usually in a list separated by commas. The
relationship of the tables to one another is then additionally defined by the keyword WHERE.

If the tables are bound through a JOIN rather than a comma, their relationship is defined by the
term beginning with ON which occurs directly after the second table.

A simple JOIN has the effect that only those records are displayed for which the conditions in
both the tables apply.

Example:

SELECT "Table1"."Name", "Table2"."Class" FROM "Tablel1", "Table2" WHERE
"Tablel"."ClassID" = "Table2"."ID"

is equivalent to:

SELECT "Tablel"."Name", "Table2"."Class" FROM "Tablel" JOIN "Table2"
ON "Tablel1"."ClassID" = "Table2"."ID"

Here the names and the corresponding classes are displayed. If a name has no class listed for
it, that name is not included in the display. If a class has no names, it is also not displayed. The
addition of INNER does not alter this.

SELECT "Tablel"."Name", "Table2".'"Class" FROM "Tablel" LEFT JOIN
"Table2" ON "Tablel"."ClassID" = "Table2"."ID"

If LEFT is added, all "Names" from "Table1" are displayed even if they have no "Class". If, on
the contrary, RIGHT is added, all Classes are displayed even if they have no names in them.

Addition of OUTER need not be shown here. (Right Outer Join is the same thing as Right Join;
Left Outer Join is the same thing as Left Join.)
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SELECT "Tablel"."Playerl1", "Table2"."Player2" FROM "Tablel" AS
"Tablel" CROSS JOIN "Table2" AS "Tablel" WHERE "Tablel"."Playeri" <>
"Table2"."Player2"

A CROSS JOIN requires the table to be supplied with an alias, but the addition of the term ON is
not always necessary. All records from the first table are paired with all records from the second
table. Thus the above query yields all possible pairings of records from the first table with those
of the second table except for pairings between records for the same player. In the case of a
CROSS JOIN, the condition must not include a link between the tables specified in the ON
term. Instead, WHERE conditions can be entered. If the conditions are formulated exactly as in
the case of a simple JOIN, you get the same result:

SELECT "Tablel"."Name", "Table2"."Class" FROM "Tablel" JOIN "Table2"
ON "Tablel1"."ClassID" = "Table2"."ID"

gives the same result as

SELECT "Tablel"."Name", "Table2".'"Class" FROM "Tablel" AS "Tablel"
CROSS JOIN "Table2" AS "Table2" WHERE "Tablel".'"ClassID" =
llTable2II . IIIDH

[WHERE SQL-Expression]
The standard introduction for conditions to request a more accurate filtering of the data. Here
too the relationships between tables are usually defined if they are not linked together with
JOIN.

[GROUP BY SQL-Expression [, ...]]
Use this when you want to divide the query data into groups before applying the functions to
each one of the groups separately. The division is based upon the values of the field or fields
contained in the GROUP BY term.

Example:

SELECT "Name", SUM("Input"-"Output") AS "Balance" FROM "Tablel" GROUP
BY '"Name";

Records with the same name are summed. In the query result, the sum of Input - Output
is given for each person. This field is to be called Balance. Each row of the query result
contains a value from the “Name” table and the calculated balance for that specific value.

When fields are processed using a particular function (for example COUNT, SUM
Tip ...), all fields that are not processed with a function but should be displayed are
grouped together using GROUP BY.

[HAVING SQL-Expression]
The HAVING formula closely resembles the WHERE formula. The difference is that the WHERE
formula applies to the values of selected fields in the query. The HAVING formula applies to
selected calculated values. Specifically, the WHERE formula can not use an aggregate function
as part of a search condition; the HAVING formula does.

The HAVING formula serves two purposes as shown in the two examples below. In the first
one, the search condition requires that the minimum run-time be less than 40 minutes. In the
second example, the search condition requires that an individual's balance must be positive.

The query results for the first one lists the names of people whose run-time has been less than
40 minutes at least one time and the minimum run-time. People whaose run-times have all be
greater than 40 minutes are not listed.

The query results for the second one lists the names of people who have a total greater output
than input and their balance. People whose balance is 0 or less are not listed.
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Examples:
SELECT "Name", "Runtime" FROM "Tablel" GROUP BY "Name", "Runtime"
HAVING MIN("Runtime") < '00:40:00';

SELECT "Name", SUM("Input"-"Output") AS "Balance" FROM "Tablel" GROUP
BY "Name" HAVING SUM("Input"-"Output") > 0,

[SQL Expression]
SQL expressions are combined according to the following scheme:
[NOT] condition [{ OR | AND } condition]
Example:
SELECT * FROM "Table_name" WHERE NOT "Return_date" IS NULL AND
"ReaderID" = 2;

The records read from the table are those for which a “Return_date” has been entered and the
"ReaderID" is 2. In practice this means that all media loaned to a specific person and returned
can be retrieved. The conditions are only linked with AND. The NOT refers only to the first
condition.

SELECT * FROM "Table_name" WHERE NOT ("Return_date" IS NULL AND
"ReaderID" = 2);

Parentheses around the condition, with NOT outside them shows only those records that do not
fulfill the condition in parentheses completely. This would cover all records, except for those for
"ReaderID" number 2, which have not yet been returned.

[SQL Expression]: conditions
{ value [|| value]

A value can be single or several values joined by two vertical lines | |. Naturally this applies to
field contents as well.

SELECT "Surname" || ', ' || "First_name" AS '"Name" FROM "Table_name"
The content of the fields "Surname" and "First_name" are displayed together in a field called
"Name". Note that a comma and a space are inserted between "Surname" and "First_name".
| value { = | < | <= | > | >= | <> | != } value

These signs correspond to the well-known mathematical operators:
{ Equal to | Less than | Less than or equal to | Greater than | Greater than or equal to | Not
equal to | Not equal to }

| value IS [NOT] NULL

The corresponding field has no content, because nothing has been written to it. This cannot be
determined unambiguously in the GUI, since a visually empty text field does not mean that the
field is completely without content. However the default set-up in Base is that empty fields in
the database are set to NULL.

| EXISTS(Query_result)

Example:
SELECT "Name" FROM "Tablel" WHERE EXISTS (SELECT "First_name" FROM
"Table2" WHERE "Table2"."First_name" = "Tablel".'"Name")

The names from Tablel are displayed for which first names are given in Table2.
| Value BETWEEN Value AND Value
BETWEEN valuel AND value2 yields all values from valuel up to and including value2. If

the values are letters, an alphabetic sort is used in which lower-case letters have the same
value as the corresponding upper-case ones.
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SELECT "Name" FROM "Table_name" WHERE "Name" BETWEEN 'A' AND 'E';

This query yields all names beginning with A, B, C or D (and also with the corresponding lower-
case letters). As E is set as the upper limit, names beginning with E are not included. The letter
E itself occurs just before the names that begin with E.

| value [NOT] IN ( {value [, ...] | Query result } )

This requires either a list of values or a query. The condition is fulfilled if the value is included in
the value list or the query result.

| value [NOT] LIKE value [ESCAPE] value }

The LIKE operator is one that is needed in many simple search functions. The value is entered
using the following pattern:

'%"' stands for any number of characters (including 0),

' _" replaces exactly one character.

To search for '% or '_' itself, the characters must immediately follow another character defined
as ESCAPE.

SELECT '"Name" FROM "Table_name" WHERE "Name" LIKE '\_%' ESCAPE '\'

This query displays all names that begin with an underscore. '\' is defined here as the ESCAPE
character.

[SQL Expression]: values

[+ | -] { Expression [{ + | - | * | /7 | || } Expression]

The values may have a preceding sign. Addition, subtraction, multiplication, division and
concatenation of expressions are allowed. An example of concatenation:

SELECT "Surname"||', '||"First_name" FROM "Table"

In this way records are displayed by the query with a field containing "Surname, First_name".
The concatenation operator can be qualified by the following expressions.

| ( Condition )

See the previous section for this.

| Function ( [Parameter] [,...] )

See the section on Functions in the appendix.

The following queries are also referred to as sub-queries (subselects).
| Query result which yields exactly one answer

As a record can only have one value in each field, only a query which yields precisely one
value can be displayed in full.

| {ANY|ALL} (Queryresult which yields exactly one answer from a whole
column)

Often there is a condition that compares an expression with a whole group of values.

Combined with ANY this signifies that the expression must occur at least once in the group.
This can also be specified using the IN condition. = ANY yields the same result as IN.

Combined with ALL it signifies that all values of the group must correspond to the one
expression.

[SQL Expression]: Expression

{ 'Text' | Integer | Floating-point number
| ["Table".]"Field" | TRUE | FALSE | NULL }

Basically values serve as arguments for various expressions, dependent on the source format.
To search for the content of text fields, place the content in quotes. Integers are written without
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guotes, as are floating-point numbers.

Fields stand for the values that occur in those fields in the table. Usually fields are compared
either with each other or with specific values. In SQL, field names should be placed in double
guotes, as they may not be correctly recognized otherwise. Usually SQL assumes that text
without double quotes is without special characters, that is a single word without spaces and in
upper case. If several tables are contained in the query, the table name must be given in
addition to the field name, separated from the latter by a period.

TRUE and FALSE usually derive from Yes/No fields.

NULL means no content. It is not the same thing as 0 but rather corresponds to “empty”.

UNION [ALL | DISTINCT] Query_result
This links queries so that the content of the second query is written under the first. For this to
work, all fields in both queries must match in type. This linkage of several queries functions
only in direct SQL command mode.

SELECT "First_name" FROM "Tablel" UNION DISTINCT SELECT "First_name"
FROM "Table2";

This query yields all first names from tablel and Table2; the additional term DISTINCT means
that no duplicate first names will be displayed. DISTINCT is the default in this context. By
default the first names are sorted alphabetically in ascending order. ALL causes all first names
in Tablel to be displayed, followed by the first name in Table2. In this case the default is to sort
by primary key.

MINUS [DISTINCT] | EXCEPT [DISTINCT] Query_result
SELECT "First_name" FROM "Tablel" EXCEPT SELECT "First_name" FROM
"Table2";

Shows all first names from tablel except for the first names contained in Table 2. MINUS and
EXCEPT lead to the same result. Sorting is alphabetic.

INTERSECT [DISTINCT] Query_result
SELECT "First_name" FROM "Tablel" INTERSECT SELECT "First_name" FROM
"Table2";

This displays the first names that occur in both tables. Sorting is again alphabetic. At present
this only works in direct SQL command mode.

[ORDER BY Ordering-Expression [, ...]]
The expression can be a field name, a column number (beginning with 1 from the left), an alias
(formulated with AS for example) or a composite value expression (see [SQL Expression]:
values). The sort order is usually ascending (ASC). If you want a descending sort you must
specify DESC explicitly.

SELECT "First_name", "Surname" AS "Name" FROM "Tablel" ORDER BY "Surname";
is identical to

SELECT "First_name", "Surname" AS "Name" FROM "Tablel" ORDER BY 2;
is identical to

SELECT "First_name", "Surname" AS "Name" FROM "Tablel" ORDER BY "Name";

Using an alias in a query

Queries can reproduce fields with changed names.

SELECT "First_name", "Surname" AS "Name" FROM "Tablel"
The field Surname is called Name in the display.
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If a query involves two tables, each field name must be preceded by the name of the table:

SELECT "Tablel"."First_name", "Tablel"."Surname" AS "Name",
"Table2"."Class" FROM "Tablel", "Table2" WHERE "Tablel"."Class_ID" =
"Table2"."ID"

The table name can also be given an alias, but this will not be reproduced in table view. If such an
alias is set, all the table names in the query must be altered accordingly:

SELECT "a"."First_name", "a"."Surname" AS "Name", "b"."Class" FROM
"Tablel" AS "a", "Table2" AS "b" WHERE "a"."Class_ID" = "b"."ID"

The assignment of an alias for a table can be carried out more briefly without using the term AS:

SELECT "a"."First_name", "a"."Surname" AS "Name", "b".'"Class" FROM
llTablelll IIaII, llTableZII IIbII WHERE ”a.”.”Cla.SS_ID" = "b"."ID”

This however makes the code less readable. Because of this, the abbreviated form should be used
only in exceptional circumstances.

Queries for the creation of list box fields

List box fields show a value that does not correspond to the content of the underlying table. They
are used to display the value assigned by a user to a foreign key rather than the key itself. The
value that is finally saved in the form must not occur in the first position of the list box field.

SELECT "First_name", "ID" FROM "Tablel";

This query would show all first names and the primary key "ID" values that the form’s underlying
table provides. Of course it is not yet optimal. The first names appear unsorted and, in the case of
identical first names, it is impossible to determine which person is intended.

SELECT "First_name"||' '||"Surname", "ID" FROM "Tablel" ORDER BY
"First_name"|]|" '||"Surname";

Now the first name and the surname both appear, separated by a space. The names become
distinguishable and are also sorted. But the sort follows the usual logic of starting with the first
letter of the string, so it sorts by first name and only then by surname. A different sort order to that
in which the fields are displayed would only be confusing.

SELECT "Surname"||', '||"First_name", "ID" FROM "Tablel" ORDER BY
"Surname"||', "||"First_name";

This now leads to a sorting that corresponds better to normal custom. Family members appear
together, one under another; however different families with the same surname would be
interleaved. To distinguish them, we would need to group them differently within the table.

There is one final problem: if two people have the same surname and first name, they will still not
be distinguishable. One solution might be to use a name suffix. But imagine how it would look if a
salutation read Mr "Muller 11"!

SELECT "Surname"||', '||"First_name"||' - ID:'||"ID", "ID" FROM
"Tablel" ORDER BY "Surname"||', '||"First_name"||"ID";

Here all records are distinguishable. What is actually displayed is "Surname, First name — ID:ID
value".

In the loan form, there is a list box which only shows the media that have not yet been loaned out.
It is created using the following SQL formula:

SELECT "Title" || ' - Nr. ' || "ID", "ID" FROM "Media" WHERE "ID" NOT
IN (SELECT "Media_ID" FROM "Loan" WHERE "Return_Date" IS NULL) ORDER
BY "Title" || ' - Nr. ' || "ID" ASC
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Queries as a basis for additional information in forms

If you wish a form to display additional Information that would otherwise not be visible, there are
various query possibilities. The simplest is to retrieve this information with independent queries and
insert the results into the form. The disadvantage of this method is that changes in the records may
affect the query result, but unfortunately these changes are not automatically displayed.

Here is an example from the sphere of stock control for a simple checkout.

The checkout table contains totals and foreign keys for stock items, and a receipt number. The
shopper has very little information if there is no additional query result printed on the receipt. After
all, the items are identified only by reading in a barcode. Without a query, the form shows only:

Total Barcode
3 17
2 24

What is hidden behind the numbers cannot be made visible by using a list box, as the foreign key
is input directly using the barcode. In the same way, it is impossible to use a list box next to the
item to show at least the unit price.

Here a query can help.

SELECT "Checkout"."Receipt_ID", "Checkout"."Total", "Stock"."Item",
"Stock"."Unit_Price", "Checkout"."Total"*"Stock"."Unit_price" AS
"Total_Price" FROM "Checkout", "Item" WHERE "Stock"."ID" =
"Checkout"."Item_ID";

Now at least after the information has been entered, we know how much needs to be paid for
3 * Item'17'. In addition only the information relevant to the corresponding Receipt_ID needs to be
filtered through the form. What is still lacking is what the customer needs to pay overall.

SELECT "Checkout"."Receipt_ID",
SUM("Checkout"."Total"*"Stock"."Unit_price") AS "Sum" FROM "Checkout",
"Stock" WHERE "Stock"."ID" = "Checkout"."Item_ID" GROUP BY
"Checkout"."Receipt_ID";

Design the form to show one record of the query at a time. Since the query is grouped by
Receipt_ID, the form shows information about one customer at a time.

Data entry possibilities within queries

To make entries into a query, the primary key for the table underlying the query must be present.
This also applies to a query that links several tables together.

In the loaning of media, it makes no sense to display for a reader items that have already been
returned some time ago.

SELECT "ID", "Reader_ID", "Media_ID", "Loan_date" FROM "Loan" WHERE
"Return_Date" IS NULL;

In this way a form can show within a table control field everything that a particular reader has
borrowed over time. Here too the query must filter using the appropriate form structure (reader in
the main form, query in the sub-form), so that only media that are actually on loan are displayed.
The query is suitable for data entry since the primary key is included in the query.

The query ceases to be editable, if it consists of more than one table and the tables are accessed
via an alias. It makes no difference in that case whether or not the primary key is present in the

query.
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SELECT "Media"."ID", "Media"."Title", "Category".'"Category",
"Category"."ID" AS "Kat_ID" FROM "Media'", '"Category" WHERE
"Media"."Category_ID" = "Category"."ID";

This query is editable as both primary keys are included and can be accessed in the tables without

using an alias.
SELECT "m"."ID", "m"."Title", "Category".'"Category", "Category"."ID"
AS "Kat_ID" FROM "Media" AS "m", "Category" WHERE "m"."Category_ID" =
"Category"."ID";

In this query the "Media" table is accessed using an alias. The query cannot be edited.

In the above example, this problem is easily avoided. If, however, a correlated subquery (see page
145) is used, you need to use a table alias. A query is only editable in that case if it contains only
one table in the main query.

Use of parameters in queries

If you often use the same basic query but with different values each time, queries with parameters
can be used. In principle queries with parameters function just like queries for a subform:

SELECT "ID", "ReaderID", "Media_ID", "Loan_date" FROM "Loans" WHERE
"Return_Date" IS NULL AND "Reader_ID"=2;

This query shows only the media on loan to the reader with the number 2.

SELECT "ID", "Reader_ID", "Media_ID", "Loan_date" FROM "Loans" WHERE
"Return_Date" IS NULL AND "Reader_ID" = :Readernumber;

Now when you run the query, an entry field appears. It prompts you to enter a reader number.
Whatever value you enter here, the media currently on loan to that reader will be displayed.

When using forms, the parameter can be passed from the main form to a subform. However it
sometimes happens that queries using parameters in subforms are not updated, if data is changed
or newly entered.

Often it would be nice to alter the contents of list boxes using settings in the main form. So for
example, we could prevent library media from being loaned to individuals who are currently banned
from borrowing media. Unfortunately controlling list box settings in this personalized way by using
parameters is not possible.

Subqueries

Subqueries built into fields can always only return one record. The field can also return only one
value.

SELECT "ID", "Income", "Expenditure", ( SELECT SUM( "Income" ) -
SUM( "Expenditure" ) FROM "Checkout") AS "Balance" FROM "Checkout";

This query allows data entry (primary key included). The subquery yields precisely one value,
namely the total balance. This allows the balance at the till to be read after each entry. This is still
not comparable with the supermarket checkout form described in “Queries as a basis for additional
information in forms". Naturally it lacks the individual calculations of Total * Unit_price, but also the
presence of the receipt number. Only the total sum is given. At least the receipt number can be
included by using a query parameter:

SELECT "ID", "Income", "Expenditure", ( SELECT SUM( "Income" ) -
SUM( "Expenditure" ) FROM "Checkout" WHERE "Receipt_ID" =
:Receipt_Number) AS "Balance" FROM "Checkout" WHERE "Receipt_ID" =
:Receipt_Number;
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In a query with parameters, the parameter must be the same in both query statements if it is to be
recognized as a parameter.

For subforms such parameters can be included. The subform then receives, instead of a field
name, the corresponding parameter name. This link can only be entered in the properties of the
subform, and not when using the Wizard.

Subforms based on queries are not automatically updated on the basis of their
Note parameters. It is more appropriate to pass on the parameter directly from the main
form.

Correlated subqueries

Using a still more refined query, an editable query allows one to even carry the running balance for
the till:

SELECT "ID", "Income", "Expenditure", ( SELECT SUM( "Income" )
SUM( "Expenditure" ) FROM "Checkout" WHERE "ID" <= "a"."ID" ) AS
"Balance" FROM "Checkout" AS "a" ORDER BY "ID" ASC

The Checkout table is the same as Table "a". "a" however yields only the relationship to the current
values in this record. In this way the current value of ID from the outer query can be evaluated
within the subquery. Thus, depending on the ID, the previous balance at the corresponding time is

determined, if you start from the fact that the 1D, which is an autovalue, increments by itself.

Queries as source tables for queries

A query is required to set a lock against all readers who have received a third overdue notice for a
medium.

SELECT "Loan"."Reader_ID", '3rd Overdue - the reader is blacklisted'
AS "Lock"

FROM (SELECT COUNT( "Date" ) AS "Total_Count", "Loan_ID" FROM
"Recalls" GROUP BY "Loan_ID") AS "a", "Loan"

WHERE "a"."Loan_ID" = "Loan"."ID" AND "a"."Total_Count" > 2

First let us examine the inner query, to which the outer query relates. In this query the number of
date entries, grouped by the foreign key Loan_ID is determined. This must not be made dependent
on the Reader_ID, as that would cause not only three overdue notices for a single medium but also
three media with one overdue notice each to be counted. The inner query is given an alias so that
it can be linked to the Reader_ID from the outer query.

The outer query relates in this case only to the conditional formula from the inner query. It shows
only a Reader_ID and the text for the Lock field when the "Loan"."ID" and "a"."Loan_ID" are equal
and "a"."Total_Count" > 2.

In principle all fields in the inner query are available to the outer one. So for example the sum
"a"."Total_Count" can be merged into the outer query to give the actual fines total.

However it can happen, in the Query Design dialog, that the Design View Mode no longer works
after such a construction. If you try to open the query for editing again you get the following
warning:
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) & LibreOffice Base ¥ X

Ch The query is based on an S0L command which could not he
Y parsed.
The query will be opened in SAL view.

4

If you then open the query for editing in SQL view and try to switch from there into the Design
View, you get the error message:

2 & LibreOffice Base % &
The column ‘Loan_ID' is unknown.

The column could not be found. Please note that the database is
case-sensitive.

The Design View Mode cannot find the field contained in the inner query "Loan_ID", which governs
the relationship between the inner and outer queries.

[ More

When the query is run in SQL Mode, the corresponding content from the subquery is reproduced
without error. Therefore you do not have to use direct SQL mode in this case.

The outer query used the results of the inner query to produce the final results. These are a list
of the "Loan_ID" values that should be locked and why. If you want to further limit the final results,
use the sort and filter functions of the graphical user interface.

Summarizing data with queries

When data is searched for over a whole database, the use of simple form functions often leads to
problems. A form refers after all to only one table, and the search function moves only through the
underlying records for this form.

Getting at all the data is simpler when you use queries, which can provide a picture of all the
records. The section on “Relationship definition in the query” suggests such a query construction.
This is constructed for the example database as follows:

SELECT "Media"."Title", "Subtitle"."Subtitle", "Author"."Author"
FROM "Media"

LEFT JOIN "Subtitle" ON "Media"."ID" = "Subtitle"."Media_ID"

LEFT JOIN "rel_Media_Author" ON '"Media"."ID" =
"rel_Media_Author"."Media_ID"

LEFT JOIN "Author" ON '"rel_Media_Author"."Author_ID" = "Author"."ID"

Here all "Titles", "Subtitles" and "Authors" are shown together.

The Media table contains a total of 9 Titles. For two of these titles, there are a total of 8 Subtitles.
Without a LEFT JOIN, both tables displayed together yield only 8 records. For each Subtitle, the
corresponding Title is searched for, and that is the end of the query. Titles without Subtitle are not
shown.

Now to show all Media including those without a Subtitle: Media is on the left side of the
assignment, Subtitle on the right side. A LEFT JOIN will show every Title from Media, but only a
Subtitle for those that have a Title. Media becomes the decisive table for determining which
records are to be displayed. This was already planned when the table was constructed (see
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Chapter 3, Tables). As Subtitles exist for two of the nine Titles, the query now displays 9 +8 -2 =
15 records.

The normal linking of tables, after all tables have been counted, follows the keyword
WHERE.

If thereisa LEFT JOIN ora RIGHT JOIN, the assignment is defined directly
after the two table names using ON. The sequence is therefore always

Tablel LEFT JOIN Table2 ON Tablel.Fieldl = Table2.Field1l
LEFT JOIN Table3 ON Table2.Fieldl = Table3.Field1l

Note

Two titles of the Media table do not yet have an author entry or a Subtitle. At the same time one
Title has a total of three Authors. If the Author Table is linked without a LEFT JOIN, the two
Media without an Author will not be shown. But as one medium has three authors instead of one,
the total number of records displayed will still be 15.

Only by using LEFT JOIN will the query be instructed to use the Media table to determine which
records to show. Now the records without Subtitle or Author appear again, giving a total of 17
records.

Using appropriate Joins usually increases the amount of data displayed. But this enlarged data set
can easily be scanned, since authors and subtitles are displayed in addition to the titles. In the
example database, all of the media-dependent tables can be accessed.

More rapid access to queries using table views

Views in SQL are quicker than queries, especially for external databases, as they are anchored
directly into the database and the server returns only the results. By contrast queries are first sent
to the server and processed there.

If a new query relates to another query, the SQL view in Base makes the other query look like a
table. If you create a View from it, you can see that you are actually working with a subquery
(Select used within another Select). Because of this, a Query 2 that relates to another Query 1
cannot be run by using Edit > Run SQL command directly, since only the graphical user
interface and not the database itself knows about Query 1.

The database gives you no direct access to queries. This also applies to access using macros.
Views, on the other hand, can be accessed from both macros and tables. However, no records can
be edited in a view. (They must be edited in a table or form.)

A query created using Create Query in SQL View has the disadvantage that it
cannot be sorted or filtered using the GUI. There are therefore limits to its use.

Tip A View on the other hand can be managed in Base just like a normal table — with the
exception that no change in the data is possible. Here therefore even in direct SQL-
commands all possibilities for sorting and filtering are available.

Views are a solution for many queries, if you want to get any results at all. If for example a
Subselect is to be used on the results of a query, create a View that gives you these results. Then
use the subselect on the View. Corresponding examples are to be found in Chapter 8, Database
Tasks.
Creating a View from a query is rather easy and straight forward.

1) Click the Table object in the Database section.

2) Click Create View.

3) Close the Add Table dialog.
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4) Click the Design View On/OFF icon. (This is the SQL Mode for a View.)
5) Getting the SQL for the View:
a) Edit the query in SQL View.
b) Use Control+A to highlight the query's SQL.
c) Use Control+C to copy the SQL.
6) Inthe SQL Mode of the View use Control+V to paste the SQL.
7) Close, Save, and Name the View.
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Creating reports using the Report Builder

Reports are used to present data in a way that makes it readily understood by people without
knowledge of the database. Reports can:

* Present data in easy-to-read tables
e Create charts for displaying data
* Make it possible to use data for printing labels

* Produce form letters such as bills, recall notices, or notifications to people joining or leaving
an association

To create a report requires careful preparatory work on the underlying database. Unlike a form, a
report cannot include subreports and thus incorporate additional data sources. Neither can a report
present different data elements than those that are available in the underlying data source, as a
form can do using list boxes.

Reports are best prepared using queries. In this way all variables can be determined. In particular,
if sorting within the report is required, always use a query that makes provision for sorting. This
means that queries in direct SQL mode should be avoided under these conditions. If you must use
a query of this type in your database, you can carry out the sort by first creating a view from the
guery. Such a view can always be sorted and filtered using the graphical user interface (GUI) of
Base.

When using the Report Builder, you should frequently save your work during editing.
In addition to saving within the Report Builder itself after each significant step, you
Caution should also save the whole database.

Depending on the version of LibreOffice that you are using, the Report Builder can
sometimes crash during editing.

The functionality of completed reports is not affected even if they were created under
another version, in which the problem does not occur.

The user interface of the Report Builder

To start the Report Builder from within Base, use Reports > Create Report in Design View.

The initial window of the Report Builder (Figure 45) shows three parts. On the left is the current
division of the report into Page header, Detail, and Page footer; in the middle are the
corresponding areas where the content will be entered; and, to the right, the properties of these
regions are shown.

At the same time the Add fields dialog is displayed. This dialog corresponds to the one in form
creation. It creates fields with their corresponding field labels.

Without content from the database, a report has no proper function. For this reason, the dialog
opens at the Data tab. Here you can set the content of the report; in the example it is the
View_Report_Recall table. As long as Analyze SQL command is set to Yes, the report can be
subjected to sorting, grouping, and filtering. A view has been chosen for the basis of this report, so
no filter will be applied; it has already been included in the query underlying the view.
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Figure 45: Initial window of Report Builder

Two output formats for reports are available for selection: ODF Text document (a Writer document)
or ODF Spreadsheet (a Calc document). If you just want a tabular view of your data, the Calc
document should definitely be chosen for your report. It is significantly faster to create and is also
easier to format subsequently, as there are fewer options to consider and columns can easily be

dragged to the required width afterward.

By default, the Report Builder looks for its data source in the first table in the database. This
ensures that at least a test of the functions is possible. A data source has to be chosen before the

report can be provided with fields.

The Report Builder provides a lot of additional buttons, so the table on the next page shows the
buttons with their descriptions. The buttons for aligning elements are not further described in this
chapter. They are useful for quick adjustment of fields in a single area of the Report Builder, but in
principle everything can be done by direct editing of field properties.
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Buttons for editing content

Buttons for aligning elements

(=]
=
&
E2
B
5]
@
=
=
B

Save
Edit File

cut
Copy

Paste

Change property 'Command’
Redo

Add Field
Fepart Mavigatar
Sorting and Grouping

|| Left Align on Section
BE RigntAlign on Seetion

|| Top Align on Section
|E| Bottom Align on Section

2] shrink

Iﬁl Shrink from top
|E| Shrink from bottom

ki Fitto smallestwidth
|&| Fitto greatestwidth

(€] EsecuteReport [=8] Fitto smallest height
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|E| Select || Let
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asc| Label Field —
lisc| TextBox e
[E] Graphic I@I Center
I]il Chart IEI Bottorn
|§| Horizontal Line
|{|§| Vertical Line
Display Grid
Snap to Grid

Helplines While Moving

Just as with forms, it is helpful to use the appropriate navigator. So, for example, a careless click at
the start of the Report Builder can make it difficult to find the properties of the data for the report.
Such data may only be reachable through the report navigator. Left-click on Report and the
properties of the report are once more accessible.

e

Report navigator = 28

- [E| Report

Jx Functions
Page Header
=| Groups

| =| Detail

Page Footer
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Initially the navigator shows, in addition to the visible sections of the document (Page header,
Groups, Detail, and Page footer), the possibility of including functions. Groups can be used, for
example, to assign all media being recalled to the person who has borrowed them, to avoid
multiple recall notices. Detail areas show the records belonging to a group. Functions are used for
calculations such as sums.

To obtain useful output in the above example, the content of the view must be reproduced with
suitable grouping. Each reader should be linked to the recall notices for all of their loaned and
overdue media.

View > Sorting and Grouping or the corresponding button starts the grouping function.

B Saorting and Grouping & 5

Groups

Field/Expression

Group actions @
Froperies

Sorting Ascending -
Group Header Present =
Group Footer Mot present o
Group Qn Each Value -

Group Interval 1

Keep Together Mo

L]

Help

Selecta field artype an expression to sort ar
group an.

Figure 46: Sorting and Grouping

Here grouping and sorting are by the Reader_Name field. Additional fields could also be included
in the table above. For example, if you also want to group and sort by the Loan_Date field, choose
this as the second line.

Directly under the table, several grouping actions are available for selection. You can move a group
up or down the list or completely remove it. As only one group is necessary for the planned report,
Figure 46 shows only the Delete symbol at the extreme right of the group actions as available.

The Sorting property is self-explanatory.

When the entry was created, the left side of the Report Builder immediately showed a new division.
Next to the field description Reader_Name you can now see Header. This section is for the group
header in the report. The header might contain the name of the person who will receive the recall
notice. In this case there is no group footer. Such a footer could contain the fine due, or the place
and current date and a space for the signature of the person sending the notice.
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By default there is a new group for each value. So if the Reader_Name changes, a hew group is
started. Alternatively you can group by initial letter. In the case of a recall notice, however, this
would put all readers with the same initial together in one group. Schmidt, Schulze, and Schulte
would receive a common recall notice, which would be quite pointless in this example.

When grouping by initial letter, you can additionally specify how many letters later the next group
should begin. One can imagine for example a grouping for a small telephone directory. According
to the size of the contact list, one might imagine a grouping on every second initial letter. So A and
B would form the first group, then C and D, and so on.

A group can be set either to be kept together with the first details section, or, as far as possible, as
a complete group. By default, this option is set to No . For recall notices, you would probably want
the group to be arranged so that a separate page is printed for each person who is to receive a
recall letter. In another menu, you can choose that each group (in this case, each reader name) be
followed by a page break before dealing with the next value.

If you have chosen to have a group header and perhaps a group footer, these elements will appear
as sections in the report navigator under the corresponding fieldname Reader_Name. Here too you
have the possibility of using functions, which will then be limited to this group.

To add fields, use the Add field function, as with forms. However in this case, the label and the field
contents are not tied together. Both can be independently moved, changed in size and dragged to
different sections.

......... T T S R S R
O Page .. | Libre Office Library
O Reader . — -
_Harme . T
Header N
Recall
: |:- et itle |
(]
the following media weren't returned at the right time:
Feca]lu:laxe |Reu:aJIH|:| 'uleclium '_u:uancleae |Ou'e|'|'l.|n F:harge |
O Detail : =Recall ||l=Recaill =Medium = can r"\;:;JDays =Charge]

L Reader : Fecall Charge: =[Sunum
Mame . g ‘I'r

Faater

Sincere regards,

[ Administration of Lilbrary)

O Page ...

Figure 47: Report design for example recall notice

Figure 47 shows the report design for the recall notice. In the page header is the heading Libre
Office Library, inserted as a label field. Here you could also have a letterhead with a logo, since the
incorporation of graphics is possible. The fact that this level is called Page header does not imply
that there is no space above it. That depends on the page settings; if an upper margin has been
set, it lies above the page header.
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Reader_Name header is the header for the grouped and sorted data. In the fields that are to
contain data, the names of the corresponding data fields are shown in light gray. So, for example,
the view underlying the report has a field named Address, containing the complete address of the
recipient with street and town. To put this into a single field requires line breaks in the query. You
can use CHAR(13) to create them.

Example:
SELECT "FirstName"||' '|]|"LastName"||CHAR(13)]||"Street"|[]|"' '||"No"|]|
CHAR13]| |"Postcode"||"' '||"Town" FROM "FirstName"

The =TODAY/() field represents a built-in function, which inserts the current date into this position.

In Reader_Name header, in addition to the salutation, we see the column headings for the
following table view. These elements should appear only once, even if several media are listed.

In the background of these column headers is a gray rectangle, which also serves as a frame for
the data.

The details area is repeated as often as there are separate records with the same Reader_Name
data. Here are listed all media that have not been returned on time. There is another rectangle in
the background to frame the contents. This rectangle is filled with white rather than gray.

In principle LibreOffice provides for the possibility of adding horizontal and vertical
lines. These are displayed in design mode. At present they do not appear when the
report is complete.

Note These lines have the further disadvantage that they are interpreted only as hairlines.
They can be reproduced better if rectangles are used. Set the background of the
rectangle to black and the size to, for example, 17cm wide and 0.03cm high. This
will create a horizontal line with a thickness of 0.03cm and a length of 17cm.

General |

M oo |Group Footer

Force New Page.....o.ooooeeeeve.. After Section -
Keep Together. oo Yes -
Repeat Section. .o Mo -
VISTBIR o Yes v
R S [1.92 B
Conditional Print Expression..... | | .
Background Transparent............ Yes -
Background calor......................

The Reader_Name footer closes the letter with a greeting formula and an area for the signature.
The footer is so defined that an additional page break will occur after this area. Also, contrary to the
default setup, it is specified that this area should be kept together in all cases. After all, it would
look rather odd if many recall notices had the signature on a separate page.

Keep together refers here to the page break. If you want the content of a record to be kept together
independently of the break, this is only possible at present if the record is not read in as Details but
is used as the basis for a grouping. You can choose Keep together = Yes, but it does not work; the
Details area becomes separated. You have to put the content of Details in a separate group to
keep it together.

A built-in function is used for calculating the total fines.
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Below is what an actual recall notice would look like. The details area contains 5 media that the
reader has taken out on loan. The group footer contains the total fine due.

Recalls.odt (read-only) - LibreOffice Writer

Insert Format Tabkle Tools Window Help

E
File Edit View
El = 2 E &R

>

Iir.
Heinrich Miller
FHowheremoad 14 b

Libre Office Library

GB 3PETQ Downtown

1124012
Recall

Dear Mr. Miller,
the following mediaweren't returned at the right time:
Recalldate |RecallNo [Medium Loandate |[Chwerrun Charge
241117 1 5 - [ hear you knocking - by Edmunds, 290412 | 20Z2Days|§7.00

Dave
241112 1 & - Im Augenblick - by van Veen, Herman [22.04.12 | 209Days|[$7.25
241112 |1 Z - Eine kurze Geschichte der Zeit - by 040412 [ 213Days|§7.50

Hawking, Steven W.

Fecall Charge: 521.75

Sincere regards,

{Administration of Librany)

LR

<]

HE

Fage 172 | Default

Note

STD Group_Header:Al

OO0 M @8 @® [75% |

Reports for single records can also extend over more than one page. The size of the
report is quite separate from the page size. However, stretching the details area over
more than one page can lead to faulty breaks. Here the Report Builder still has
problems in calculating the spacing correctly. If both grouping areas and graphical
elements are included, this may result in unpredictable sizes for certain areas.

So far individual elements can be moved to positions outside the size of a single
page only with the mouse and cursor keys. The properties of the elements always
provide the same maximum distance from the upper corner of any area that lies on
the first page.
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General properties of fields

There are only three types of field for the presentation of data. In addition to text fields (which,
contrary to their name, can also contain numbers and formatting), there is also a field type that can
contain images from the database. The chart field displays a summary of data.

ﬁ] Data

A oo |Charge |
POSHION Xe.ooooooesree l6.12 B
VISIBIE. oo |Yes < |
POSHION Yeooooooeoesreo l0.00 B
WG, oo 0.73 B
HEION oo I0.20 B
Print repeated values.._... |Yes e
Conditional Print Expression..... [ (=] |:|
Mouse wheel scroll........... |When focused | |
Print When Group Change....... |No -
Background Transparent........ |Yes -
Background colar......................

FOM [Liberation Sans, Reg |..|
Horz. Alignment............ |Left -
Vert Alignment... ... |Top v |
Farmatting.......ocooooooeeeeee [$1.234.5? ] I:I

As with forms, fields are given names. By default, the name is that of the underlying database field.

A field can be set to be invisible. This may seem a bit pointless in the case of fields but is useful for
group headers and footers, which may be required to carry out other functions of the grouping
without containing anything that needs to be displayed.

If Print repeated values is deactivated, display of the field is inhibited when a field with the same
content is loaded directly before. This functions correctly only for data fields that contain text.
Numeric fields or date fields ignore the deactivation instruction, Label fields are completely faded
out when deactivated, even if they occur only once.

In the Report Builder the display of certain content can be inhibited by using Conditional Print
Expression or the value of the field can be used as a base for formatting text and background.
More on conditional expressions is given in “Conditional print” on page 169.

The setting for the mouse wheel has no effect because report fields are not editable. It seems to be
a leftover from the form definition dialog.

The Print When Group Change function could not be reproduced in reports either.
If the background is not defined as transparent, a background color can be defined for each field.

The other entries deal with the internal content of the field in question. This covers the font (for font
color, font weight, and so on, see Figure 48), the alignment of the text within the field, and
formatting with the corresponding Character dialog (see Figure 49).
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D e Character Settings & 25
[ant | Fant Effects ] F’nsitiun] Background ] Alignment]
Eamily Style Size
[Liberatiun Sans ] [Regular ] [12 l
Ciberation Sans 10
Liberation Sans Marrow [talic 105
Liberation Serif Bold 11
Linux Biolinum G Baold Italic
Linux Liberine G 13
LM Mono 10 14
Language
% English (UsA) (£ |
The same fant will be used on both your printer and your screen.
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[ QK ] [ zancel ] [ Help ] [ Eeset
Figure 48: Fonts: Character Settings
@ Mumber Format g 2
Category Farmat Language
Percent (~] |Automatically s | [English (UsA) 2 -
?iii -§1,234.00
Scientific -1 234.00 m
Fraction -1,234.00 USD
Boalean Yalue . 51,234 -
Text §1,234 57
Qptions
Decimal places 2 = Megative numbers red
Leading zeroes 1 == Thousands separator
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Figure 49: Formatting numbers
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Special properties of graphical controls

eneral | Data

M oo Image |
Presenve as Link. ..o, |Yes +3
POSHION Kerroooeesereoeees e .57 B
VISIBIE ..o oo |Yes o3
POSHION Yoo 0.20" B
WA oo 1.57 B
R S 1.57 B
Frint repeated values................. |‘f’ES - |
Conditional Print Expression..... [ (=] |:|
Print When Group Change......... |Mo < |
Background Transparent........... |Yes -
Background calor.......................

Wert, AlGNMENt. .o, |Top o)
Graphics........oo [ | v | |:|
AR |Keep Ratio o)

A graphical control can contain graphics from both inside and outside the database. Unfortunately
it is not possible at present to store a graphic such as a logo permanently in Base. Therefore it is
essential that the graphic is available in the search path, even when you are presented with the
choice of embedding rather than linking images and the first field Set up as link can be set (literally
closed) to a corresponding planned functionality. This is one of several functions that are planned
for Base and are in the GUI but have not actually been implemented yet—so the buttons and
checkboxes have no effect.

Alternatively, of course, a graphic can be stored in the database itself and so becomes available
internally. But in that case, it must be accessible through one of the fields in the query underlying
the report.

To take up an external graphic, use the selection button beside the Graphic field to load it. To load
a graphical database field, specify the field under the Data tab.

The vertical alignment setting does not seem to have any effect during the design stage. When you
call up the report, however, the graphic appears in the correct position.

When scaling, you can select No, Keep aspect ratio, or Autom. Size. This corresponds to the
settings for a form:

* No: The image is not fitted to the control. If it is too large, a cropped version is shown. The
original image is not affected by this.

* Keep aspect ratio: The image is fitted to the control but not distorted.
* Automatic size: The image is fitted to the control and in some cases may be distorted.
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Incorporating charts into the report

You can insert charts into a report by using the corresponding control or with Insert > Report
controls > Chart. A chart is the only way to reproduce data that is not found in the data source
specified for the report. A chart can therefore be seen as a kind of subreport, but also as a free-
standing component of the report.

CRA PR [ J [

Preview ROW(S)...........cooooooooo.. [0 B

You must draw the place for the chart using the mouse. In the general properties, in addition to the
familiar fields, you can choose a Chart type (see the corresponding types in Calc). In addition, you
can set a maximum number of records for the preview, which will give an impression of how the
chart will finally look.

Charts can be formatted in the same way as in Calc (double-click on the chart). For further
information, see the description in the LibreOffice Calc Guide.

......... L R I e [V P 7
Media - Charts: Top 10
Count Medivm Contenttype. .. SQL command =
B |=C COmtent. oo [ =
0 @ @ ~ BELECT"M-'—;dia_ID". -~
. Analyze SQL command..... e ount' FROM
Filter. . MView_Media_Charts"
3 ORDER BY "Count’ 3
1T S DESC"Media_ID" ASC | ||
2 ul
= meent 8 Link master fields............ | o |
! I‘ I I Link slave fields................. [ ] -
1]
1] 1 2 3 4 7 B [ ]
m m m L

The chart is linked in the Data section with the necessary data fields. Here, in a Media Top 10 list
example, the chart shows the frequency with which particular media are borrowed. The Query
Editor is used to create a suitable SQL command, as you would do for a listbox in a form. The first
column in the query will be used to provide the labels for the vertical bars in the chart, while the
second column yields the total number of loan transactions, shown in the height of the bars.

In the example above, the chart shows very little at first, since only limited test loans were carried
out before the SQL command was issued.

The chart on the next page, from the membership database of a society (German:
Mitgliederstatistik), has been prepared from a query that needs to be entered in direct SQL mode,
as the graphical user interface does not understand it. For this reason No (German: Nein) has
been chosen for Analyze SQL command, a choice that excludes any filtering and sorting with the
internal tools of the Report Builder. These fields are therefore grayed out. In the data properties of
the chart, Query (German: Abfrage) has been entered.

Fields are linked together in the same way as for a main form with a subform. In the report itself,
the age distributions of male and female members are listed in tabular form. They are grouped by
gender. Each group is given its own chart. So that the chart only contains data for the correct
gender, the Gender field (German: Geschlecht) in the report is linked to the Gender in the chart.
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Figure 50: Linked fields for a chart, same as in forms. This example is not translated, because the
report is nt part of the example database.

The creation of charts works at present only in Versions 3.3.x and 3.4.x. From
Version 3.5, LibreOffice can no longer open these reports. They can still be
produced, however.

LibreOffice is not the only program to have problems with charts. In Version 3.3 of
OpenOffice.org, the display does not work either. OpenOffice.org does open the
reports, but with the charts missing.

Note

Data properties of fields

General | Data

Data Field Type..... |Field ar Formula

L

Datafield......... |Charge ~

Funection.................

In the properties dialog, the Data tab shows by default only the database field from which the data
for this report field will be read. However, in addition to the field types Field and Formula, the types
Function, Counter, and User-defined function are available.

You can select in advance the Sum, Minimum, and Maximum functions. They will apply either to
the current group or to the whole report. These functions can lead to problems if a field is empty
(NULL). In such fields, if they have been formatted as numbers, "NaN" appears; that is, there is no
numerical value present. For empty fields, no calculation is carried out and the result is always 0.

Such fields can be reformatted to display a value of 0 by using the following formula in the Data
area of the view.

IF([numericfield]; [numericfield];0)

This function calculates with the actual value of a field that has no value. It would seem simpler to
formulate the underlying query for the report so that 0 is given instead of NULL for numeric fields.
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The Counter counts only the records that will occur either in the group or in the report as a whole. If
the counter is inserted into the Details area, each record will be provided with a running number.
The numbering will apply only to records in the group or in the whole report.

GeneraI|Data

Data Field Type.....
Data field................

Funetion..................

Lser defined Function

[SummeGebuehrleser_Mame]

L

Finally the detailed User-defined Function is available. It may happen that the Report Builder itself
chooses this variant, if a calculation has been requested, but for some reason it cannot correctly

interpret the data source.

Functions in the Report Builder

The Report Builder provides a variety of functions, both for displaying data and for setting
conditions. If these are not sufficient, user-defined functions can be created using simple
calculation steps, which are particularly useful in group footers and summaries.

Entering formulas

The Report Builder is based on the Pentaho Report Builder. A small part of its documentation is at
http://wiki.pentaho.com/display/Reporting/9.+Report+Designer+Formula+Expressions.

A further source is the Specifications for the OpenFormula Standard:
http://lwww.oasis-open.org/committees/download.php/16826/openformula-spec-20060221.html

Basic principles:

Formulas start with an equals sign.

References to data fields are placed in square
brackets.

[Field name]

If the data fields contain special characters
(including spaces), the field name must also be
enclosed in quotes.

["This fieldname should be in
quotes"]

Text entry must always be in double quotes. "Text entry"
The following operators are allowed. +, -,
* (Multiplication),
/ (Division),

% (divide the preceding number by 100),
" (Raise to the power of the following number),
& (concatenate text),

The following relationships are possible.

=, < ,<,<=,>, >=

Round brackets are allowed.

()

Default error message.

NA (Not available)

Error message for an empty field that was
defined as a number.

NaN (Perhaps "not a number"?)
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All formula input applies only to the current record. Relationships with previous or following records
are therefore not possible.

Data field.............. | Charge -

Next to the date field is a button with three dots whenever a formula can be entered. This button
starts the Function Wizard.

B s Function Wizard v X
Functions | Structurs

Category ABS

All v ABS(Number)

Eunction

ACOS B Absolute value of a number.

ACOSH 1
ARD

ASIM

ATAMN

ATANZ

ALUTHOR

AVERAGE

AVERAGEA

CHOOSE

Cos

COUNT Charge -
COUMNTA ‘

Farmula

COUNTEBLAMEK

Help | cancel << Bacl Next > [ ok ]

However there are far fewer functions than in Calc. Many functions do have Calc equivalents.
There the Wizard calculates the result of the function directly.

The Function Wizard does not always work perfectly. For instance, text entries are not taken up

with double quotes. However, only entries with double quotes are processed when starting the
function.

The following functions are available:

Function Description

Date and Time Functions

DATE Produces a valid date from numeric values for the year, the month
and the day.

DATEDIF Returns the total years, months or days between two date values.

(DAY | MONTH | YEAR)

DATEVALUE Converts an American date entry in text form (quoted) into a date
value. The American variant that is produced can then be
reformatted.

DAY Returns the day of the month for a given date.

DAY ([Date field])
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DAYS Returns the number of days between two dates.

HOUR Returns the hours of a given time in 24-hour format.
HOUR([DateTimeField]) calculates the hours in the field.

MINUTE Returns the minutes of a date in the internal numeric format
MINUTE([Timefield]) calculates the minutes part of the time.

MONTH Returns the month for an entered date as a number.
MONTH([Datefield])

NOw Returns the current date and time.

SECOND Returns the seconds